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3 Introduction

3.1 Professional Documents Created With Ease

Many thanks for evaluating TFORMer!

The TFORMer product family represents a complete, lean and powerful solution for generating
arbitrary documents. It combines the features of barcode labeling tools with the characteristics of
report generators into a unified printing-solution. It provides professional layout and output capa-
bilities, an integrated barcode generator, full-featured UNICODE support and it supports direct PDF
generation. It can be used on client and on server side and it is available for all major operating
systems.

iy @ A
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The functionality of TFORMer is available for end-users as well as for software developers:

End-Users benefit from the graphical layout editor with instant output capabilities: TFORMer
Designer offers outstanding design and printing features for reports, tables, lists, serial letters,
industry forms, vouchers and barcode labels. Furthermore the numerous ready-to-use label and
report templates for industry and logistics (e.g., VDA-4902, Odette, GALIA, AIAG, ...) will be a valu-
able assistance.

Software developers use TFORMer SDK as reporting tool for direct printing, PDF generation,
PostScript-, HTML, image or ZPL-Il output. Layouts are designed graphically with TFORMer
Designer. The TFORMer SDK is then used to provide dynamic data for the layouts and to generate
the output. This core functionality for printing and output is available for all major operating systems.

3.2 TFORMer Basics

In contrast to a word processor which is mostly used for static content, TFORMer generates output
based on dynamic data. Examples for dynamic contents are article-numbers used in product labels
or addresses used in serial letters.

Dynamic content is provided by an external data source like a database, a file, an arbitrary appli-
cation or by the user. Such an external data source is read by TFORMer during printing. So-called
data fields are used to access the external data. They serve as placeholders for dynamic content in
the layout. To simplify usage, TFORMer provides a mapping mechanism to bind external data to
the data fields used in a layout.
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This data-centric output scheme is maintained in all cases. Even when printing pure static
documents (like personal address labels without any dynamic data) a data source is required for
controlling the number of printed labels.

Design (tt, tfr) Data
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Figure 1: Architectural Overview

Layouts created with TFORMer Designer are able to perform computations and to react on the
values of data fields. Thus, TFORMer enables you to embed the complete output logic of a

document into the layout.

3.3 Output Formats

Once a layout was designed it produces identical results across printer models, operating systems
and formats. The following formats are supported:

= Direct Printing
Print layouts directly on all printers supported by Microsoft® Windows®.

= PDF
PDF export with full-featured barcode support, Unicode and font embedding.

= PostScript®
Used for printing under Linux/UNIX and for pre-press applications.

=  HTML!
The built-in HTML output is ideal for previewing and for web-based applications.

" Due to the nature of HTML some output features may be limited or not available.
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= Image Formats
The built-in image output supports BMP, GIF, JPG, PCX, TGA, PNG and TIF formats
(including multipage TIF).
= ZEBRA®
Print to ZEBRA® printers without any additional driver. ZPL-Il output is generated directly.
= ASCI
Pure ASCII output without any graphics for special purpose requirements.

3.4 System Requirements

3.41 Operating Systems

TFORMer Designer requires one of the operating systems listed below. It works with 32-bit and 64-
bit operating systems.

= Microsoft® Windows 2000

*  Microsoft® Windows XP

= Microsoft® Windows Vista

= Microsoft® Windows 7

= Microsoft® Windows 8

= Microsoft® Windows Server 2003 (including Terminal Server)
= Microsoft® Windows Server 2008 (including Terminal Server)

TFORMer Designer includes the output kernel of the TFORMer SDK. This output kernel is
available for Linux® and UNIX® as well. For details check out the Developer Manual.

3.42 Memory

512 MB RAM is the recommended minimum (1 GB for Windows Vista or higher). Actual memory
requirements depend on the type and size of the generated output.

3.4.3 Disk Space

TFORMer needs approximately 30 MB on disk. When using the .NET based API of the TFORMer
SDK or the printing utility TFORMer QuickPrint please also consider .NET 2.0 requirements.
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4 User Interface

This chapter will give you an overview of the TFORMer user interfac

4.1 Main Window

e.

PR A By B | 11 0.00 - .00 rerm |71 180.00 s 0547 me

Ul'-"-'-ﬂhl"' '-Cl,.-lmuv,w. HIIG - |

Figure 2: User Interface
The main window is divided into the following areas:

Quick Access Toolbar (see 4.2).

Ribbon Menu (see 4.3).

Layout Window with Layout Tabs (see 4.4 and 4.8).
Design Tree Window (see 4.5).

Properties (see 4.6).

Status Bar (see 4.7).

Q60000 0Q
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The quick access toolbar gives you access to the following functions:

* Cut Copies all selected objects (rectangles, texts, printing bands, data fields, ...) to the
clipboard and removes them from the layout.
Shortcut: Ctrl+X
EE| Copy Copies all selected objects to the clipboard.
Shortcut: Ctr/+C
[73, | Paste Inserts the content of the clipboard.
Shortcut: Ctri+V
)y Undo Reverts the last change.
Shortcut: Ctrl+Z
= Redo Reverts the last Undo.
Shortcut: Ctri+Y
H Save Saves the current layout.
(Same as the “Save” command in the file menu, see section 4.3.1.)
Shortcut: Ctrl+S
@ Print Prints the current layout.

(Same as the “Print” command in the file menu, see section 4.3.1.)
Shortcut: Ctrl+P

4l

Quick access for specific program settings:

=9 | Options... Opens the options dialog (see chapter 17).
Show Grid Shows or hides the grid (see also section 17.2.2).
Shortcut: Ctrl+G
Fine Positioning Sets one of the three positioning modes (see also section
Snap to Grid 17.2.1).
Snap Lines Shortcut (switch modes): Ctrl+R
Grid Options... Opens the options dialog with the grid settings.

4.3 Ribbon Menu

The ribbon menu gives you access to the functions below. The menu structure is divided into the

following areas:

File —see 4.3.1
Layout — see 4.3.2
Page — see 4.3.3
Data — see 4.3.4
Preview — see 4.3.5

Repository (only on demand) — see 16.3
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File

Page
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Save
H Save the active document

= Save as..
H Save the active document using another file
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Figure 4: Ribbon Menu — File
New... Creates a new layout (see also section 6.2.2).
Shortcut: Ctri+N
~= | Open... Opens an existing layout (or repository) — see also section 6.2.1.
v Shortcut: Ctr/+O
Save lg Save Saves the current layout (see also section 6.2.4).
Shortcut: Cirl+S
L1 | Saveas... Saves the current layout with a new name. You can also
save layouts as ZIP-files.
Shortcut: F12
Q Save All Saves all layouts (and repositories) that are currently
opened.
Shortcut: Cirl+Shift+S
Templates Templates can be used as basis for new layouts.
v/ Save as Template... Saves the current layout as template.
Organize Organizes the templates in a hierarchical structure.
Templates...
Print... @ Print Prints the current layout (see also chapter 15).
Shortcut: Ctrl+P
u'l Preview Shows the current layout in the print preview (see also
chapter 14).
Shortcut: Ctrl+Space
Repository A repository is a central location for storing multiple layouts in a structured way (see
g chapter 16).
s | New Repository... Creates an empty repository.
= | Open Repository... Opens an existing repository.
) Close Repository Closes an open repository.
# | Close Closes the current layout.
J Shortcut: Ctri+W or Ctrl+F4
-Iﬁ Options... lg_:‘j ‘ Options... Opens the options dialog window (see chapter 17).
L=
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. | License...

Opens the License dialog for TFORMer Designer (see
chapter 18).

e 2

4 | Check for Updates...

Checks if an update of TFORMer Designer is available.

9 Help See also section 4.3.6!

Exits TFORMer.

Q Exit

4.3.2 Layout
B - r b e
i ||| o] 280 88| 50| | ]
Dara 5||_m 11_:: Blu:!dc Pollure SH:pl ﬁ-u_nu (LT .| =

Figure 5: Ribbon Menu — Layout
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Shortcut: Ctrl+L

Selects the layout view (see section 4.4.3).

Shortcut: Ctrl+D

Data Selects the data view (see section 4.4.4).
Use this view to manually edit the data or to import data from external data sources.

LS Preview
»jl Shortcut: Ctrl+Space

Selects the print preview (see section 4.4.5).

4.3.2.2 Select

(see section 9.3).

Select i1 Select Normal selection mode.
] Allows the selection of elements via mouse click.
E | Selects all elements in the layout.
I_j Document Selects the document.
(Is required for editing specific properties — see also
section 6.4)
4.3.2.3 Insert
Text Inserts a text element.
ABC

A text element provides formatted text. The content may consist of static and dynamic
data (see also section 8.3.1). Depending on the required content type choose one of the
following options. Please note that the content and its type can be changed at any time

11| | Data Field

Shows the content of a data field (without any additional
information). (See also section 9.4.)

jauz| | Formatted Text

Shows an arbitrary formatted text, which may be enriched
with data fields and expressions (see also section 9.5).

[ i
Expression

Shows the result of an expression (see also section 9.8).

& | Barcode Inserts a barcode.
¥

section 4.3.2.6).

A barcode encodes the given data in a machine readable form. The content may consist
of static and dynamic data (see also section 8.3.2). Depending on your requirements
choose one of the following barcode types. This type can be changed at any time (see

Recently Used

Choose from the most recently used barcode types.

[my) | Linear Barcodes

2D Codes

Postal Codes

GS1 DataBar

Choose the barcode type by category.

For more information on barcode types and their possible
adjustments, please refer to the “Barcode Reference”
which is available for download on www.tec-it.com.
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[mr) | HIBC Codes

T : Picture Inserts a picture.
| ‘h‘ The name of the image file may be specified as fixed text or computed (see also section
8.3.3).
h .
L::L‘J Shape |_| | Rectangle Inserts a rectangle (see also chapter 8)
|__| | Rounded Rect. Inserts a rectangle with rounded corners.
. | Ellipse Inserts an ellipse.
[=] | Line Inserts a line.
I Band Iﬁ Report Header... Inserts a new band (see also chapter 7).
—j ™ | Page Header...
" | Group Header...
i | Detail...
L2 | Group Footer...
L | Page Footer...
L | Report Footer...
4.3.2.4 Edit
T / Content Edits the content of a text, barcode or picture element (see also chapter 9).
Edit... Edits the element content.
Shortcut: Double-Click the Element or press F2
Data Field Assigns one of the existing data fields or a new data field
Computed Field of the respective type as element content.
Serial
Formatted Text / Assigns a text (respectively a file name) as element con-
Text / File tent.
Expression Assigns an expression as element content.
Condition [ | Edit... Edits the printing condition for the selected object (band,
element or layer) — see also section 12.2.
Print Removes the printing condition.
Thus the object is always printed.
Don’t Print Sets the printing condition to 0 (= false).
Thus the object is never printed.
4.3.2.5 Format
Arial Font Arial Selects the typeface.
="~ 2| Font Size 15 - Selects the font size (in points).
Font Style B | Bold Toggles bold text on/off.
Shortcut: Ctri+B
| ltalic Toggles italic text on/off.
Shortcut: Ctrl+l
II | Underlined Toggles underline on/off.
Shortcut: Ctrl+U
Alignment = | Alignment Sets the text alignment.
= | Justify Toggles text justification on/off.
||+ | Direction Specifies the text direction inside the text frame (in 90°
steps).
Coloring A | Font Color Selects the font color.
&» | Fill Color Selects the fill color.

WWW.TEC-IT.COM
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& | Line Color Selects the line color.
Line Properties = | Line Width Sets the line width.
=== | Line Style Sets the line style.
4.3.2.6 Barcode
[1om) Type Changes the barcode type.
You can choose between several 1D and 2D barcode types.
For more information on available barcode types and their possible adjustments, please
refer to the “Barcode Reference” which is available for download on www.tec-it.com.
I [ Color Changes the barcode color.
4.3.2.7 Arrange

See also section 8.2.11.

S Align Aligns two (or more) selected elements (see also section 8.2.11.1).
S| Left Aligns the selected elements to the left.
Shortcut: Ctri+ ¢
1-1;" Vertical Aligns the selected elements vertically centered.
35| | Right Aligns the selected elements to the right.
Shortcut: Ctrl+->
ﬂ Top Aligns the selected elements to the top.
Shortcut: Ctri+
—;-—_|- Horizontal Aligns the selected elements horizontally centered.
i Bottom Aligns the selected elements to the bottom.
Shortcut: Ctri+v
Vertical Spacing '#E'.' Make Equal Makes the vertical spacing between the selected
elements equal.
%[ Increase Increases the vertical spacing between the selected
elements.
.31:; Decrease Decreases the vertical spacing between the selected
elements.
Horizontal Hia | Make Equal Makes the horizontal spacing between the selected
Spacing elements equal.
J:_J_:- Increase Increases the horizontal spacing between the selected
elements.
_J‘J*-"_ Decrease Decreases the horizontal spacing between the selected
elements.
[ Size Adjusts two (or more) selected elements in size (see also section 8.2.11.2).
=] | Same Width Applies the same width to all selected elements.
|f] | Same Height Applies the same height to all selected elements.
|| | Same Size Applies the same size to all selected elements.
'—Iil Z-Order Changes the order of overlapping elements (see also section 8.2.11.4).
-_'_1, Move to Top Moves the selected elements to the foreground.
Shortcut: Ctrl+Pos1
—ll Move Up Moves the selected elements up one level.
Shortcut: Ctrl+Page Up
—_II Move Down Moves the selected elements down one level.
Shortcut: Ctri+Page Down
—_'_', Move to Bottom Moves the selected elements to the background.
Shortcut: Ctri+End
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4.3.2.8 Layers
& Base - Assigns all selected elements to the corresponding layer (see also section 12.3.2).
G | New Layer Creates a new layer (see also section 12.3.1).
& Show Layers Toggles the display of layer colors on or off (see also section 12.3.3).

4.3.3 Page
Layout Page Data Preview
8 I = 4 Z
Eid .’“"!-. s [ Alignment
k e Mode ~
Data Setup

Image

-

View Camman

Figure 6: Ribbon Menu — Page

Watermark

4.3.31 View
Layout Switches to the respective view (see also section 4.4.2).
Data Shortcuts: Ctri+L, Ctrl+D and Ctrl+Space
Preview

4.3.3.2 Common

.LI Setup Adjusts the page settings.

e The dimensioning can be adjusted manually or you can choose one of the many prede-
fined templates. The dialog allows you to adjust the layout type, the paper format, the
page orientation, the margins, and the appropriate partitioning when printing on label
sheets. — See also section 6.2.3.

Watermark

Image Specifies a background image for the output page (= watermark).
You can use a specific image file name or an expression which computes the file name
during print-time.

= Alignment Specifies the output position of the picture on the page:
|=— = El Top, Left Top, Center Top, Right
|§ = El Center, Left Center Center, Right
|=_ = ﬁ Bottom, Left Bottom, Center Bottom, Right

aﬂ Mode 5 | Clip Uses the image as is. Clipping may occur.

; Stretch Stretches the image to fit the page size without maintain-
ing the aspect ratio.
ﬁ;. Zoom Zooms the image to the page size.
A | Tile Fills the page using tiles of the image.
4.3.4 Data
Layout Page Data Preview Repository
™ : [ Edit | Edit manually (defaul) v | EE l‘-.'E‘.I :
| Q o | T---1 S5 |
i E“ ; s Clear f Settings d '_I —
Preview Refresh Auto  Apply Mew New Edit
- Filter % Parameters -
View Fitter Data Source Data Fields

Figure 7: Ribbon Menu — Data

4341 View

_ Ml Layout
. Data

Switches to the respective view (see also section 4.4.2).
Shortcuts: Ctri+L, Ctrl+D and Ctrl+Space
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Preview

g:i Refresh Reloads the data from the data source.
L Shortcut: F5
4.3.4.2 Filter

See also section 13.6.

Auto Filter Creates a new filter which is based on the current selection in the data grid (see also
g section 13.6.1.2).
Place the cursor inside the row and on the value for which you want to filter. Alternatively
you can also select a specific record by clicking on the line number on the left side. Then
click Auto Filter.
Please note that multiple selection is possible as well (hold down the Shift or the Ctrl key).
You can also filter several times in order to refine the result.
Apply Enables or disables the filter (see also section 13.6.1.2).
I [
,}} Edit Edits the filter expression (see also section 13.6.1.1).
,i Clear Removes the existing filter.
4.3.4.3 Data Source

Edit manually [default)

-

Selects an existing data source or creates a new one (see also sections 13.3.2.6 and
13.3.2.1).

lg-f Edit Edits the current data source (see also section 13.3.2.3).
lg-g Parameters Edits the data source parameters (see also section 13.5.2.3).
@ New Creates a new data source (see also section 13.3.2.1).
J
4.3.4.4 Data Fields
I:'%:I New Inserts a new data field (see also section 10.2.1.1).
el |
?-bh-] | Edit Edits the selected data field (see also section 10.3).
4.3.5 Preview
Layout Page Data Preview
w ::! -j-{ L;[} One Pagei [ Mext Page
IQ Two Pages + Previous Page
Layout Print Refresh Setup Zoom Zoom

-

View Page

Out | Show Labet Boundaries

Loom Preview

Figure 8: Ribbon Menu — Preview

Shortcut: F5

4.3.51 View

Layout Switches to the respective view (see also section 4.4.2).

Data Shortcuts: Ctri+L, Ctrl+D and Ctrl+Space

Preview

Print Prints the layout on a printer of your choice or generate file output (PDF, PostScript®,
HTML, Text).
Shortcut: Ctrl+P

d:i Refresh Refreshes the preview.
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4.3.5.2 Page

.LI Setup See also sections 4.3.3.2 and 6.2.3.
S Shortcut: Ctrl+Shift+P
4.3.5.3 Zoom
4. Zoom In Selects the zoom factor. You will find the selected zoom factor shown next to the zoom
‘{ symbol in the status bar:
_ Q0% - @ ) @
i'{ Zoom Out Shortcut: Ctri++, Ctrl+— or Ctrl+Mousewheel
_J] One Page Switches to single page preview mode.
@ Two Pages Switches to two page (side by side) preview mode.
4.3.5.4 Preview
Next Page Shows the next page in the preview.

Previous Page

Shows the previous page in the preview.

|5 &

Show Label Enables or disables the display of the label boundaries.
Boundaries
4.3.6 Help
| 5
@ -

Figure 9: Ribbon Menu — Help

9 Help

&4 | Help Displays the TFORMer manual.

Shortcut: F1
Online FAQ Opens the default browser and navigates to the

TFORMer Designer frequently asked questions web
page.

&y | TEC-IT Website Opens the page www.tec-it.com in the default web
browser.

vi | Buy TFORMer Opens the default browser and navigates to the online
order form.

About TFORMer... Displays information about TFORMer Designer and the
program version.
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4.4 Layout View, Data View and Preview

4.41 Introduction
TFORMer Designer provides three different views for documents:

= Layout View (see section 4.4.3)
= Data View (see section 4.4.4)
= Preview (see section 4.4.5)

The default view is the layout view (see 4.4.3). It is used to create the layout. The layout usually
utilizes data fields (like [ProductGroup], see figure below) as placeholders for the data. For details
regarding data fields, please refer to chapter 10.

The data for the data fields is provided by a data source. The data source can be edited in the data
view (see section 4.4.4).

TFORMer also offers a preview, which instantly renders the resulting output using the layout and
the data of the adjusted data source (see section 4.4.5).
1)

-
Layout Page Data Preview
1 y I
ﬁ ABC| S| =] j Arial -z ~||B F U

Data Select Text Barcode Picture Shape | Band | Content Condition |||= - = A - ==
View Select Insert Edit Format B
Start Page Picking List X i
.-|-'-|-2-|-3-|-4-|-5-|-'5-|-7-|-5-|-3-|-'-I)-l-“-|-'2-|-'3-|-'4-|-'5-|-'E~-|-'?-|-'5-|-'

m

|.— lﬁ Edit Page Header -
RAECEEETECINEGE] 0 Express Picking List

N

Picking List Number: [PickingListNo]

| = ﬁ Edit Page Header - Page Header InGroup

Article Group: [ProductGroup] (continued)

Article-No | Description | Quantity |  Unit Price | Barcode
| — I*j Edit Group Header

Article Group: [ProductGroup]

Article-No | Description | Quantity | Unit Price |  Barcode
| = b Edit Detail
- | rarticleNo] | [Description] | [quantiy] |3, w00 | NN
| — &} Edit Group Footer
- LGroup Total iroupUnits] 1_GroupPrice] |
- - I [
select View: ] 5G] @ | 471000 0.00 mm 17 180,00 x95.11 mm Oe

Figure 10: Layout View, Data View and Preview
44.2 Switching Views

You can switch between the layout view, the data view and the preview by clicking the correspond-
ing tabs in the ribbon menu (®) or by selecting the required view via button ®. Alternatively you can
also click on the respective symbol in ©.
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443 Layout View

The layout view is used to create layouts:

FL[e Layo ut Page Data Preview

|| ec] 3 58] 30

: [
j Arial -1z ~||B F O

Data Select Text Barcode Picture Shape Band Content Condition = - = .| A - & - # ==

View Select Insert Edit Format B

Start Page Picking List > -
.-|-'-|-2-|@-|-4-|-5-|-'5-|-?-|-5-|-3-|-'{)-|-"-|-'2-|-'3-|-'4-|-'5-|-'E\-|-'7-|-'5-|-'

| — lﬁ Edit Page Header -
-EB GG GGGl - - Express Picking List

AN TEG-IT.

m

Picking List Number: [PickingListNo]

— ﬁ Edit Page Header - Page Header InGraup

o

Article Group: [ProductGroup] (continued)

Article-No | Description | Quantity |  Unit Price | Barcode
| = l‘j Edit Group Header

Article Group: [ProductGroup]

‘- [Article-No | Description | Quantity |  Unit Price | Barcode
| = i3 Edit Detai
- | rarticleNo] | [Description] I s | TITTH
| — &} Edit Group Footer
- LGroup Total iroupUnits] 1_GroupPrice] |
4 L 3

Figure 11: Layout View

On the worksheet @ you can place all kinds of graphical elements like text elements, lines, rect-
angles, barcodes and images. Such elements can be moved, resized or deleted. Furthermore, you
can add and remove single print areas like page headers and page footers. These areas are called
bands (see chapter 7).

On the left and on the top of the layout there are rulers (®) which assist you when positioning
elements. After starting TFORMer Designer for the first time, the measuring unit is set to "System
(Default)”. You can change this value in the options dialog (ribbon menu File » Options... |
Options...).

It is possible to zoom the layout using the zoom slider & 100% ~ (=) 5 # . on the bottom
right side of the application window or via hotkeys Cir/++ and Cirl+-. You can also adjust the zoom
factor by holding down the Ctr/ key and by simultaneously turning the mouse wheel.

For more information on how to design layouts, please refer to chapters 6 to 12.
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4.4.4 DataView

The data view is used to administrate data sources. You can create, switch and modify data
sources. Furthermore, the content of the active data source is shown. This is the data which is used

for printing the layout.

Layout Page Data

Preview
L . B A i Edit | |Edit manually (default) @ ~ IE:IJ =
|—1 N kd % Clear | [ Edit k5] ul
Preview Refresh Auto  Apply New Mew Edit
- Filter 95 Parameters -
View Filter Data Source Data Fields
Start Page Picking List X hd
3 Copies |ArticIeNo| CustomerNo| Description | Express| Flag_InGroup | PickingListN
1 1 7009800 4711 Pentium 4 (Prescott 2M)
2 1 87009801 4711 Pentium 4 Extreme Edition (Prescott 2M)
3 1 87009802 4711 Pentium D (Smithfield)
4 1 7009803 4711 Pentium Extreme Edition (Smithfield)
5 1 7009804 4711 Pentium Extreme Edition (Presler)
& 1 87009805 4711 Pentium 4 (Cedar Mill) o
7 1 87009806 4711 Pentium D (Presler)
8 1 87009807 4711 Core Solo (Yonah)

87009800 [ 4711 |Pentiomd(Prescott2) | | | ]

L1

k

Record: 4@ <@ 15 Hvons @

9 [ Hide unused data fields

Figure 12: Data View

The data view mainly consists of a data grid showing the current data (@®). Use the navigation
buttons in ® to select rows or to jump to a specific row in the data source. In ® you will find func-
tions for manipulating and selecting data sources. When checkbox @ is activated all data fields
which are not used in the layout will be hidden.

By default TFORMer assigns a manual data source to a newly created layout. This means that you
can enter values for data fields manually in the grid. It is also possible to create and edit other types
of data sources (e.g., ODBC database access). For more information regarding the data view,

please refer to section 13.2.
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445

Preview

This view shows an instant preview of the output using the selected data source.

Layout Page Data Preview
MBQ & R <

[:y 8] | 1
L Z | S

Layout Print Refresh Setup Zoom Zoom
k& In Cut

_J]One Page
|J_—J]Two Pages

_ﬁ. Next Page
_4 Previous Page

Show Label Boundaries

Page: |42 <= 1 = = of2 (2)

View Page Zoom o Preview
Start Page Picking List X -
Picking List
Plcklng List Number:
Article Group: CPU
ArticleHo |Descrintion Quartity Unit Price Barcode
87009800 |Pertium 4 (Prescott 2M) 78 s7o0 | HAEEIND
STO0SE01 | Pewtam L Ecteme Edtior (Frescott2 i) g 33,00 [ ][]
87003502 |Pentium D (Smithfeld) 7 1o000 | NN
57009503 | Pentium Extreme Edition (Smithfield) 2 11z00 | AR
S7009504 | Fentium Exdreme Edition (Freslan 22 123,00 -I.I
BTO09E05 | Pentium 4 (Cedar Mil) 8 15400 | HEEINNN
S7009806 | Pertium D (Presler) 3 160,00
57009807 | Core Solo (vonah) 1 12400
ST009505 | Caore Dua (Yonahk) 3 145,00
57009509 | Celeron M (Yonah-1024) 12 155,00
S7009810 | Celeron D (Cedar Mill-512) 3 209,00
57009511 | Core 2 Duo (Alendale) 1 22200
57009812 | Core 2 Duo MConroed 200 246,00

Figure 13: Preview

Use the functions in @ to change the zoom factor, switch between single page or double-page
preview and show/hide label boundaries. The buttons in ® allow you to navigate between pages or
to jump to a specific page. For details, please refer to chapter 14.
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4.5 Design Tree Window

451 Layout Tree

The design tree window shows a structured view of the layout. It lists all objects in a single place
and allows the selection of objects per mouse click. Even such elements, which are occluded in the
design view, can be selected in the design tree easily.

Repository/Design Repositary/Design
%I._-’] PickList _104F [C:\Temp'] =[5 PickList_104f [C:\Temp']
|1 Data Sources =+l Data Sources
[ Data Fields | Edit manually (default)
& Tray Mappings | )l oDBC
Layers T
=] Bands w0 % cut Umschalt=Entf
[™ Report Headers =T
- [ Page Headers L Copy Strg=C
= Iﬁ Page Header % Bi 1% Paste 9 Strg+V
e [Customer [CustomerNo]]
5 [Picking List] X Delete
0 =iE v
(5] Grafik ﬂ'e&t Logo bmp] ) Mew Data Source...

[ed [Picking List Number: [Ficki.. ]

Edit Data 5
m Page Header InGroup it Data Source

,;3 Group Headers ¥4 Mew Source Parameter..,
.‘Q Details L.gs Edit Source Parameter...
[} Group Footers
[ Page Footers v | Set as Active Data Source
[y Report Footers .
Repnsﬂnn@\nesig@’ Repository Properties
Figure 14: Design Tree Window Figure 15: Delete a Data Source

The tree in O lists all objects in a hierarchical structure. You can expand single branches of the tree
by clicking the i+ symbol and you can collapse them by clicking the = symbol.

To select an object, click on it with the left mouse button. Hold down the Shift key or the Ctrl key for
multiple selection. Figure 14 shows a selected text element (®), which is located in the page header
of a layout called “PickList_10.tff".

If you right-click on a tree item a context menu will appear (see Figure 15, ©). The context menu
offers various functions for the selected object.

If TFORMer encounters an error in a user defined computation, the affected tree item is drawn red.
For more information, please refer to section 10.4.

4.5.2 Repository Tree

If a repository is used, a second tab will be shown next to the Design tab ©. Clicking tab @ switches
to the tree view of the Repository. A repository is a central database for layouts, data field defini-
tions and tray-mappings. For details, please refer to chapter 16.
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4.6 Properties

The complete layout structure in TFORMer is based on objects (bands, text boxes, data sources,
etc.). To adjust the properties of such objects the properties window is used. For a completive list of
all object properties, please refer to Appendix A.

The properties of the following objects can be modified:

= Forms

= Bands

= Elements (graphical design elements)
= Data Sources and Source Parameters
= Data Fields

= Layers

= Tray Mappings

=  Projects (Repository)

Properties

Ianmmon -
Text Express
Font Arial(18)
Text Direction 0 - Horizontal
Text Color Il ffo000 [=]
Fill Color [ ] Ne Color
Line Color |:| Mo Line £
Line Width 0.100 mm
Line Style
Alignment Center, Right
Justify Mo
Word Wrap Yes i
Advanced
Control
Position
Margins -
Text Color 0

Color of the Text.

Figure 16: Properties Window

All properties are grouped into categories (like “Common”, “Advanced” or “Position”, see @). The
categories help you to locate properties more easily.

Properties are accessible as “field:value” pairs. E.g., the property “Text” is currently set to “Ex-
press”. The color (“Text Color”) is set to red.

The area ® shows information on the selected property.

» TFORMer Designer supports multiple object selection. This can be used to change the pro-
perties of multiple objects simultaneously. A change will be applied to all objects within the
selection.
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4.7 Status Bar

The status bar displays information about position and measurement of the selected design
element. Furthermore you can switch between the different views, change the raster settings and
modify the zoom factor for the layout view.

=1

select View: i) 3| 5] 471 0,00 0.00 mm [ 180.00 x 95.11 mm I Grid Settings ~ G 100% - (

.......... s

5— T —®

Figure 17: Status Bar

O allows to switch between the design view, the data view and the preview (see also section 4.4).

® shows the coordinates of the upper left corner of the selected element (or of the element with the
mouse focus).

©® shows the dimensions of the selected element (or of the element with the mouse focus). The
measuring unit used for displaying positions or dimensions can be adjusted in the options dialog
(menu File » Options... | Options...).

O allows to adjust the raster settings.

© shows the current zoom factor for the layout view. The zoom factor can be adjusted via the drop
down menu, by pressing the buttons # and (=), or by dragging the zoom slider. Alternatively you can
change the zoom factor by pressing Ctr/++ and Ctrl+-, or by using the shortcut Cirl+Mousewheel.

4.8 Layout Tabs

When working with multiple layouts, each of these layouts is represented by a tab (see ©). To
switch between layouts click on the corresponding tab in @ or use the layout picker ®. To close the
current layout click on the = symbol inside the tab or use the keyboard shortcut Ctri+W.

Start Page” Picking List X | VDA 4902 EN o 9 -

. et 2030405 BT B9 W 120 0 13 14 15 1B AT 1B 0 T

|.— lﬁ Edit Page Header -
ANCNCETECINENEY - Express Picking List

m

‘| Picking List Number: [PickingListNo] _

| — ﬁ Edit Page Header - Page Header InGroup

Article Group: [ProductGroup] (continued)
Article-No | Description | Quantity |  Unit Price |  Barcode

| — [} Edit Group Header

Article Group: [ProductGroup] =

Article-No | Description | Quantity |  Unit Price | Barcode
| — |4 Edit Detail
- | rarticleNo] | Description] | uantity] |, w00t | NN
| — F_} Edit Group Footer
- | Group Total iroupUnits] 1 GroupPrice] |
4 e 3 :

Figure 18: Change Layouts quickly by using Tabs
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5 Printing Concept and Workflow

5.1 Introduction

TFORMer uses one universal output concept to produce all different kinds of outputs like:

= Reports — a table, a list or a letter usually spanning multiple pages.

= Label sheets — a layout which is printed repeatedly in multiple rows and columns on each
page.

= Single labels (Label Printer) — a layout which is printed once on each page. One page is one
label.

= Hybrid Layouts — a mix of the first two variants.

The output concept is based on the logical separation of the /ayout (®) into different printing areas
(e.g., report header, page header, detail area, page footer and report footer). Such a printing area is
called band.

Each of these bands fulfills a specific purpose. By combining bands and by adjusting their proper-
ties, different layout schemes can be produced. The figure below illustrates the printing of a simple
report (®).

Layout (1) Output Input Data with Data Fields (3]
.I 'I' R M e
1 i i Evcogis L ArtirieName . At e
o rwe = L— 1 Chair 1
| |
e il i bl oo SEEREE | Chak 100 HIAN A "// P | Dk PRSI0 |15
I . TIEED | Doen o RN < |5 [y N
| a1 | —1 & | Mo Lo
[avicietial (At s+ T[T (T > cae lIAMIN AT | Parel
¢ L R T [ =
[Page ~+ Sl Fagays o » Comzmbagen]| Wl M - 5 | Gothee Mac
ST 2 fitas
N -7 P
o NNME 3 Frang
A 208 Fag 1201

Figure 19: Printing Concept

In contrast to a word processor which is mostly used for static content, a report generator like
TFORMer generates output based on dynamic data. Good examples for dynamic contents are the
article numbers on product labels, the addresses in serial letters and the order positions in invoices.

The dynamic content is usually provided by an external data source (). This is either a text file, a
database, an arbitrary application or user specified data.

5.2 Rendering the Layout

Each print-out is based on the form layout. The form layout uses different design elements like text
elements, barcode elements, shapes and pictures which are placed on bands (see Figure 20, ©).

When generating the output, each of the bands will be rendered repeatedly: Usually a detail band is
rendered for each single record (see Figure 20, ®) of the data source. Page header and page
footer are rendered at the top respectively bottom of each page automatically (see Figure 20, @).
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The report header and the report footer are printed at the beginning and at the end of the report
(see Figure 20, @). In this way the output is assembled.

Layout Input Data with Data Fields
Text Barcode Shape Picture Reference Data Fields
Tes | [JVIINN] | S || 20 in Text, Barcode or Image Elements
T (e.g. [ArticleNo])
Y 1

Crtaorne: | B ransaiy (dosl

o [l ArideName
i jonee NELAANR 1 |ohar
P wsee M (@ T o

! i i
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Figure 20: Rendering the Layout

For providing the content you have various possibilities: Text, barcode and image elements can be
filled with fixed data. Aside from that they can also reference the fields in a data source. Such
references will be resolved during print time and the actual data is inserted (see Figure 20, ©).
However, not only the fields in the data source may be used to provide dynamic data. TFORMer
also provides system fields (e.g., the current page number) and functions (e.g., the current date),
and you can perform your own arbitrary computations. Besides that, you can easily create your own
serial numbers and use them in the layout.

5.3 Data Source Concept

For generating output TFORMer requires data. The records and the data fields control the content
and the appearance of the output. As a rule of thumb TFORMer prints one detail band per record of
the data source.

Please note, that this data-centric output scheme is maintained in all cases, even when printing
pure static documents like personal address labels. In this case the number of records (or the copy
counter for records) controls the number of printed labels.

A data source can be seen as a simple table, which is read row by row (record by record) by
TFORMer during printing. Each record (each row) provides the values for one or more data fields
used in the layout (e.g., “ArticleName”, “ArticleNo” and “ArticlePrice”).

Data Fields
# Copies |ArticIeName|ArticIeN0|ArticIePrice|
1 1 Chair 558963 110
?DU 2 1 Desk 778920 150
3 3 1 Monitor 775116 236
a4 1 Panel 544503 |40
5 1 Coffee Ma... | 549896 30
& 1 Printer 458862 100
7 1 Fax 445866 115
Y 3 1 Phone 458932 50

Figure 21: Data Source Concept
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5.4 Reading a Data Source and Printing Bands

TFORMer processes an output request in the following way:

A data source is read record by record in the native order of the data source. TFORMer does not
change the order of the records.

After starting a print-job the first record is loaded. If no record exists TFORMer does not produce
any output.

Then, for each available data record, TFORMer internally iterates through all bands in the layout.
Whether a band should be printed on the current printing position on the output page depends on
the following rules:

If the current record is the first record of the input data, all defined report headers are
printed.

If the current record is the first record within a group, all defined group headers are printed.
All defined detail bands for the current record are printed.

If the current record is the last record within a group, all defined group footers are printed.

If the current record is the last record of the input data, all defined report footers are printed.
Printing page headers and page footers is triggered automatically. It works completely
independent from the current record.

>

>

Keep in mind that TFORMer supports multiple bands of the same type in one layout (e.g.,
multiple page headers).

Whether a specific band is printed or not can be controlled via printing conditions.

For more information on bands, please refer to chapter 7.
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5.5 Typical Workflow

The typical workflow when designing a new layout is outlined below.

5.5.1 ldentify Dynamic Data

The first step before creating a layout is to identify the static and dynamic content of the layout.
Dynamic content is usually provided by the user or by external data sources via placeholders.
These placeholders are called data fields and are filled with current values during print-time.

5.5.2 Layout Design

To create the layout, you either modify one of the numerous available templates, or you create your
own layout.

Layouts are composed of different logical areas called bands. When designing a layout you can
combine different bands to create different layouts schemes. Each band can contain different
graphical elements (text elements, barcode elements, shapes and images). Dynamic features (e.g.,
printing conditions) give you additional control over the output.

For more information on designing layouts, please refer to chapters 6 to 12.
5.5.3 Provide Data

Before you can generate any output you have to specify the data to be printed. The data can be
provided in different ways:

= |t can be edited manually.
= |t can be imported from an external file or from a database.
= |t can be provided programmatically via the TFORMer SDK.

For more information on providing data, please refer to chapter 13.

5.5.4 Generate Output

Once you have designed your layouts you can assign different data sources to generate output with
different content. For details, please refer to chapter 15.
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6 Documents (Forms)

6.1 Introduction

TFORMer documents are also called forms. A form contains the graphical design (the layout),
which consists of one or more vertical areas holding all graphical design elements. Furthermore it
contains all data fields, data sources, tray mappings and layers.

6.2 Basic Operations

6.2.1 Open an Existing Document

To open an existing document select File » Open... from the menu or press the keyboard shortcut
Ctrl+O. Then select the requested file and press OK to confirm.

Alternatively you can double-click on the .ff file in the Windows® Explorer, or drag the file from the
Explorer to the TFORMer window.

6.2.2 Create a New Document

To create a new document select File » New... from the menu or press the keyboard shortcut
Ctrl+N. The following wizard will appear:

r ~
Create New Form @

Template
Which template should be used to create the new form?

Choose a template for the new form

Template Description
Bl <Custom Report>

=] <Custom Label>

(=) (1) Automotive

() () Transportation

(3 (3) Business Cards

() (4) Company Logistic Labels

IC3) (5) Tape Labels

opeo

() (6) Samples [2)
2 (7) Overviews
() (8) Medical 3]

9 < Back Finish |[ Cancel ][ Help

. .

Figure 22: Create a New Document

Select the template that you want to start with. Choose between:
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Custom report (see section 6.2.2.1).

Custom label (see section 6.2.2.2).

Ready-to-use label or report templates for industry, logistics and the medical branch.
Sample and overview layouts, demonstrating the functionality of TFORMer.

oo 0O0e

Select the desired item and confirm your selection with Next respectively with Finish (see ©). If all
required adjustments are done the according layout will be opened in the design window.

The layout can be adapted to your needs by adding, removing or modifying bands and design ele-
ments.

If you want to design your own report, choose <Custom Report> and click Next. The following
wizard will appear:

WWW.TEC-IT.COM

P ~
Create New Form &J
Page Settings
Spedfy the page size and the layout type
: 4 Paper (Media) Orientation
o q Format:  |a4 ~| @ Portrait -
| ] A
Width: 21am ) Landscape j
s ; [ Printer Default
Simple Height: 29,7 cm -
Margins - Output -
Tap: 1.5am Left: 1.5cm Rotation:
Bottom: 1.5cm Right: 1.5 m 2}
I 2|
Columnar
Repaort
Complex
Report
MNext = [ Finish a | Cancel I | Help

" 4

Figure 23: Simple Report — Page Settings

Choose the desired layout type in @. Normally this is the type Simple Report.
Then specify the page size, the orientation and the page margins in ®.
Click Finish ® to open the layout.

The following layout was created with the settings as shown above. Reports typically have a report
header, a page header, followed by a list of data records (detail bands), a page footer and a report
footer. Upon creation of the new report 10 records are inserted automatically. For each of these
records TFORMer generates one “row” in the report.
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Maport Hestds

FapmtP i

Figure 24: Simple Report — Layout View

6.2.2.2 Custom Label: Label Sheet

s by Faa

Figure 25: Simple Report — Print Preview

If you want to design your own label for laser or inkjet printers (e.g., Avery® standard label formats),
choose <Custom Label> and click Next. The following wizard will appear:

' ™y
Create New Form &J
Page Settings
Spedify the page size and the layout type
— Predefined Templates
|
| II [ Select Label Template ... @ ]
|
|
| : ] )
Paper (Media) Crientation
Label - A
Printer Format: [A4 v] @ Portrait
Width; 21 am © Landscape ﬂ
(7 Printer Default
(1] Height: 29.7cm :
Margins Output
Label Top: 1.5am Left: 1.2am Rotation:
Sheets Bottom: L.5cm Right: 1.2cm
Label Settings
Width: acm Columns: 3 - SpacingX: 0.2cm
Height: S5cm Rows: 5 - Spacing ' 0.2cm
Complex Print Order
Labels (@) Across, then Down 2 ©
() Down, then Across 314]
Mext = [ Finish q ’ Cancel ] ’ Help

-

Figure 26: Label Sheets — Page Settings

Choose the layout type Label Sheets ® (= print multiple labels on one output page).
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In ® you specify the paper size, the page orientation and the page margins. Furthermore you can
specify the label dimensions, the number of rows and columns (= the number of labels per page),
the row- and column-spacing and the printing order for the labels.

= e : - In order to select one of the predefined label

T templates use the button Select Template... ®.
o e o aam e d The selection dialog shows a list of all available
e e o piE = s i, format definitions (see figure on the left). Use the

filter ® to narrow down the selection. After you
s have chosen the desired format in @ confirm with
s OK.

Click Finish @ to open the layout.

The following layout was created using the settings as shown above (3 columns, 5 rows, label
dimensions of 6 cm x 5 cm, row-and column-spacing each 2 mm). Labels typically use the detail
band only. No page headers or footers are used by default. Upon creation of the new label some
records are inserted automatically. For each of these records TFORMer generates one label.

.-|-'-|-2-|-3-|-4-|-5-|-'5-|-
| — b Edit Detail

n .IIa-Ja I.-.-.r: i .II-..II J-.ir ) .Iu o 3 l_.a.':-
N izprinted once for each data recond

3 Lakel [Prirtedlitems] on Page [Page]

- Haw dav i lmmitil . on M d .
4

5

? _Ill'#:u'-_a‘iﬂ: 4 _Ib':-'lll_.-lr L _lhll:_!n':l_.'\f_-_
Figure 27: Label Sheets — Layout View §

[reapr I e i e

[Hb L II.'ITJ'Ju.lI: R ] e

Figure 28: Label Sheets — Print Preview
6.2.2.3 Custom Label: Label Printer

For printing labels with label printers (e.g., thermo transfer printers), choose <Custom Label> and
click Next. The following wizard will appear:
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- 1
Create New Form &
Page Settings
Spedfy the page size and the layout type
= | Predefined Templates -
I
o =il | Select Label Template ... @ |
If
il
— Paper (Media) - Crientation
Print &t'.' Format: | <Custom Format = - (@) Portrait
Width: 6am @ Landscape &
— ) (7 Printer Default
Height: 5cm
11 Cutput -
| M- (3) »
I =bel Rotation: g2 B
Sheets
| |
| |
Complex
Labels
Next = [ Finish @ | Cancel ‘ | Help

e =

Figure 29: Label Printer — Page Settings

Choose the layout type Label Printer @ (= the output page is the label).

In ® you specify the label size and the page orientation.

. - In order to select one of the predefined label
S templates use the button Select Template... ®.
o e e The selection dialog shows a list of all available
i ek meeeE  aa format definitions (see figure on the left). Use the
Do . i filter ® to narrow down the selection. After you
e have chosen the desired format in @ confirm with
- OK.

Click Finish ® to open the form

The following layout was created using the settings as shown above (label dimensions of 6 cm x 5
cm). Labels typically use the detail band only. No page headers or footers are used by default.
Upon creation of the new label one record is inserted automatically. Unless you insert more records
TFORMer will generate exactly one label.
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|.— b+ Edit Detail

Dok

Standard L abel
izprirted once for each data record
Lakel [Prirtedlitems] on Page [Page]

|

4

3

Figure 30: Label Printer — Layout View

Standard Label
is printed once for each data record
Label 1 on Page 1

Figure 31: Label Printer — Print Preview

6.2.3 Page Setup

If you want to adjust the page setup for the opened layout select Page » Common | Setup from
the menu or press the keyboard shortcut Ctr/+Shift+P. Alternatively you can also double-click on the
gray area around the layout. The following dialog appears:

( Label Settings lﬂ‘
I Predefined Templates
gl Select Template ...
Labelll Paper Media Ori!entation.
Printer Format: [A4 - @ Portrait
Width: 21 em () Landscape ﬂ
Height: 29,7 cm () Printer Default
Margins Output
Label Top: 1.5cm Left: 1.5cm Rotation:
Sheets Bottom: 1.5cm Right: 1.5cm
Label Settings
Width: &cm Columns: 3 - Spadng ¥:  0.2cm
Height: 5cm Rows: 5 - Spading Y: 0.2cm
Complex Print Order
Labels @) Across, then Down 1.2
() Down, then Across 31t
[ oK ] [ Cancel Apply
J

"

Figure 32: Page Setup

On this dialog you can do all necessary page adjustments. You can change

= the layout type,
= the paper format and the page orientation
= and the page margins.

= For labels you can additionally adjust the row- and column- settings and the print order

(“Across, then Down”, “Down, then Across’).

plate....

> For labels you can access a large amount of predefined formats by clicking Select Tem-

Using the page setup dialog you specify the exact page layout:
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Paper Format: Width

Paper Format: Height

Margin Top Margin Top
Label
(Detail Band)
= Report Header = Label Label
3 3 (Detail Band) (Detail Band)
IS =
S I
3 )
= Detail Band = " Label
ColumnlWic (Detail Band)
Detail Band Label 3 3:!;) Label
(Detail Band) n:% (Detail Band)
Detail Band
Label
(Detail Band)
Detail Band
Label Label
(Detail Band) (Detail Band)
Detail Band
> ( 1
) K]
Row Spacing &
= 5 .
) Label 3 Label 5 =
D:: (Detail Band) (Detail Band) ’3:: -g
5 5 f
2 g Etikett g
Page Footer = = O £
(Detailbereich) S
w
=
3
&
Margin Bottom Margin Bottom

Paper Format: Width

Figure 33: Page Setup for Standard Reports, Label Sheets, and Label Printers

For more information about different layout variations please refer to Appendix D.

Property
Format
Width
Height

Property
Top
Bottom
Left
Right

Property

Orientation

Property

Rotation

Description

The paper format (e.g., DIN A4, DIN A5, ..., <Custom Format>).
The paper width.

The paper height.

Description

The page margins are used to confine the printing area on the output page. They are specified
with respect to the physical borders of the output page.

Description

The page orientation:

= Portrait

= Landscape

= Printer Default (uses the orientation, which is adjusted in the printer driver)

Description

Output rotation (0, 90, 180 or 270 degrees, counter clockwise).

Instead of rotating the output page (portrait, landscape) you can also rotate the output on the
page.

In order to print multiple labels on one output page (e.g. business cards on an A4 page) you have to
specify the size of the labels and the desired number of labels per page:

WWW.TEC-IT.COM Page 41 of 152




Property Description

Width The width of the label.
Height The height of the label.
Columns The number of labels which is printed besides each other.

(If set to auto, the maximum number of columns that fit on the output page will be selected
automatically.)

Rows The number of labels which is printed underneath each other.
(If set to auto, the maximum number of rows that fit on the output page will be selected
automatically.)

Spacing X The horizontal spacing between the labels.
Spacing Y The vertical spacing between the labels.
Print Order The print order defines the order (“Across, then Down” or “Down, then Across”) in which the labels

are printed on the output page.
This setting is only available when printing multiple rows and columns (see also 6.2.3.4).

6.2.4 Save a Document

To save an open layout select File » Save from the menu or click on the icon ld ~ in the quick ac-
cess toolbar:

u I Save
H Save Saves the current layout.
Shortcut: Ctrl+S
Save as... Saves the current layout with a new name. You can also

save layouts as ZIP-files.
Shortcut: F12

ug Save All Saves all layouts (and repositories) that are currently
opened.

Shortcut: Ctrl+Shift+S

6.2.5 Switch between Documents

To switch between open forms just click on the corresponding tab in the layout window. Alterna-
tively you can use the layout picker . Using the keyboard shortcut Cir/+Tab you will switch to the
next layout tab. Ctrl+Shift+Tab switches to the previous tab.

6.2.6 Close a Document
There are different ways to close an open document:

=  Click on the small x in the layout window tab (see section 4.8, ©).
= Select File » Close from the menu.

= Click with the right mouse button on the form (either in the layout window or in the design
tree window) and select Close Form from the pop-up menu.

= Press the keyboard shortcut Ctri+W.

6.3 Watermark

The Watermark is an image which is used as background for each page.

In order to set a watermark switch to the Page tab in the ribbon menu. In the group Watermark you
can adjust the image file name, the output position and the output size (see also section 4.3.3.3).
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6.4 Document Properties

The following document properties are only accessible through the properties window (see also

Appendix A.1):

= Name for the output or spool file,

=  Comment.

First select the document. Thereafter the properties can be adjusted.

6.4.1 Document Selection

El 2 L 9 - = - - dg o5 | TFORMer - TFORMerl

==

Layout

View SE18CE

ABC [w Barcode =

Data _Selec:-_ Text Content Condition

Start Page TFORMerl >

Arial

B 7 U =
A& -l - &=~z

Repositary/Design

| = Edt Detai

- Standard Label

is printed once for each data

Label [Printeditems] on Page

5

4 L

= Align = %
i
Layers

JOder v -

Arrange

TFORMer1 {3
1J Data Sources
[v.q Data Fields

@ Tray Mappings

[ h_.J Bands

Properties

aED

= Common

Data Source

=| Advanced

Document name

Edit manually (default) |

m

Sefect View:

= Watermark
File Name
Watermark Mode Clip
Watermark Alignment  Top, Left
b
T Grid Settings ~ Q_150% - (=) ) )

"

Figure 34: Document Properties

To select the document choose Layout » Select » Document from the ribbon menu ©@ or simply
click with the left mouse button in the upper left corner of the layout view @. Alternatively you can
also click somewhere inside the gray area @ or you can click on the top level element in the design
tree ®. The square M (respectively [*/ under Windows XP) in ® will indicate, that the form is

selected.

6.4.2 Document Name

The Document Name (category Advanced) is used as name for the generated output file or spool
file. If left blank, the file name of the form is used.

6.4.3 Comment

The field Comment (category Documentation) can be used for documentation purposes.
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7 Bands

7.1

Introduction

A layout consists of one or more bands. Each band is a vertical section, which contains graphical
elements like text elements, lines or barcodes. Each band fulfills a specific purpose and is printed in
a clearly defined position and sequence.

Besides that, bands may be used for computations, and they can be used to control the output
behavior (see chapter 12).

7.2 Band Types

TFORMer supports the following band types:

Report Header

This band is printed at the top of the first page of the output. Alternatively it can also be
printed at the top of the first label. This band is optional.

Page Header

This band is printed at the top of each page (on the first page after the report header).
Alternatively it can also be printed at the top of each label. This band is optional.

Group Header

This optional band is printed before a group starts. A group is defined by the “Group By”
property in this band. Whenever the “Group By” expression changes, a new group is started.
Detail Band

This band is printed for each single record.

Group Footer

This optional band is printed after a group. A group is specified by a “Group By” expression.
Page Footer

This band is printed at the bottom of each page (on the last page before the report header).
Alternatively it can also be printed at the bottom of each label. This band is optional.

Report Footer

This band is printed on the last page of the report (after the last data record). Alternatively it
can also be printed at the bottom of the last label. This band is optional.

First page Intermediate pages Last page

‘ Report Header ‘ ‘ Page Header ‘ ‘ Page Header ‘

‘ Page Header ‘

Detail Band \ Group Footer \

Group Header Detail Band

Group Header

Detail Band Detail Band

Detail Band Detail Band

Detail Band

\ \
‘ Detail Band ‘
\ |

Detail Band Group Footer

\
Detail Band ‘
|

Group Footer

Detail Band

Report Footer ‘

Detail Band ‘ Detail Band

Group Header \ ‘ Detail Band ‘

‘ Page Footer ‘ ‘ Page Footer ‘ ‘ Page Footer ‘

Figure 35: Rendering Scheme for Bands (Report)
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The figure above shows the printing of a report. When printing labels, typically no page- and report
headers/footers are required. The detail bands will be arranged differently (see also Appendix D).

7.3 Basic Operations

7.3.1 Insert a Band

Layout Page Data

e [aec] 28 (8] SO |l )
Select

Preview

Data Text Barcode Picture Shape

- - - -

View Select Insert

- -

.ﬁ Report Header...

Start Page” TFORMerl ™ Page Header...
..""'I'Z"'3"'4"'5""5"'7fﬁGroupHeader...
| — [ Edit Page Header 9 B4 Detail..
- o . Q Group Footer...
Q Page Footer..
Q Report Footer...

Band Content Condition = -

Arial -1z - B £ O

I
b
&
LS
]

i

;
z
=
o
Al
3
@

m

b— I3 Edit Detail

_ L. . isprinted once for each data recard
Label [Prrteditems] on Page [Fage]

| — Q Edit Page Footer

o

Figure 36: Insert a Band

To insert a band select Layout » Insert | Band from the menu and choose the desired band type
(see ©@). The band will be inserted as a vertical section on the worksheet.

Report Header...

) i Band

Page Header...

[N

Group Header...

Detail Band...

Group Footer...

Page Footer...

BBy 0

Report Footer...

7.3.2 Band Selection

Inserts a new report header.
Inserts a new page header.

Inserts a new group header. For each group header you
have to define a group by expression (see also 7.3.10).

Inserts a new detail band.

Inserts a new group footer. For each group footer you
have to define a group by expression (see also 7.3.10).

Inserts a new page footer.

Inserts a new report footer.

To select a band, click on the band header ® or on an empty area inside the band. You can also
select a band in the design tree. Once a band is selected, it can be copied, deleted or its properties

can be adjusted.

7.3.3 Expanded/Collapsed Band View

Bands can be displayed in expanded or in collapsed view. The collapsed view is used to hide a
band during the layout design. The resulting output is not influenced!
Click on the # symbol to expand, and on the =l symbol to collapse the band view (see ©).
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7.3.4 Adjust Band Properties

To adjust the band properties, first select the band. Then the properties can be edited in the proper-
ties window. For a list of available properties, please refer to Appendix A.2.

7.3.5 Change Size

The width of bands is usually defined by the page setup (see 6.2.3). Each band gets the maximum
available space which is available (= paper width minus the page margins).

For complex layouts certain bands may also be adjusted directly in the layout.

For labels the height of detail bands, group headers and group footers is preset and fixed according
to the label size (see 6.2.3).

For reports the height of bands is freely adjustable. It can be changed with the mouse by clicking

and dragging the lower band margins (see Figure 36, @). Alternatively you can adjust the height in
the group “Position” in the properties window.

7.3.6 Change Band Printing Order

If your layout contains more than one band of the same type (e.g., three detail bands), TFORMer
processes them from top to bottom.

The position of bands can be changed. Click the Edit link in the band header (or right-click on the
band) and select Order from the appearing menu. Alternatively you can also use the keyboard
shortcuts Alt+ and Alt+V to move the selected band.

7.3.7 Delete a Band

Select the band that you want to delete and press the Del key. Alternatively you can also right-click
on the band and select Delete from the pop-up menu.

7.3.8 Printing Conditions

For each band you can specify a printing condition. A printing condition decides at print-time whe-
ther a band is printed or not.

For more details on printing conditions, please refer to section 12.2.
7.3.9 Pre- and Post-Evaluations

For each band you can specify pre-evaluation and post-evaluation expressions. These expressions
will be evaluated before and after the band is printed.

For more details, please refer to section 12.4.
7.3.10 Grouping

By using group headers and/or group footers you have the possibility to achieve a grouping for the
output:
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First insert a group header and/or a group footer.
Then enter an appropriate group by expression. Click
the Edit link in the band header (or right-click on the
band) and select Group By from the context menu.

The expression editor (see also section 11.2) will
appear.

In the expression editor enter the group by
expression. This expression works as follows: Every
time the computed value changes a new group will
be started and the corresponding group header
respectively footer is printed.

Please note that the group by expression must be
entered for each single group header respectively
group footer in the layout!

When generating the output the records will be
grouped accordingly.

Please note that the group by expressions does not
change the order of the records in the data source!
The records must be provided in the correct order
already.
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8 Elements

8.1 Introduction

Elements (or graphical design elements) are all sorts of printable shapes like texts, barcodes, lines,
rectangles, circles and pictures. They are placed on the bands to create the layout.

8.2 Basic Operations

8.2.1 Insert an Element

Layout Page Data Preview
. — : . =9 :
E asc| EB8 (WW| 0| || 7

Data Select | Text .Barcode Picture Shape Band Content Conditio

- - - - - -

View Select Insert Edit

Start Page TFORMer2 x

st e 200 34 B B o T B B 10 e

[ i_ ﬁ Edit Detail
_ " _ |
1 " ABGabc = _ 9

c

Figure 37: Insert Element

To insert an element (e.g., a barcode) into your layout, first click on the appropriate symbol in the
ribbon menu (@). Then place the element on one of the bands inside the layout (®). You can place
elements in two different ways:

= A single mouse click on the worksheet will insert the element with its default size.

= If you click and drag a frame with the mouse pointer (while holding down the mouse button),
the element is inserted in the given dimensions upon release of the mouse button.
Please note that the modifier keys which are described in section 8.2.3 will also apply for the
insert operation.

Select Selects existing elements (or bands) in the layout view. This tool is enabled by default.

Text Inserts a text element.

A text element provides formatted text. The content may consist of static and dynamic
data (see also section 8.3.1). Depending on the required content type choose one of the
following options. Please note that the content and its type can be changed at any time
(see section 9.3).

11 | Data Field Shows the content of a data field (without any additional
information). (See also section 9.4.)

aac| | Formatted Text Shows an arbitrary formatted text, which may be enriched
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with data fields and expressions (see also section 9.5).

ir= | Expression Shows the result of an expression (see also section 9.8).

m:m | Barcode Inserts a barcode.

= A barcode encodes the given data in a machine readable form. The content may consist
of static and dynamic data (see also section 8.3.2). Depending on your requirements
choose one of the following barcode types. This type can be changed at any time (see
section 4.3.2.6).

Recently Used Choose from the most recently used barcode types.

[mm) | Linear Barcodes Choose the barcode type by category.

For more information on barcode types and their possible
adjustments, please refer to the “Barcode Reference”
which is available for download on www.tec-it.com.

[mm) | 2D Codes
[ | Postal Codes
[mm) | GS1 DataBar
[m) | HIBC Codes

= Picture Inserts a picture.
rly The name of the image file may be specified as fixed text or computed (see also section
8.3.3).
1 Shape |_| | Rectangle Inserts a rectangle.
__| | Rounded Rectangle Inserts a rectangle with rounded corners.
._) | Ellipse Inserts an ellipse.
[=] | Line Inserts a line.

For a list of element properties, please refer to Appendix A.3.

8.2.2 Element Selection
In the layout view you can select elements in various ways:

= Click with the left mouse button on an element.
Hold down the Shift key or the Cirl key for multiple selection.
= Click with the left mouse button in an empty area of the layout view and (while holding the
mouse button pressed) drag a selection frame around the required elements. Then release
the mouse button. Depending on the direction, in which you have dragged the selection
frame, different selection criteria are used:
- Drag frame from left to right:
Only objects that are entirely overlapped by the frame will be selected.
- Drag frame from right to left:
All objects that are entirely or partially overlapped by the frame will be selected.

Small rectangles (sizing handles) on the corners and on the sides indicate that the element is se-
lected.

> To start a selection frame over an existing graphical element try to hold down the Shift or the
Ctrl key. This will prevent other elements (which might be under the mouse pointer) from
being moved.

WWW.TEC-IT.COM Page 49 of 152



http://www.tec-it.com/

L T T - T T O T < e - N - O

| — | Edit Detail

e
] =) ]
ofextbox ® o
) ° =) |
o- [, 0 |
(3) o

Figure 38: Element Selection
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8.2.3

After

This element has the mouse focus (bold outline). If you click your left mouse button, it will be
selected.

This element is part of a selection. Because it does not have the selection focus its sizing
handles are drawn as outline (=).

This element is part of a selection and has the selection focus. This is indicated by solid sizing
handles ().

If you adjust the size or the alignment of two or more elements (see sections 8.2.11.1 and
8.2.11.2), the focused element will act as “master”. This means its properties (or property
changes) will be applied to the rest of the selection. The last element that is added to the
selection always receives the selection focus.

You can set the focus within a selection by clicking on the required element. Do NOT hold
down any modifier keys, like Shift or Ctrl!

This element is not selected.

Change Element Size

selecting an element, you can change its size by clicking and dragging the sizing handles.

While changing the size you can use the following modifier keys:

Modifier Key Description

Shift

Ctrl

Alt

Square/Circle.
The width and the height of the element are set to the same value.

Centered.

The element center is maintained. The change is applied with respect to the center.
Fine positioning.

Allows a positioning off the grid. (For setting up the grid see sections 4.7, ® and 17.2.2.)

Alternatively you can also edit the element size in the properties window.

>

Please note: If the selection contains more than one element, all selected elements will be
resized simultaneously.
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8.2.4 Move an Element

An element can be moved by clicking and dragging. While dragging you can use the following
modifier keys:

Modifier Key Description

Shift Move horizontally/vertically.
The movement of the element will be restricted to the horizontal and vertical axis.

Ctrl Copy mode.
A copy of the original element(s) will be created on the release position. In copy mode the mouse

pointer changes its shape to tﬁa

Alt Fine positioning.
Allows a positioning off the grid. (For setting up the grid see sections 4.7, ® and 17.2.2.)

8.2.5 Rotate an Element

In order to rotate an element first you need to select it. Then click and drag the rotation handle @\E
until the desired orientation is reached. While dragging you can use the following modifier keys:

Modifier Key Description
Shift 15° Steps.

The element is rotated in 15° steps.

Alternatively you can enter the required rotation in the group Position in the Properties Window.

» Please note: For text, barcode and picture elements the direction of the content can be
adjusted separately (independent from the element rotation). To change the text direction
use the button /! in the Layout tab, group Format (see section 4.3.2.5). Alternatively you
can also adjust the Text Direction in the Properties Window, group Common.

8.2.6 Element Properties
To change the properties of a selected object, you can:

= Edit the desired properties in the Properties Window.
= Use the Format commands in the ribbon menu (see section 4.3.2.5) to change common
settings like font style, background color, etc.

8.2.7 Positioning and Measuring

Graphical elements are either positioned with the mouse or by entering the corresponding values in
the properties window.

When using the mouse the rulers and the status bar assist you with measuring and positioning
elements.

When entering measures in the properties window please note: If no unit is given TFORMer
interprets the value as mm or as inch (depending on your system settings). However, you may also
specify the measurement unit by appending common abbreviations (mm, cm, inch, mil) to the
numeric input.

8.2.8 Delete an Element
You can delete selected elements in various ways:

= Press the Del key on the keyboard.
= Right-click on the element. Then select Delete from the pop-up menu.
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8.2.9 Printing Conditions

For each element a printing condition can be specified. The condition decides at print-time whether
the element is printed or not. In order to edit a printing condition first select the Element, then use
the menu Layout » Edit | Condition.

For more details on printing conditions, please refer to section 12.2.

8.2.10 Assign Elements to a Printing Layer

A printing layer gives you the possibility to use a single printing condition for multiple elements. This
condition lets you control whether all elements assigned to the layer are printed or not.

By default, only one layer (the “Base” layer) is available. Newly created elements are automatically
assigned to this layer.

Please note: The printing layer does NOT affect the z-order, in which the elements are printed!

For more details on printing layers, please refer to section 12.3.

8.2.11 Helper Functions for Design Elements

These functions simplify the creation of layouts. You can make all selected elements the same size,
you can adjust the spacing between selected elements, and more.

The following properties can be adjusted:

= Alignment

=  Spacing (horizontal and vertical)
= Size

= Z-Order

The respective functions are available via the ribbon menu under Layout » Arrange.

» When changing the alignment or the size of selected elements, the element with the
selection focus (see 8.2.2.1, ©®) acts as master: all selected elements will be changed ac-
cording to its values!

Select at least two elements. Then choose one of the following functions. The element with the
selection focus acts as master.

|5 | Align |5 | Left Aligns the selected elements to the left.
Shortcut: Cirl+ <
1-1;" Vertical Aligns the selected elements vertically centered.
%52 | Right Aligns the selected elements to the right.
Shortcut: Ctrl+>
ﬂ Top Aligns the selected elements to the top.
Shortcut: Ctri+
—;-—_I- Horizontal Aligns the selected elements horizontally centered.
% | Bottom Aligns the selected elements to the bottom.

Shortcut: Ctri+v

Select at least two elements. Then choose one of the following functions. The element with the
selection focus acts as master.
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=+ Align

Sk

Mo :

Vertical Make Equal Makes the vertical spacing between the selected
Spacing elements equal.
1"1[ Increase Increases the vertical spacing between the selected
' elements.
_;J'; Decrease Decreases the vertical spacing between the selected
elements.
Horizontal i | Make Equal Makes the horizontal spacing between the selected
Spacing elements equal.
{_{- Increase Increases the horizontal spacing between the selected
elements.
_J‘J*-"_ Decrease Decreases the horizontal spacing between the selected
elements.

Select at least two elements. Then choose one of the following functions. The element with the
selection focus acts as master.

| Size = | Same Width Applies the same width to all selected elements.
[f] | Same Height Applies the same height to all selected elements.
|| | Same Size Applies the same size to all selected elements.

Select at least one element. Then choose one of the following functions:

-;l_l Z-Order -;l_l Move to Top Moves the selected elements to the foreground.
—_II Move Up Moves the selected elements up one level.
__II Move Down Moves the selected elements down one level.
1, | Move to Bottom Moves the selected elements to the background.

8.3 Elements with Content

8.3.1 Text Elements

Text elements are used for printing formatted text. Single phrases, words and characters can be
formatted individually. Data fields and expressions can be embedded within the text.

LI - I R e N - I I |

| | — Iﬁ Edit Report Header

! Inventory List

1 ACME Laboratories

2| [Creation Date: [Now (}] .

Page [Page] of [MurmPages]
(1)

Figure 39: Text Element

In the example above static and dynamic content is mixed. The embedded expressions for the
current date [Now ()], the current page number [Page] and the total number of pages [NumPages]
are placed in-line with the static text. During print-time these expressions will be replaced by the
actual values automatically. Such dynamically provided content is always displayed between square
brackets “[]” (see @) or angle brackets “<>":

= Square brackets indicate that the content of the data field respectively the result of the
expression will be inserted as is.
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= Angle brackets indicate that the content of the data field respectively the result of the
expression will be interpreted as HTML. This allows you to specify dynamic content with
additional formatting (see also section 9.5.3)!

For information on how to edit the content of text fields, please refer to chapter 9.

8.3.2 Barcode Elements

Barcode elements encode the given data in a machine readable form.

LI - I R e N - I I |

' |.—I§@Detail
bl2g  [AtideNojg

)| AaB ricieNo] g

Figure 40: Barcode Elements

The barcode data can contain static content (e.g., the fixed string “AaBb12”, see @), dynamic con-
tent (e.g., the data field ArticleNo, see @), or a combination of both. Dynamically provided content is
always displayed between square brackets “[]”.

For information on how to edit the barcode data, please refer to chapter 9.

> Please note: The barcode symbol in the layout view is just a sample. It does not encode the
actual data! The correct barcode is computed during print-time.

The Barcode Type and other barcode specific settings are adjusted in the properties window. You
can choose from 1D, 2D and composite barcode symbologies. Depending on the selected barcode
type different property groups are available

For more information on available barcode types and their possible adjustments, please refer to the
“Barcode Reference” which is available for download on www.tec-it.com.

8.3.3 Picture Elements

Picture elements are used to embed images in the layout. Supported image formats are BMP, GIF,
JPG, PCX, PNG, TGA and TIF.

v et e e 2 3 e B g B T

T l = {4 Edit Detail

e

Figure 41: Picture Elements

The actual image is usually specified through a fixed file name (see ©). If you want to use different
images for different records (dynamic logos) you can also compute the file name dynamically (e.g.,
based on a data field value, see 8).

For information on how to edit the image file name, please refer to chapter 9.
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» You can use absolute file names (e.g., “C:\sample.jpg”) or relative file names (e.g.,
“sample.jpg” or “img\sample.jpg”). Relative file names are treated relative to the base path of
the layout file.
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9 Element Content

9.1 General

All text, barcode and picture elements are filled with

9.2 Content Types

specific content.

When assigning data you have the choice between the following three different content types:

= Data Field (Computed Field, Serial) — see 9.4

Provides the value of the given data field (dynamic data). This type is typically used for

barcodes or simple text elements.

= Text (Formatted Text, Simple Text, File) — see 9.5 to see 9.7
A fixed text which may be combined with the content of data fields and/or expressions. This
type is the standard choice for text elements and barcodes. It can be used for the creation of

simple and complex contents.
=  Expression — see 9.8

Computes the content dynamically with the help of the available functions, constants and
data fields. This type can for example be used for dynamic picture file names.

9.3 Edit the Element Content

Whenever a text, barcode or picture element is inserted the appropriate editing dialog is opened

automatically (see Figure 43 below).

In order to edit the content of an existing element, first select the element, then use the menu
Layout » Edit | Content. Instead of using the command Edit... in ® (see Figure 42) you can also
right-click the element and select Edit Content... from the pop-up menu, use the keyboard shortcut

F2 or double-click the element.

Data Preview

5 (] [ j .

ﬁ = "::);..J I / Arial 12
code Picture Shape Band EContent‘!COHdition ,5_ = |- A - &
- - - === f—

Data Field il ArticleName
Fed o5 o0 B 0 T o8| 4 |
Computed Field » ArticleMo %
xR - Serial , Quantity
Text Unit
]‘ “““‘i“““l; ExprESSion Nw Data FiE|d“I
ABGabc  _
Figure 42: Edit Element Content
T / Content = | Edit...
Data Field

Computed Field
Serial

Formatted Text /

L For

Edits the element content.
Shortcut: Double-Click the Element or press F2

Assigns one of the existing data fields or a new data field
of the respective type as element content.

Assigns a text (respectively a file name) as element con-
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Text / File

tent.

Expression

Assigns an expression as element content.

The element content is edited via the following dialog:

Figure 43: Edit Dialog for Element Contents

Use the option buttons on the left side to switch between the three different content types:

O Data Field (see 9.4)

® Formatted Text (for text elements, see 9.5)
Simple Text (for barcode elements, see 9.6)

File (for picture elements, see 9.7)
© Expression (see 9.8)

Depending on your selection (@, ® or ®) one of the following dialogs is shown:

9.4 Data Field

The type Data Field is used to provide data field values (without any additional data).
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Figure 44: Edit Dialog — Data Field

Make sure the option Data Field © is selected. Then select the desired data field in list ® and
confirm with OK.

The creation of a new data field is also possible. When double-clicking on “<New Data field...>” an
appropriate dialog will be opened (see section 10.2.1.1).

Please note that TFORMer internally distinguishes between three different data field types (see also
chapter 10):

= Data Field
Provides values from a data source.

= Computed Field
Computes the values based on a user defined expression respectively on one of the built-in
aggregation functions.

=  Serial
Provides consecutive numbers.

9.5 Formatted Text (Text Element)

The type Formatted Text is available for text elements only. It is an arbitrary formatted text, which
may be enriched with data fields and expressions.

WWW.TEC-IT.COM Page 58 of 152




Edit Tesy

= (et P

e R

-5 - B FIU S 2 EEEE (3) =§|

Inventory List

MCME Laborabonies
Craation [ate: |Mow ()
Fage [Pagal of fNumPagas]

@ resilmabes

Figure 45: Edit Dialog — Formatted Text

Make sure the option Formatted Text @ is selected. You can now edit the text in ®@. The toolbar ©
allows you to apply different formatting (single phrases, words and characters can be formatted
individually — see section 9.5.1). Using the buttons @ and © you can insert data fields and
expressions (see section 9.5.2). When you are done with editing confirm with OK.

9.5.1 The Toolbar

Toolbar © provides the following functions:

) Undo Reverts the last change.
Shortcut: Ctrl+Z

(u Redo Reverts the last Undo.
Shortcut: Cirl+Y

Arial Font Name Selects the typeface.

10 Font Size Selects the font size (in points).

B Bold Toggles bold text on/off.
Shortcut: Ctrl+B

i Italic Toggles italic text on/off.
Shortcut: Ctri+/

1) Underline Toggles text underline on/off.
Shortcut: Ctri+U

5 Strike Through Toggles text strike through on/off.

), & Superscript Toggles text superscript on/off.

Xz Subscript Toggles text subscript on/off.

[ ] Font Color Selects the font color.

= Align Left Aligns the text left.
This alignment is applied to the whole text element and not for single lines
or paragraphs. (Same as the Text Alignment property “Top, Left”.)

= Center Centers the text.
This property is applied to the whole text element and not for single lines or
paragraphs. (Same as the Text Alignment property “Top, Center”.)

= Align Right Aligns the text right.
This alignment is applied to the whole text element and not for single lines
or paragraphs. (Same as the Text Alignment property “Top, Right”.)

E:ﬂﬂ HTML Source TFORMer internally uses a subset of HTML (see Appendix B) for storing
formatted text. With this button you can toggle between the WYSIWIG view
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and the HTML source view.

9.5.2 Data Fields and Expressions

In order to provide dynamic content you have the possibility to insert data fields and expressions in
line with the formatted text. Use the following buttons for inserting. For more information on data
fields and expressions see chapters 10 and 11.

[ Insert Data Field... ] Insert Data Opens a selection dialog for Data Fields (analogous to section 9.4).
Field In this dialog select the desired data field from the list and confirm with OK.
[ Insert Expression... ] Insert Opens the Expression Builder (see sections 9.8 and 11.2).
Expression In this dialog compose the desired expression using the available functions,

constants and data fields. Then confirm with OK.

The data field respectively expression will be inserted at the current cursor position. Data fields and
expressions are marked with square brackets “[]” (or angle brackets “<>” in case of HTML content —
see section 9.5.3):

Please note:
» Data fields and expressions must always be inserted using the appropriate buttons!

» If you try to enter the expression start- and end-markers [] (or <>) via keyboard, the text will
not be evaluated as an expression!

For formatting the in-line data fields and expressions use the format toolbar ® as you would do for
the rest of the formatted text. For dynamic formatting you can also use HTML formatted expressions
(see below).

To edit an existing data field or expression place the cursor between the square brackets and click
on the Insert Data Field... or Insert Expression... button. The appropriate dialog will be opened.
Alternatively you can also double-click on the data field (or expression) which will always open the
expression builder.

Hint: The functions Insert Data Field... and Insert Expression... are also available via context menu
when right-clicking inside the text area.

9.5.3 HTML Formatted Expressions

In order to provide dynamic text formatting you can use HTML formatted expressions.

This feature allows you to control the appearance of a text element during print-time.

If the & button is pushed inside the expression builder (see Figure 58, ®), the result of the expres-
sion will be interpreted as HTML content. This means, all supported HTML tags that are found in the
result of the expression are directly applied. For a list of supported HTML tags, please refer to

Appendix B.
.J]§D1 ; | 'D2 '_l' e Rl RO SRS R e In this example the data fields “ColorOn” and
= etail - Detail “ 9 T .
g - ColorOff” are utilized for dynamic text format-
- |<ColorOn=Hello World<ColorOff= ting. y

Copies | ColorOff| ColorOn In order to apply different font colors the ap-
1 L Eheeeedeeiees propriate HTML tags (<font color=xxx> and
1 </font>  <fontcolor=#394383>  </font>) are inserted in the Data window. In

8 this case this is done for the first two records.
The following eight records are printed with
default formatting (as applied in the text
editing dialog).
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Hello World When printing, TFORMer reads the content
Hello World of the fields in the data source. The contained

R e font tags are directly applied to the output.
Hello World

Hello World
Hello World
Hello World
Hello World
Hello World
Hello World

9.6 Simple Text (Barcode Element)

The type Simple Text is available for barcode elements only. It allows you to mix unformatted text
with data fields and expressions.

Edit Barrode-Cuia HH
& (nin P L B

. Gusgla Tl J :-‘:‘-EELHE'

® Empreman 9

Figure 46: Edit Dialog — Simple Text

Make sure the option Simple Text @ is selected. You can now edit the text in ®. Using the buttons
©® and O you can insert data fields and expressions (analogous to section 9.5.2). When you are
done with editing confirm with OK.

9.7 File (Picture Element)

The type File is available for picture elements only. The file name can be entered manually or via
file selection dialog.

" Edit File Mame ==
| [(>pmmm ]
e 2 etk Frarme arrgle Sctom e pm e =]
T e
Wi 0 e abepine iy nawwes (. g, “Cremmple pe o relaiiee M rarnes o g, "sample jog " or S lsanpke g for penees. Asadve
® Eapesmon Pl narver ars hwawd rea e 1o Hhe e mat of doe oot fla
oK | oo
|

Figure 47: Edit Dialog — File
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Make sure the option File ©® is selected. Then specify the file name in ® and confirm with OK. The
button (= opens a file selection dialog.

For dynamic image file names (e.g., different images for different records) use either the option

Data Field or Expression.

9.8 Expression

The type Expression is required in special cases only (e.g., calculating the file names for dynamic
picture content). For all common applications it is recommended to use the option Data Field or

Formatted/Simple Text. Expressions can be embedded in-line with such text content.
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Figure 48: Edit Text Dialog — Expression

Make sure the option Expression © is selected. You can now edit the expression in ®@. The over-

view in ©® helps you to find the required functions.

For more information on expressions see chapter 11.
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10 Data Fields

10.1 Introduction

For providing dynamic content TFORMer uses so called data fields. These data fields serve as
placeholders for the actual data. They can be used in text, barcode and picture elements (dynamic
logos).

A data field must be defined before it can be used. This definition takes place directly in the layout
(see below) or in a repository (see chapter 16). One layout can use an arbitrary number of data
fields (0..n).
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Figure 49: Data Fields as Part of the Printing Concept

In the layout TFORMer displays each data field in square brackets “[]” (or angle brackets “<>” for
HTML content) — see ©. The current value of a data field is available on the print-out respectively in
the preview only (®). The value of a data field is either

= provided manually (see section 13.3.1),

= provided by an external data source (e.g., imported from a database — see section 13.3.2),
= aserial number (see section 10.3.3),

= computed per record (see section 10.3.2),

= computed for specific bands (pre- and post-evaluation — see section 12.4) or

= provided programmatically by a software developer (see section 15.3).

If no value was loaded (or computed), the data field returns its default value (see section 10.3.1), its
start-value (see section 10.3.3) or zero (see section 10.3.2).

» In order to provide the data from an external data source, the data field has to be bound to
the required field in the data source (to the so called source field). Please note: Data field

and source field need not necessarily have the same name (see section 13.4).
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10.2 Basic Operations

The design tree window lists all available data fields in an alphabetical sort order (see ©). If you
want to edit an existing data field or if you want to create a new data field, right-click on the respec-
tive tree item. A context menu with the appropriate editing commands will appear.
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Figure 50: Maintain Data Fields

If you are in the data view (see @) you can also edit the data fields via the corresponding com-
mands in the ribbon menu @ or in the data grid ® (e.g., double-click the respective column header
or click on <New Data Field>).

New Inserts a new data field (see also section 10.2.1.1).

;\t:]- Edit Edits the selected data field (see also section 10.3).
18]

For more detailed information on creating and editing data fields, please see below:

10.2.1 Create Data Field Definitions

Data field definitions can be created manually, or they can be imported from a data source.

10.2.1.1 Create Data Field Definitions Manually

To create a new data field definition either use the context menu in the design tree or select Data »
Data Fields | New from the ribbon menu. Alternatively you can also right-click in the gray area of the
layout or on the entry “Data Fields” in the design tree and select New Data Field... from the pop-up

menu.

The following dialog is opened:
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Q" ™
%.1| New Data Field [

General

Name:

ArtideMame
Data Type: Default Value:
| Text hd

Description

[ OK J l Cancel

Figure 51: New Data Field Dialog

Depending on your requirements choose the kind of data field that you want to create:

© Data Field (see 10.3.1)
A conventional data field provides values from a data source.

® Computed (see 10.3.2)
A computed data field provides values, which are computed via an expression respectively
with the help of the built in aggregation functions.

©® Serial (see 10.3.3)
A serial number field provides consecutive numbers.

ey Da"acﬂe'd; . Once the data field is inserted you will find the appropriate entry in the
g i design tree: Normal data fields are listed directly under the branch “Data
=) AticleName (D) Fields” (see @). Computed fields and serials are listed in the
[z ArticleNo corresponding subfolders.
[2z] ArticlePrice

Used data fields are displayed in black (= the data field is used in the
layout, within a computation or in a printing condition). Unused data fields
are displayed in gray.

When using an external data source you can generate all data field definitions automatically. In the
data source configuration dialog go to the tab Field Bindings (see section 13.4) and press the button
Auto.... TFORMer will suggest to create and assign a new data field for each source field which is
not already used in the current layout (or repository). The data type “Text”is assigned automatically.

Using this function you can create numerous data field definitions automatically. All field names
of an existing data source are imported.

10.2.2 Use Data Fields in Layouts
Once a data field was defined it can be used

= as element content in

- text elements (see section 8.3.1),
- barcode elements (see section 8.3.2) and
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- picture elements (dynamic logos — see section 8.3.3),
= in control expressions (e.g., printing conditions — see sections 12.2 and 12.3) and
= in computations (e.g., as operand for computed fields — see section 10.3.2).

To assign a data field to an element edit the element content as described in section 9.3 and select
the desired data field.

Alternatively you may also drag and drop the data field from the design tree to the layout view (see
O below). Drop the data field on an existing element to update its content or drop it on an empty
area to insert a new element. When using the right instead of the left mouse button for the drag
operation you will be offered additional insert options.

[ ;i [ — e

agp] = Darosde = - - 5 1 - &

== d| — g packure ) B orou - - iy e Loyer
25 1+ Seheit Tewt Eang il Candin & Amange
= . - |_|Shape = = £ e d = 2 o % shaw Layers
Wit Page | Datadl % v Repoutswgesion
" T EIRERE T v d ot Rt Mg T Ry BTG e ey g g s | ] Osnd [RATECTTRORMar ek Dt tion Do
- g | [ 1§ Det> Sourmes
=7 S Dekail T l_ - Jig et Fiaddy
4 [P i [E! mpa e
S| [trmckebio] | [Aniclerame] p 1)) =
= 1| G Group Footer - = Sy
-] ; =) Aticiehane
= | 1%3 o = Aoiehia
1] k Si) Miicla e
=1 F l: Tray Maopengs
; |
1 i | Sands

Figure 52: Drag and Drop a Data Field
10.2.3 Edit a Data Field

To edit an existing data field first select it in the design tree or in the data grid in the data view. Then
choose Data » Data Fields | Edit from the ribbon menu or right-click the data field and select Edit...
from the pop-up menu. Alternatively you may also double-click the data field.

The “Edit Data Field” dialog will appear (see section 10.3). Use the dialog to adjust the required
settings and confirm with OK. Alternatively you can also directly edit the data field properties in the
properties window.

For a description of data field properties, please refer to sections 10.3 and A.5.
10.2.4 Rename a Data Field
To rename a data field select it in the design tree and thereafter press F2 (or click again on the data

field with the left mouse button). Now you can directly edit the data field name. Alternatively use the
properties window or the Edit Data Field dialog to rename a data field.

> Attention: When renaming a data field TFORMer will NOT automatically update all referen-
ces to this field (e.g., in text elements, pre-/post-evaluations, printing conditions, ...). A man-
ual update is required. — Invalid references will throw errors and are marked with red color
(see section 10.4)!

10.2.5 Delete a Data Field

To delete a data field select it in the design tree and then press the Del key. Alternatively right-click
the data field and select Delete from the pop-up menu.
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> Attention: When deleting a data field, TFORMer will produce errors in all bands and ele-
ments in which the data field is used (e.g., in text elements, pre-/post-evaluations, printing
conditions, ...). Affected elements are marked with red color (see section 10.4).

10.3 The Edit Data Field Dialog

10.3.1 Standard Data Fields
The type Data Field provides the field values from a data source.

1| Edit Data Field =

[} & Data Field General
= Name:

@ Computed Artidetame  (7)

i

7 Data Type: Default Value:
& Seral
Text ( :)v ®
Description

[ K J l Cancel

Figure 53: Edit Data Field Dialog — Data Field

Make sure the option Data Field ©® is selected.

In ® enter a name for the data field. Depending on the field type in your data source you may adjust
a suitable type in @ (Text, Integer, Floating-point). However, for most cases the type “Text” will be
fine. In ® you can specify a default value. This value will always be used if no other value is compu-
ted respectively provided by the data source. In @ you can add an arbitrary description text.

> Please note: Before you can use the data field to access the data from an external data
source you have to create the necessary field bindings (see section 13.4)!

10.3.2 Computed Fields

The type Computed Field computes the values based on a user defined expression. Besides that
you may also apply one of the built-in aggregation functions to the expression result (e.g., calculate
sums).

WWW.TEC-IT.COM Page 67 of 152




1] Edit Data Field =5

@ Data Field General
Name:

1 MyComputedField ®

5o Data Type: Compute per:
[Integer @ V] [Record @ v]
Expression:
2 @ (o]

Aggregation [ Summation
Aggregation Type:

Mone @ - || Al @ @
Description
©)
OK ] [ Cancel

" A

Figure 54: Edit Data Field Dialog — Computed

Make sure the option Computed ©® is selected.

In ® enter a name for the data field. In @ select the data type. The computed value can either be a
text, an integer or a floating-point number. The field value is calculated by evaluating the expression
in @. In ® you can choose, whether the expression is computed for every record or for every record

copy.

Example:
If you set the expression in @ to “NumRecordCopies” the data field will return the number of copies,
which is adjusted in the data source.

A typical application for computed fields is the aggregation / summation of data field values. In ®
you can select one of the following aggregation types:

Selection Description

None Do not calculate any sums.

Running Calculate the arithmetic average for all values within each enclosed region ® up to the current record.
Average — This means, the expression @ is calculated for each record respectively record copy (see ®). The

result is then added to the series of values within region ®. The data field provides the average for
these values.
Pease note: The average of all(!) records is not available before the last record!

Running Sum Calculate the sum for all values within each enclosed region ® up to the current record. — This

means, the expression @ is calculated for each record respectively record copy (see ®). The result is
then added to the series of values within region ®. The data field provides the sum of these values.

Pease note: The sum of all(!) records is not available before the last record!

> Please note: These functions are only available for numeric data types (integer, floating-
point) and not for text!

For Running Sums and Running Averages specify the region in which the values shall be evaluated
(see ®):

Selection Description

WWW.TEC-IT.COM Page 68 of 152




All
Page
Label
Group

Do one aggregation within the whole range of the print-job.

Do a separate aggregation within the range of each new page.

Do a separate aggregation within the range of each new label.

Do a separate aggregation within the range of each new group.

In order to identify the group enter the same condition as for the group header/footer (property “Group

By’) in field @. Whenever the result of the expression changes a new group is started.

When using a filter in field ®, single values will only be considered if the expression returns true.

Thus you can define, which values are considered for the aggregation, and which not.

In ® you can add an arbitrary description text.

In the following example we will summarize all listed prices in a report. The result is printed
underneath the last detail band.

r ~
-1| Edit Data Field [
@ Data Feld | General
MName:
[0 Compued] [Gompriderice  ———
N Data Type: Compute per:
[Floating-point V] ’Record V]
Expression:
ArticlePrice [:]
Aggregation [ Summation
Aggregation Type: Region:
[Running Sum v] [AII -
: I 4 Aggregation Filter:
LerTi ASL vl BarCodes B
5565657 | Char v IR
7RSI | Desk EEC I | {11101 1
FIEV16 | Monkor U || ([ 111111 1]
544533 | Panel aioa JIRNAENN
S4BRE | Coffes Machine anoa JIREMIIN ok | [ cancl
45BBED | Printer oo HEEE
4aFEET | P e | (111
45RE37 | Prione sooa (IRENIN
Tatel price. 83100 <
Figure 55: Calculate Sum

First create a new computed data field (e.g., “Sum_ArticlePrice”). Set the data type to “Floating-
point” (prices are usually given with decimal digits). As expression enter the name of the data field
that you want to sum up (in this case “ArticlePrice”). Choose the aggregation type “Running Sum”
and confirm with OK.

The newly created data field “Sum_ArticlePrice” can now be used in the layout. Place it in the report
footer to print the sum underneath the last list item. You can print the sum directly, or you can
format it. Use the following expression to create a number with up to eight digits before the decimal
point and exactly two digits after the decimal point:

| [Format

(Sum_ArticlePrice,

"HEFHEE£0.00") ]

Of course you can also use digit grouping if required:

| [Format

WWW.TEC-IT.COM

(Sum_ArticlePrice,

UHH, #HH, #%#0.00") ]
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10.3.3 Serial Numbers

The type Serial Number provides consecutive numbers.

:-1| Edit Data Field (S
@ Data Field General

MName:

N Data Type:
0 Seral
[ fieger 5
Start Value: Step Size:
1 & @ =
@mre value after printing

Advanced
Update on: Update Condition:

[Record @ - @ E]

Description

OK ] [ Cancel

0 4

Figure 56: Edit Data Field Dialog — Serial Number

Make sure the option Serial @ is selected.

In ® enter a name for the data field. In @ select the data type. A serial number can either be an
integer or a floating-point number. Enter the start value in @ and the increment in @. If you want
TFORMer to remember the last value which was printed you have to select option ®. In this case
TFORMer will continue with the next serial number on the next print-out.

Instead of making TFORMer remember the last serial value you can also provide each starting
value via an expression (compute it, read it from a data field). To do this, click button [.]. The
expression editor will open.

In field ® you can specify, whether the serial number should be incremented for each new

= Document,

= Label,

= Page,

= Record (default) or
= Record copy.

When using an update condition in @ the serial number will only be incremented if this condition re-
turns true.

In ® you can add an arbitrary description text.

After you are done with editing close the dialog with OK. The serial number can now be used in the
layout. You can print the counter directly, or you can format it. For example, use the following
expression to create an eight digit number with leading zeros:

| Format (MySerial, "00000000")
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10.4 Faulty Data Field References

When renaming or deleting a data field, all references to this data field will become invalid imme-
diately (e.g., in a text element, in the printing condition of a band, etc.). The concerned bands and
elements are marked red to indicate the error. In order to fix the problem all broken references have

to be replaced manually.

Repository/Design

=& TFORMer1 ] 9
|| § Data Sources

[=[ty Data Fields
I=) Computed
I Serals
wr| ArticleNo
wr] Customerho
wr| Description
wr| Express
%7 Flag_InGroup
%] PickingListMo
%7| ProductGroup
%] Quartity_renamed o
%7 Sum_Group Price
%] Sum_Group Units
%7 Sum_TotalPrice
%] Sum_Total Units
wr| UnitPrice
é Tray Mappings

Layers
=] % Bands 9

.ﬁ Report Headers
.ﬁ Page Headers

»

m

=

.ﬁ Group Headers
=] .‘Q Details
5k Detal @

P ] Rect: Background

[ee] [[Description]]

[ [[ArticleNo]]

[ [[Format {CObl{UnitPrice), "...]

e ([Gugrttyl] @
] Rt Semnst - .
5 | Error 'Unknown name. ' in text expression,
| D: [Quantity]
[>=] Li
[*] Line Right
@ ™ e Fretars SE
ol - | ol i) !'.Idll-b-ﬂluh Datail

(Armicleio) | [Descrpton] [Cuantity]

Figure 57: Data Field Reference Errors
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In this example the data field "Quantity” @ was
renamed to “Quantity_renamed”.

The original data field name is still in use in
various bands and elements. For this reason
some errors are displayed (®).

When hovering the mouse over one of the red
objects a short error description is displayed (©).
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11 Expressions

11.1 Introduction

Expressions are used for computing element content or controlling output behavior during print-

time. Expressions can be used

= as dynamic content in text, barcode and picture elements (see section 8.3).

= as printing conditions for bands and graphical elements (see section 12.2).

= as printing conditions for layers (see section 12.3).

= for computed fields and serial numbers (see sections 10.3.2 and 10.3.3).

= for pre- and post-evaluations in bands (see section 12.4).

= to compute the name of the generated output or spool file (see section 6.4.2).
= to filter the input data (see section 13.6).

The syntax used by TFORMer is similar to the programming language C.

Example:
‘ — |o] Edit Page Footer This text element contains formatted text. In line
. with the text the expression “Now()” was inserted. It
CNCate: [Now ()] will return the current system date.
Date: 15.03.2013 During print-time the expression is evaluated:

Instead of [Now()] the current date is printed.

11.2 Expression Builder

Expressions are edited using the Expression Builder:

WWW.TEC-IT.COM
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1

p
[fe| Expression Builder

I Data Fields * || Expression = Description

g g:;:;rgata Fields I=Date («Texts, «Formats) Test for a vald Date

£ Functions IsLeapYear («Dates) Testif Leap Year
= <Al _ || Minute (<Datex) Minute
) Math = || Month («Date=) e Month
(=) Conversions Mow O Now
=) Text Second («Datex) Second
) Date | | WeekOfYear («Date») Week of Year
I Cthers Year («Datex) Year

) Operators [ ] [T

Flease enter an expression manually. You can also add a predefined expression or data field by double-dicking it.
A static text must be specified between apostrophes - "StaticText”.
Text values {or data fields) may be concatenated by using '+, E.g. "concatenated-" + “text”. 9

g Insert Data

Required type of expression: ANYTHING OK

] ’ Cancel

"

Figure 58: Expression Builder

Field @ shows the current expression. To extend the expression in @ you can select one of the

predefined

= Data Fields

The data fields available in your layout.
= Constants

True, False and Linefeed (“\n”).
=  System Data Fields

Data fields that are maintained by TFORMer automatically (the current page number, the

band name, ...)
=  Functions

Mathematical functions, conversion functions, string manipulation, ...
= Formats

Common formats for numbers, date and time values.
= Common Expressions

Frequently used expressions like page numbering (“Page N of M”), the current date and

time, currency formatting, ...

First select the category in ®. Then mark the required item in ® and click Insert ® (or just double-
click on the list item). The item will be inserted at the actual cursor position in @. The text area @

shows additional information on selected items.

If you click OK the expression will be validated. Only expressions with a correct syntax are accep-

ted.

A list of all available functions, constants, system data fields, formats and common expressions is

available in Appendix C.

For text elements, additionally the button = (®) is available. When pushed, the evaluated expres-
sion in @ will be interpreted as HTML. Thus you can provide additional format specifications within
the text. HTML-formatted expressions are marked with angle brackets “<>” (see section 9.5.3).
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11.3 Evaluation Order

The over-all evaluation order for expressions is defined as follows (see also figure below):

1. Printing Condition of the Band

2. Pre-Evaluation of the Band
(Can be used for computing data fields)

3. Printing Conditions of Layers

(These are computed for every band, the results are used later when printing the elements)

4. Printing Condition of Elements in the Band
5. Dynamic Contents for Elements
6. Post-Evaluation of the Band

Steps 2 to 6 will only be performed if the band is printed — in other words: if the printing condition of

the band is true.

Process all Elements of Band

Process Band

Unprocessed
Elements left?

Printing
Condition of
Band

False

Printing
Condition of

Do
Pre-Evaluation(s)

v

Do
Post-Evaluation(s)

Band finished

Figure 59: Evaluation Order
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Evaluate
Printing Conditions Printing False
of Layers Condition of
Element

——

Calculate Dynamic
Content of Element

v

Print Element

|
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12 Smart Layouts

12.1 Introduction

TFORMer offers a number of features, which give you additional flexibility for formatting the output:

= Printing Conditions
(These are used to control whether single bands or elements are printed or not.)
= Printing Layers
(With the help of printing layers you can control the printing of multiple design elements via
one single printing condition.)
=  Pre- and Post-Evaluations
(These are used for performing computations which are specific to a certain band.)
= Invisible Bands
(These are used for controlling special layout features.)
= Tray Control
(This allows you to switch printer trays — even within a print job!)

12.2 Printing Conditions

Printing conditions are used to control the visibility of elements, layers or bands during print-time.

A printing condition is an expression (see chapter 11) which returns either true or false. Printing
conditions can be assigned to elements (text elements, lines, ...), to entire bands and to printing
layers (see below). If a printing condition returns false the corresponding object will not be printed.

> Please note: The result of a printing condition will be converted to the data type “Integer”
(numerical value) if required. A value of 0 is interpreted as false.

12.2.1 Edit a Printing Condition

In order to edit a printing condition first select the object (in this example the page header). Then
use the menu Layout » Edit | Condition. Alternatively you can also right-click on the object and
select Condition from the pop-up menu.

m Layout Page Data Preview
s ] [ =
:ABC ] Barcode ] |

5| Picture || B
Band | Content [Condition| A

Arial

| B

Select | Text

¥

= i « || shape~ = % = =
View Select Insert g & Edit.... k
Start Page ~ PrintingCond.tff X Print
._ L e O O R - B EC - R O A O - I Don'tPrint'

iPri'nt me on top of odd pages.

1 = m |=:[§ Page Header

Figure 60: Edit Element Content

Condition 55 | Edit... Edits the printing condition for the selected object (band,
element or layer).

Print Removes the printing condition.
Thus the object is always printed.

Don’t Print Sets the printing condition to 0 (= false).
Thus the object is never printed.
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For editing the printing condition the Expression Builder (see section 11.2) is used. In order to print
the page header in Figure 60 on odd pages only you would, for example, enter the following printing
condition (see also section 12.2.3):

| IsOdd (Page)
12.2.2 Visual Cues for Printing Conditions

If you have applied a printing condition, the band or the element will be marked with a small red dot:

DI Bands are marked in the layout view and in the
design tree (®). Graphical elements are marked in
the design tree only (©).

. |.— 39@ Page Header
- |Frint me on top of odd pages.

Repository/Design
=] Iﬂ Data #ff [RATECATATFORMertrunk\Distribution®\D) »
|1 Data Sources
[t Data Fields
&= Trey Mappings
Layers
= Bands
,ﬁ Report Headers
= Page Headers
@™ Page Header
|26 [Prirt me on top of odd pages ]
[ Group Headers
= kg Details
= b+ Detail
© ] Rectangle
[eed [[ArticleName]]
[eed [[ArticleNa]]
[ed [[Format (CLng{AdiclePrice)...]
[om) [ArticleMo] b
|| Rectangle
.‘; Group Footers =

m

12.2.3 Examples

To print different headers and footers create at least two bands of the same type. Then use the prin-
ting condition to decide which band shall be printed. E.g., create one page header for odd pages
and one page header for even pages. The expressions “IsOdd(Page)” respectively “IsEven(Page)”
will serve as printing condition.

To print rows with alternating background colors draw a filled rectangle in the background of the
detail band. Then set the printing condition to “IsOdd(Record)”.

12.3 Printing Layers

Printing layers are used to control the visibility of multiple elements with a single printing con-
dition. The printing condition of the layer decides whether all elements assigned to that layer will
be printed or not.
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By default only one printing layer, the layer “Base”, is defined. Newly inserted design elements are
always added to this layer.

Please note:
> One element can be assigned to one printing layer only.
» Layers do NOT influence the z-order of elements!

» Elements assigned to a printing layer may still use additional element-specific printing condi-
tions.

12.3.1 Create a New Layer

. New Layer [ To create a new layer select Layout » Layers |
New Layer from the menu. Alternatively you can
# Layer is 3 pool of Elements with 3 cammon Printing also right-click on the item “Layers”in the design
Condition. Specify the display color of Elements
agzigned to this Layer and the cormman Printing tree and select New Layer. .. from the pop-up
Condition. menu.
Mame; M_|r||_a_|r|e|‘| o
Color. I -0 The “New Layer dialog will appear.
Printing Condition: e G
Diescription: o In this dialog enter the name (@), the color (®) and
the printing condition (©) for the layer. In @ you
can enter an arbitrary description text.
[ Ok ] [ Cancel ]

Repository/Design Once the printing layer is inserted you will find the
== Layersff [RATEC-T\TFORMer\trunk Distribution’\ Do appropriate entry in the design tree (©).

-__'_J Data Sources

[t Data Fields

& Tray Mappings For a description of all layer properties, please refer
=l Layers to Appendix A.4.

T, Base

T, Mylayer @
uj Bands

12.3.2 Assign Design Elements to a Layer
To assign design elements to a specific printing layer, perform the following steps:

First select all elements that you want to assign to the layer. Then use the menu Layout » Layers |

Base - (see O below) to complete the assignment. Alternatively you can also right-click on the
selection and select Assign Layer » MyLayer from the pop-up menu.

Layout Page Data Preview (]

[apg| 2 Barcode - ] /| | I T T, | | = MyLayer [6) !TI
5| Picture et
et - Band Content Condition
- J Shape ~ - - -

View Select Insert Edit Format

Base

EBarcode | Arrange

MylLayer

Start Page  Layers.tff x w | Repaository/Design

z| Layers tf [RATECATNTFORMer trunk\Distrbution
| | Data Seurces

_I-|-'--|-2-|-3-|-4-|-E--l-i\-|-7-|-S-|-5-|-}-5-|-‘Y-|-‘2-|-73-|-'_—
— b4 Edt Detail =
“ilam printedinthe"Bgse”laver.

e é Tray Mappings
-5y Layers

(-7, Base
| | W Ml
> | = m N Bands

Figure 61: Assign Printing Layer

am printed in the_"h@Laver” layer.
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12.3.3 Display Layer Colors

If you want to see which design elements are assigned to which layer, you can make TFORMer
display the layer colors. Use the menu Layout » Layers | Show Layers to toggle between the
following two display modes.

W --torc2o03cac4e B8 T nE Per default “Show Layers”is disabled. All design
[~ 5 Edt oetai elements are displayed in their printing color.
- |l am printed in the "Base" laver.

: | am printed in the "MyLayer" layer.

W cvcteaeze 3 g BB T B If “Show Layers”is enabled all design elements are
| =5 Edt Detail drawn in the respective layer colors.
. | am printed in the "Base” layer. | The layer color can be adjusted in the layer proper-

1 i ion 12.3.1, ®).
| am printed in the "MyLayer" layer. | ties (see sectio 31,0)

12.3.4 Hide Layer Contents

To hide all elements which are assigned to one layer, first select the layer in the design tree and
then use one of the following methods:

= Right-click on the layer in the design tree and deselect Visible in the pop-up menu.
= Double-click on the layer in the design tree.
= In the properties window go to the Common group and set the property Visible to “False”.

12.4 Pre-Evaluation and Post-Evaluation

The pre- and the post-evaluation can be used to compute data fields during print-time.

With this type of evaluation each band can perform arbitrary computations. You have the choice
between computations before a band is printed (Pre-Evaluation) and computations after a band was
printed (Post-Evaluation). If the band is not printed at all (if the printing condition of the band returns
false), no evaluations are performed.

Usually pre- and post-evaluations are used for

= implementing computations which are specific to a band,
= implementing counters,
= formatting data prior printing.

For example, the pre-evaluation in the report header may be used to evaluate one or more expres-
sions at the “beginning” of the report.

Please note:

» When assigning a value to a data field during print-time (computed field, pre-/post-evalua-
tion), this data field will be excluded from data import. It will no longer be filled with any
values from the data source. — A data field which provides the data from a data source
(which is bound to a source field) may therefore never be filled with computed values.
Always use a separate data field for computations!
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12.4.1 Edit Pre- and Post-Evaluations

B I N T T
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Tialn Fisdd [
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Page Break Maone
Pre-Evaluation FormattedPrice; o .-
Post-Evaluation (Empty) (5)
Advanced
Control
Position

Documentation

Columns

=]

Pre-Evaluation
A list of expressions evaluated before the band is
printed. A printing condition is evaluated after

Click the Edit link in the band header (or right-click
the band) and select Evaluation » Pre-Evalu-
ation... respectively Post-Evaluation... from the
pop-up menu.

The following dialog will appear:

First select the data field that you want to compute
in @. Then enter an expression in ®. Click on the
- | button to open the Expression Builder (see
section 11.2).

The computations are evaluated in the order as
they appear in the dialog (from top to bottom). If
you want to change the computation order or if you
want to delete a computation, use the buttons in ©.

The Common group in the properties window of the
band shows all data fields calculated in the pre-
evaluation @.

The post-evaluation © is empty. No data fields are
computed.

12.4.2 Visual Cues for Pre- and Post-Evaluations

= Edit Detail
[ArticleMo]

[AricleMame]

= u:] Bands
ﬁ Report Headers

ﬁ Page Headers
lﬁ Group Headers
= [Ey Detais

ﬁ Detail
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If you have entered a pre- or a post-evaluation
expression, the band will be marked with a small
red sigma symbol in the layout view ® and in the
design tree @.
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12.5 Invisible Bands

Invisible bands are used to perform computations or to control the output behavior of the layout.

An invisible band is a band with zero height. It does not contain any graphical elements like text or
lines, and therefore nothing is being printed.

Invisible bands can be used for:

= Computations (pre- and post-evaluation).

You can initialize a data field in the report header (at the beginning of the printing process).
= Feed Control (insert page- or column-breaks, triggered by printing conditions).
= Tray Control (see section 12.6).

Please note:

» If the printing condition for the band returns false, it will not be printed. This means, no pre-
and post-evaluations are performed, no page- or column breaks are inserted and no tray will
be selected.

» If the height of the band is not adjustable use the menu Page » Common | Setup to change
to the layout type Complex.

12.6 Tray Control

The tray control is used to select or switch printer trays during print-time.

For every single page of the output you can dynamically select a tray on the target printer. This is
useful for printing the first page of an invoice on a letterhead or for adding an envelope to a print-
out. You could also print a number of labels and add a cover sheet which is printed on non-sticky
paper. Such output with mixed types of paper can be done in one single print-job. The selection of
the trays is performed during print-time.

The tray selection works completely device-independent: TFORMer uses logical tray numbers (tray
1 to tray 10). Thus it is possible to select the trays without taking care for the actually used
hardware or printer driver. A tray is always selected by its logical number.

The mapping of the device-dependent printer trays to the logical tray numbers is done in the Tray
Mappings. These tray mappings have to be configured beforehand. Then, for each print-job, you
can select the appropriate mapping.

Example:

Assume you are printing one layout on two different printer models (Printer A and Printer B):

Name Tray Mappings for Name Tray Mappings for
Printer A Printer B

Tray 1 Automatically Select - Tray 1 Auto

Tray 2 Upper Paper Tray -— Tray 2 Tray 1

Tray 3 Manual Paper Feed -— Tray 3 Tray 1 (Manual)

Tray 4 Envelope, Manual Feed - Tray 4 Envelope Feeder

Tray 10 A4 B E—— Tray 10 A4

The first page of the layout should be printed using the manual paper feed which is named diffe-
rently on both printers (due to different printer drivers). Using the tray mappings as shown above,
the tray number 3 can be assigned in both cases. When printing, take care to select the appropriate
tray mapping for the actual output device.
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The following steps are necessary for tray control:

= Create and configure the required tray mappings.
= Perform the tray selection in the band properties.
= Select the correct tray mapping for printing.

Please note:
» The “ Default_” tray mapping is always available.

» You can define as many tray mappings as required (this is useful when printing one layout
on different printers).

» When using paper sizes (e.g., A4 or Letter) in the tray mappings (instead of tray names), be
careful to configure your printer drivers correctly. Otherwise the mapping between the paper
format names and the printer trays will not work.

12.6.1 Create a New Tray Mapping

Repasitary/Design To create a new tray mapping, right-click on the
B [§| TFORMer2 ] folder “Tray Mappings”in the design tree and select
1Ly Data Sources New Tray Mapping from the pop-up menu (see ©).
* A new entry “New_Tray_Mapping_0” will be
ol = T _ created.
' Cut Umschalt+Entf
* Ban :
Alkeis oS To rename the tray mapping select it in the design
& Paste strg=V tree and thereafter press F2 (or click again on the
P item with the left mouse button). Now you can

directly edit the name. Alternatively use the

New Tray Mappingo% properties window to rename a tray mapping.

Propertias

12.6.2 Configure Tray Mappings

Each tray mapping has ten logical trays which can be filled with device specific physical trays. The
trays are assigned as follows:

Properties Enter the name of the logical tray directly in ® or
| & select it from the list provided by the printer driver.
Click on the .. button to open the dialog below.

=2 Common -

Marne Mew_Tray_Mapping_0
B Trays
Tray1 Automatically Select
Tray 2 A3 3
Tray 3 Letter @)

WWW.TEC-IT.COM Page 81 of 152




 Select Printer Tray [E) First select the target printer in ®. Then select one

_ _ of the listed items: You can choose a “Tray Name”
Printer:  Microsoft XPS Document Writer el (2o ( 9) or a "Form Name” ( 9)

Available trays [ forms for the selected printer: ’
B Tray Names

iy Automatically Select e

Form Names

= ﬁfﬂjma" Click OK to assign the selection.

o 5] Ledger 9
w2 Legal
i =) Statemert
o= Executive

In order to refresh the tray list for manually entered
printer names, use the button .

] v

l Ok J l Cancel

12.6.3 Tray Selection in the Layout

First select the band which should perform the tray change. Then go to the properties window and
choose the required tray number (1 to 10) in the Tray property:

E Advanced By default “Tray 0 - (Default)” is pre-selected for
Tray 0 - (Default) " each band. This means, the settings of the current
Type Detail printer driver are used for printing.

» The first band that is printed on a page (e.g., the page header) does the tray selection. Tray
settings of subsequent bands which are printed on the same page are ignored.

» Tray 0 (default) uses the settings of the current printer driver.
» Tray 1 to 10 can be pre-configured in the tray mappings.

If you want to print the first page of a report on a letterhead, assign the required tray to the report
header. After the first page you have to switch back to normal paper. Therefore enter the number
for the default tray in the page header.

12.6.4 Select the Tray Mappings for Printing

If your layout contains any sort of tray selection, please make sure to choose the appropriate tray
mapping for the target printer.
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Pages
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Copies:

Collate.
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[ simulate Copies

A

Data Source: [Edit manually {default) - ]

[Filter: (]
Save zerial values after printing

Tray Mapping: [_De'hult_ @ v] Start Row: 0

SDK Options: Start Column: 0=
Open output file automatically [ Print ] ’ Cancel

- Settings ...
|[ setings |

Figure 62: Select Tray Mappings in the Print Dialog

On the print dialog choose Advanced Settings @®. Then select one of the pre-configured tray

mappings in ®. For more information on the print dialog, please refer to chapter 15.
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13 Providing Data

13.1 Introduction

As mentioned in chapter 5 TFORMer requires data in addition to the layout for printing. The follow-
ing data source types are supported:

Manual Data Source

This is the default data source. It allows you to edit every single data value manually
(see section 13.3.1).

ODBC Data Source

The data will be imported from an ODBC connection (see section 13.3.3).

Flat Text File

The data will be imported from a text file (CSV, TSV,...) (see section 13.3.4).

XML File

The data will be imported from a XML file (see section 13.3.5).

TFORMer SDK API

This data source is not selectable in the user interface. The data will be provided program-
matically from outside TFORMer Designer. This method can be used by software deve-
lopers. For details see section 15.3.

For each layout you can create multiple data sources and switch between them as required.
So you have the possibility to print one single layout with data from different data sources
without modifying the layout.

13.2 The Data View

For managing data sources TFORMer offers a separate view, the data view. In the data view you
can...

inspect the data which is provided by the currently selected data source,
create, edit, rename and delete data sources,

switch between different data sources,

reload a data source,

set parameters for a data source,

bind source fields (the fields provided by a data source) to data fields (the placeholders,
which are used in the layout),

and apply a filter to the current data source.

To switch to the data view click on the Data tab in the ribbon menu (see ® below) or use one of the
other methods as described in section 4.4. You can also use the keyboard shortcut Ctr/+D.
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Layout Page Datao Preview @'

(™~ N Edit | |Edit manually (defautt) (1)~ | &8 T A
( A 4 ] 2] |5
|—4‘ b ke 4 Clear f Settings _I
Preview Refresh Auto  Apply Mew Mew Edit
- Filter ,§ Parameters -
View Filter Data Source Data Fields
Start Page  Data.tff = w | Repository/Design
# Copies |Artic| eName| ArticIeNo| ArticlePrice| * E‘"' IEJLata.tﬁ' [RATECATVTFORMer'trunkc\ Distribution* Docy
- ; T £+l Data Sources
1 Chair 558963 110 <New Data Fi.. [ u Edit lly (default) @
2 1 Desk 778920 150 <New Data Fi Data Fields
3 1 Maonitor 775116 (236 <New Data Fi ") Computed
4 1 Panel 544593 40 <New Data Fi IC5) Serials
5 1 Coffee Ma... 549896 30 <New Data Fi AdticleName
6 1 Printer 458862 100 e«. New Data Fi AticleNo
7 1 Fax 445866 115 <New Data Fi [ AiclePrice
8 1 Phone 458032 |50 <New Data Fi -8 Tray Mappings
- <New Data Fi E-5g Layes
s e [#-|_] Bands
] 1 3

= Common -
Data Source Edit manually (default) D

Advanced

Watermark i

Advanced

Advanced options
[~ Hide unused data fields

Record: |48 4@ 1 = = vons e
Figure 63: Data View

The data view is divided into the following areas:

© Ribbon Menu » Data
® Data Grid
© Record Navigation

Via the ribbon menu © you can edit the active data source, switch to a different data source, or
create a new data source (see also command descriptions in 13.2.1). To set a different data source
you would, for example, use the drop-down list in ©. By default, the manual data source is selected.
This data source is used for directly editing the print data within TFORMer.

The design tree @ gives you an overview over the available data sources. The active data source is
displayed in bold. A right-click on the data source will open a context menu with the most important
commands.

The data grid ® shows the data which is provided by the active data source. The grid is divided into
rows and columns. The rows represent the data records, the columns represent the data fields
(ArticleName, ArticleNo etc...).

The first column in the data grid is the column “Copies” . This column is always available. It defines
how often each single record is printed.

The data field columns are ordered alphabetically by default. Using the data field property “Display
Order” (see section A.5) a custom display order can be specified.

The record navigation ® allows you to navigate to the next, previous, first or last record, or to a spe-
cific data record directly.

» TFORMer Designer always uses the active data source for printing.

> TFORMer Designer only prints the records which are shown in the data grid. This is usually
the content of the active data source, but the number of records may be reduced by a filter
(see section 13.6).
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» Sorting the records in the data grid is not supported. If the printing order has to be changed,
please re-arrange the records manually or adjust the appropriate data source definition (e.g.,
by inserting an ORDER BY instruction in the SQL statement).

13.2.1 Menu Commands

The following table gives you an overview over the available menu commands:

13.2.1.1 View
= Layout Switches to the respective view (see also section 4.4.2).
hl Data Shortcuts: Ctri+L, Ctrl+D and Ctrl+Space
Preview
(;:a Refresh Reloads the data from the data source.
L Shortcut: F5
13.2.1.2 Filter
Auto Filter Creates a new filter which is based on the current selection in the data grid (see also
section 13.6.1.2).
Place the cursor inside the row and on the value for which you want to filter. Alternatively
you can also select a specific record by clicking on the line number on the left side. Then
click Auto Filter.
Please note that multiple selection is possible (hold down the Shift or the Ctrl key). You
can also filter several times in order to refine the result.
Apply Enables or disables the filter (see also section 13.6.2).
,}} Edit Edits the filter expression (see also section 13.6.1.1).
,i Clear Removes the existing filter.
13.2.1.3 Data Source

Edit manually (default] -

Selects an existing data source or creates a new one (see also sections 13.3.2.6 and
13.3.2.1).

lglﬁ’ Settings Edits the current data source (see also section 13.3.2.3).
| 55 Parameters Edits the data source parameters (see also section 13.5.2.3).
@ New Creates a new data source (see also section 13.3.2.1).
13.2.1.4 Data Fields
:;] New Inserts a new data field (see also section 10.2.1.1).
o |
Edit Edits the selected data field (see also section 10.3).

13.3 Data Sources

13.3.1 Manual Data Source (Default)

For each layout TFORMer provides a manual data source (see @). This data source is always
available. It allows you to enter the required data directly into the data grid.
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Layout Page Data Preview

“‘l @ i Edit Edi.t manually (default) @) - (] ﬂ
Lo G 4 Clear # Settings
Preview Refresh Auto  Apply ] New Mew Edit
= Filter % Parameters =
View Filter Data Source Data Fields
Start Page Datatff x
S Copies (5) |ArticleName|Artic|eN0|ArticlePrice * |
1 1 Chair 558963 110 <New Datg FL.
2 1 Desk 778920 150 <New DEQFL.
3 1 Monitor 775116 236 <New Data FL.
4 1 Panel 544593 40 <New Data FL.
5 1 Coffee Ma... 549896 30 <New Data FL.
6 1 Printer 458862 100 <New Data FL.
7 1 Fax 445866 115 <New Data FL.
8 1 Phone 458932 50 <New Data FL.
* Q _ Dummy 9 <New Data Fi.

Figure 64: Edit Data Manually

To insert a new record place the cursor in the last data row ® (which is marked with a ” *“), enter
the required data and confirm with enter. If a default value was assigned to a data field, this default
value is displayed as gray text (see ). It will be used, if no other value is entered.

To change an existing value in the data grid, select the required cell with the mouse and press F2
(or double-click on the cell). This allows you to place the cursor at the required position inside the
cell and to edit the content.

A new line within a cell is inserted by pressing Ctri+Enter. Please note that this line break is not
visualized in the data grid view. Though, it will be inserted on the print-out.

To select a row click on the record number in the first column “#”. It is possible to select more than
one row by holding down the Shift or the Ctrl key. The selection can be deleted (press the Del key)
or it can be copied and pasted into any of the other rows (Ctr/+C and Ctri+V).

» Only the manual data source allows you to edit the data within TFORMer Designer directly.
For all other data sources (ODBC, flat text files and XML) the data grid is read-only.

» Read-only cells are marked with gray background color.

» Inserting new records is only possible in the last row ®. You cannot perform an insert opera-
tion between two existing rows.

If required, you can create a new data field by clicking on the command Data Fields | New @ in the
ribbon menu or by clicking inside the column <New Data Field...> ®.

= For the manual data source the content of the new data field can be edited immediately.

= When using an external data source (e.g., ODBC) you need to provide the content for the
new data field via source field binding (see section 13.4).

To edit an existing data field click inside the respective row and then use the command Data Fields
| Edit in the ribbon menu. Alternatively you can also double-click on the respective column header.

> The field “Copies” ® is not an actual data field. It is used to determine how often a single
record is printed.

13.3.2 External Data Sources

In addition to the manual data source you can specify one or more of the following external data
sources:
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= ODBC Data Source — see section 13.3.3
= Flat Text File (CSV, TSV, ...) — see section 13.3.4
= XML File — see section 13.3.5

For managing these data sources use the operations described below:

13.3.2.1 Create a New Data Source

To create a new data source select the command Data Source | New @ from the menu. Alterna-
tively you can also select <Create New Data Source...> from the drop-down list in @, or you right-
click on the tree item “Data Sources®and select New Data Source... from the pop-up menu ©.

Layout Page Data Preview |

‘*l N i/ Edit | |Edit manually (defauit) @) ~ | &P ;‘.;:Jl A
L5 . 3 s Clear 4 settings o e
Preview Refresh Auto  Apply Mew Mew Edit
- Filter 15 Parameters -
View Filter Data Source Data Fields
Start Page ~ Datatff X v  RepositonyDesian
# Copies |Articlehlame|ArticleNo|ArticIEPrice * | | [ Dataiff [RATECAT\TFORMertrunk\Distribution’
1 1 | Chair 558063 110 gl ——
2 1 Desk 778920 150 RN
4 1 Panel 544583 |40 Paste Strg=V
5 1 | Coffee Ma... 549896 30
6 1 | Printer 458862 100 7 | Delete
7 1 |Fax 445866 115 &
& 1 Phone 458032 |50 blew:Bata Sourcesr @)
a3 Dummy Edit Data Source..,

Figure 65: Create New Data Source

The dialog “New Data Source” will appear:

l' ™\
% New Data Source - Choose one of the data source types in @.
Specify a name (©) and an optional
ﬂi} Spedify the name and the type of the new data source. description (®) for the data source. Then
ES gaa:lsources are used to print layouts with dynamic confirm with OK.

h i
i idnd A dialog for setting up the respective data

Flat TextFie (CSV, TSV, ..) @ source will appear. Setting up the different
XML File types of data sources is described in
sections 13.3.3 to 13.3.5. Additional
adjustments (which apply to all of these data
sources) are discussed subsequently in
sections 13.4 to 13.6.

Mame:
Mew_Datasource @

Description:

6 Once the data source is inserted and set up
you will find an appropriate entry in the
design tree.

Lok J[ cancal | A newly created data source is set as the
. J active data source automatically.

Figure 66: Dialog “New Data Source”

13.3.2.2 Loading Data and Progress Bar

For all external data sources TFORMer caches the data locally in order to provide a stable set of
data for printing (you see the cached data in the data view). This means the data source is read
completely, before a print-job or the rendering of the print preview is started.
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Whenever a new data source is created or when switching to an existing data source (see sections
13.3.2.1 and 13.3.2.6) the data from this source is read automatically. However, it is also possible to
manually force a reload on the data source (see section 13.3.2.7).

For large amounts of data, sometimes the loading may take several minutes. While loading the
records TFORMer displays a progress bar:

e ™

i

Please wait... This bar shows the progress of the loading operation.

e it SRR AR axer) By clicking Cancel you have the possibility to cancel

the operation:
T

Cancel

. =y

(TeCT TFORMer =5 Yes aborts loading immediately. All data read so far
is kept in the data cache. This results in an incomp-
e 5 - . lete data cache. An appropriate notification text will
| | Do you want to continue with incomplete data? . .

- be displayed at the bottom of the data view or
preview (see © below).

-
m
n
=
(=]

Cancel |

No aborts loading immediately. All data read so far is
discarded. This results in an empty data cache. An
appropriate notification text will be displayed at the
bottom of the data view or preview (see ® below).

Cancel continues loading.

'0" Loading of data was stopped. 0
¥ vou cancelled this operation. The data shown can be used but may be incomplate, Press FS 1o refresh data,

lﬁi Loading of data was stopped. )
¥ vou cancelled this operation. Mo data is available.

First make sure that the respective data source is set active (see also 13.3.2.6). Then select the
command Data Source | Edit from the menu. Alternatively you can also right-click on the data
source item in the design tree and select Edit Data Source... from the context menu, or just double-
click on the data source.

To rename a data source select it in the design tree and thereafter press F2 (or click again on the
data source with the left mouse button). Now you can directly edit the data source name. Alterna-
tively use the properties window to rename a data source.

To delete a data source select it in the design tree and then press the Del key. You can also right-
click the data source and select Delete from the context menu.

To switch to a specific data source use the menu command Data Source | [Editmanualy [defaul] - gnd
select the respective item from the drop-down list (see also Figure 63, @). Alternatively you can
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also right-click on the data source in the design tree and select Set as Active Data Source from the
context menu.

13.3.2.7 Reload a Data Source

You can refresh the cached data any time by selecting Data Source | Update from the menu or by
pressing the shortcut F5.
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13.3.3 ODBC Data Source

ODBC data sources are used to retrieve data from a database (Microsoft Access, SQL Server,
Oracle,...). Each database with a suitable ODBC driver is supported. On Microsoft Windows the
drivers for Microsoft Access and SQL Server are pre-installed. For more information on how to
install additional ODBC drivers please refer to the documentation of the database system in
question.

In the DSN tab specify the ODBC connection:
("Edit ODBC B

DSN |SQL-Quer\‘-I | Field Bindings | Preview|

CODBC Data Source

Specify or select the D3N (data source name) of your ODEC database. If required modify the DSN with expressions and source
parameters,

Data Source (DSM):

DSMN=TFORMer_Sample;| m

User:

admin 9 [I]

Password:
O [.]
o

[ Shaw Advanced Options CK ] [ Cancel ]

"

Figure 67: Data Source (DSN)

= Data Source (DSN) ©
Enter the connection string which identifies your required ODBC connection. You can select
from a list of available data sources as defined under Microsoft Windows (Control Panel »
Administrative Tools » Data Sources (ODBC)) by pressing the button = . Or you can enter
the string manually by pressing the button - .
=  Username @
Enter a username for the database connection by pressing the button
=  Password ©
Enter a password for the database connection by pressing the button
= Test Connection ©
Use this button to test the connection settings.

» For advanced users: With the help of expressions and source parameters you have the
possibility to build dynamic connection strings (e.g., use a variable data source (DSN), user
name and/or password). First open the expression builder for the respective field in @, @ or

® by clicking the button - !, then use the button Insert Source Parameter... or Insert Ex-
pression.... For details on expressions and source parameters see chapter 11 and section
13.5.2.
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13.3.3.2 SQL-Query

In the SQL-Query tab you specify the SELECT statement for fetching the data:

r 5
Edit ODEC (B
[psn_| sat-Query |Field Bindings | Preview
Spedfy the SQL SELECT-statement manually or generate it automatically by double-dicking a table name. For advanced applications use
source parameters and expressions to modify your SQL-guery (2.g. with dynamic WHERE parameters).
Available Tables: Generate SQL  SELECT Query: C' Inser@'
tbl_Example Select * from tbl Fickinglist WHERE
tbl_PickingList PickinglistNo = [(EeillSksman
- 9 0 ("Pickingli=stFara: 9
ArtideMNo PickingListMo CustomerNo Description Express ProductGroup Quantity UnitPrice
4511656 1 4711 Hitachi Ultra... HARD DISC 25 308 4
4562656 1 e 4711 Hitachi Ultra... HARD DISC 28 503,78
456A61G 1 4711 Fujitzu Alleg... HARD DISC 14 495,96
4564626 1 4711 Seagate Ch... HARD DISC 31 496,86 e
€ 1 |
[ show Advanced Options CK ] [ Cancel
\

Figure 68: SQL-Query

= Available Tables ©®
This window lists all available tables for the ODBC connection specified in the DSN tab.

= SELECT Query ®
The SQL query is used for data selection. This statement can be typed manually. Alterna-
tively you can also generate a “Select *” statement by double-clicking the table name in @
(or by selecting the table and clicking on the link Generate SQL).

=  Preview ©®
A preview of the selected data is displayed. To update the preview press the button €.

For advanced users: With the help of expressions and source parameters you have the
possibility to build a dynamic SQL SELECT statement. First place the cursor in ® on the
required text position, then use the Insert button ® to insert an expression or a source
parameter. For details on expressions and source parameters see chapter 11 and section
13.5.2.

13.3.3.3 Field Bindings

To complete the setup of the data source adjust the required field bindings (see section 13.4).
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13.3.4 Flat Text Files (CSV, TSV, ...)

Text file data sources are used to retrieve data from a file (CSV, TSV, ...).

In the File tab you specify the text file to be loaded:

- o
Edit New_Datascurce l S| S
File Field Bindings I Preview
Text data source (C5V/TSV)
Please select an existing file, If required, the file name can be adapted with expressions and source parameters, The field separator
character as well as the text qualifier can also be set.
File:
C:\Temp'Data. csv o D
Field separator: Text qualifier:
+ (Semicolon) 9 » {None} 9 - ﬂt line contains column names
ArtideName ArticleNo ArticlePrice
Chair 558963 110
Desk 778520 150
Maonitor 775116 235
Panel 544593 a0
Coffee Machine 54939 0
Printer 4588602 100
Fax 445866 115 9
Phone 458932 50
[ show Advanced Options OK | [ Cancel

" J

Figure 69: Text Data Source

= File ©
Enter the name of the file which you want to use as data source. You can select a file by
pressing the button = or you can enter the file path manually by clicking the button - .

= Field separator @
The field separator specifies the character used to separate the fields in the text file. Select a
predefined separator character from the list or enter a custom separator character.

= Text qualifier ®
The text qualifier specifies the character which is used to enclose data values in the file
(e.g., data values may be enclosed in quotes). This may sometimes be necessary to
differentiate field values from the separator character. Select a predefined text qualifier cha-
racter from the list or enter a custom character.

= First line contains column names ©
Specifies whether the first line in the text file contains the column names or not. If selected
TFORMer does not treat data in the first line as data values. Instead these names are used
as the names of the source fields.

= Preview ©
A preview of the data source values is displayed.

» For advanced users: With the help of expressions and source parameters you have the
possibility to build a dynamic file path and/or file name. First open the edit dialog for @ by

clicking the button |, then use the button Insert Source Parameter... or Insert Expres-
sion..... For details on expressions and source parameters see chapter 11 and section
13.5.2.

To complete the setup of the data source adjust the required field bindings (see section 13.4).
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13.3.5 XML File

XML file data sources are used to retrieve data from a well-formed XML file. In addition to the XML
file you can specify an optional transformation file (XSLT file). This file may be used to transform a
custom XML file into a structure accepted by TFORMer.

13.3.5.1 File
Edit New_Datascurce l (=) e
File Field Bindings I Preview
File data source (XML)
Please select an existing file. If required, the file name can be adapted with expressions and source parameters.
File:
i\Temp'Data. xml G D
Cptional transformation file (. xslt):
o]
Test Connection 9
[ show Advanced Options oK ] [ Cancel

Figure 70: XML Data Source

= File ©
Select the XML file which you want to use as data source. You can select a file by pressing

the button = or you can enter the file path manually by clicking the button - .

= Optional transformation file (.xslt) @
Select an optional transformation file which should be applied to the XML file. Select the
XSLT file via = or enter the file path manually by clicking the button .

= Test Connection ©

Use this button to check if the XML file exists and if the transformation was successful.

» For advanced users: With the help of expressions and source parameters you have the
possibility to build a dynamic file path and/or file name for the XML file and for the XSLT file.
First open the edit dialog for ® or ® by clicking the button - !, then use the button /nsert
Source Parameter... or Insert Expression..... For details on expressions and source

parameters see chapter 11 and section 13.5.2.

13.3.5.2 Field Bindings

To complete the setup of the data source adjust the required field bindings (see section 13.4).
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13.4 Field Bindings

Whenever you edit an external data source it is essential to specify the field bindings. In this step
you associate the required source fields of the external data source with data fields. Only data fields
can be used as placeholders within text boxes, barcodes, images etc. Source fields are not directly
available in the layout.

» All source fields that you want to use in the layout must be bound to data fields.

To edit the field bindings switch to the tab Field Bindings in the “Edit Data Source” dialog. There you
see all available source fields and their data field bindings. Directly after the creation of a new data
source by default no bindings are specified.

Edit New_Datasource | = £ |
i Field Bindings i r
F [Breview | Bindings for Source Field ArticlePrice [
Field Bindings Select the data fields, which you would like to
Assign the fields available in the data source (source fields) L. 1| bind to the source field.
Usually each data field is assigned to a source field. e
[ artideMame
Source fields Bound data fields [E] ArticeNo 9 m
ArticleMame ArticeName ArticlePrice
ArticeNo ArticeNo
ArtidePrice (1] <No data fields ass]
New Data
Field...
| MewDataField... || ok || cancel
Source field for number of copies: Escape sequences (\n, wA3, ||, ...)
[<N0ﬂe> o - Déranslabe Escape Sequences
|| Show Advanced Options OK l [ Cancel

L

Figure 71: Field Bindings Settings

= Source fields ©

This list shows all available source fields and their assigned data fields. One source field can

be associated with one or more data fields. In order to edit or delete the field bindings use

the buttons in ®:

- Auto...
This button is used to create field bindings automatically. It binds all source fields to
existing, equally named data fields. If no appropriate data field exists, TFORMer prompts
you, if you want to create a new data field with a suitable name.

- Edit...
This button opens the dialog ©. In this dialog select one or more data fields, which you
want to bind to the selected source field.

- Delete...
This button deletes the bindings for the selected source field. Alternatively press the Del
key on the keyboard.

- New Data Field...
This button creates a new data field. A newly created data field is automatically bound to
the currently selected source field.
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= Source field for number of copies @
The drop-down list @ specifies the source field which is used as “Copies” column. The field
“Copies” specifies how often a record is printed. If no source field is specified, TFORMer
prints each record once.

= Escape sequences ©
This option tells TFORMer whether escape sequences should be translated or not. An
escape sequence is an in-text placeholder for special characters. It always starts with a
backslash (“\") followed by a character or character code.
Example: The escape sequence “\n” is a placeholder for a newline character.

» Please note: If escape sequences are activated you must use the sequence “\\” in the data
source to encode a single backslash “\"!

13.5 Advanced Options

When enabling the checkbox Show Advanced Options at the bottom of the “Edit Data Source”
dialog the following additional tabs will be shown:

= Computed Fields (see section 13.5.1)
= Source Parameters (see section 13.5.2)

13.5.1 Computed Fields

A computed field adds an additional column to a data source. The content of this column is either
specified as a constant value or it is computed using an arbitrary expression. In the expression you
may refer to other source fields and computed fields as basis for calculation.

The usual purpose of a computed field is to compute values which are based on source fields or
other computed fields. For example, you might convert the content of an existing source field to
uppercase, or remove leading and trailing spaces. You can also concatenate multiple source fields
into a single source field. Or you can perform numerical computations (e.g., add the Value Added
Tax, VAT). For examples, see section 13.5.1.1.1.

In addition, computed fields support aggregation functions. Thus it is pretty simple to calculate run-
ning sums and averages which are not directly available as fields in the data source. However,
please note: If the aggregation value is not necessarily required as source field, you may also
calculate it via a computed data field in the layout (see section 10.3.2).
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-

Edit New_Datasource

File Computed Fields | Field Bindings | Source Parameters | Preview |
If required, add computed fields to your data source
Computed fields can be used like other source fields, The order of the computations is adjustable.
Mame Expression Aggregation
TotaPrice GetDSField("ArtidePrice™) Running Sum
Up
Show Advanced Options Ok ] [ Cancel

L

Figure 72: Computed Fields

Computed Fields ®
The list of computed fields is empty by default. Use the buttons in @ to create, edit and
delete computed fields:
- New...
Create a new computed field (see next section).
- Edit...
Edit the computed field which is selected in @.
- Delete
Delete the computed field which is selected in @
Computation Order ©®
TFORMer computes the fields from top to bottom (as listed in @). To change this computa-
tion order use the buttons in ®. Setting the correct computation order is essential if compu-
ted fields depend on each other.
- Up
Move the selected item up one position.
- Down
Move the selected item down one position.

>

>

After a computed field was created, it is treated exactly like every other source field. It has to
be bound to a data field before it can be used in the layout (see section 13.4).

Computed fields are not available in the manual data source.

13.5.1.1 Create a Computed Field

When clicking the New... button the following dialog will appear:
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[, Create a new Computed Field

Specify the name and the expression for a computed field.

ﬁ! The additional filter may be used to exdude records from the

computation.
Mame:
TotalPrice o
Comment:
Expression:
GetDSField("ArticlePrice") e [
Aggregation:
Runining Sum 6 v]
Aggregation Filter:

Lok

Cancel ]

Figure 73: New Computed Field

In @ specify the name for the computed
field. The name is used to identify the field.
It has to be unique within the data source.

In ® an optional comment can be entered.

The expression in ® provides the values for
the computed field. You can enter the
expression directly or you can open the
expression builder by pressing button - |.
For details see section 13.5.1.1.1.

The aggregation function @ allows you to
build running sums and running averages.
For details see section 13.5.1.1.2.

The filter expression © can be used to ex-
clude records from the computation. For
details see section 13.5.1.1.3.

The expression in ® specifies the content of the computed field. It may return a constant value
(e.g., to simulate a source field which is not available in the current data source), or it can perform

arbitrary computations.

The expression can be entered directly in ©, or you can open the expression builder by pressing
the button - |. For more information about the expression builder, please refer to section 11.2.

Common applications are:

= Modify a source field (convert it to uppercase, remove leading and trailing spaces, ...).
Example: Trim (GetDSField("ArticleName"))
= Concatenate multiple source fields into a single source field.
Example: "Group:" + GetDSField("ProductGroup") + "Desc: " + GetDSField("Description”)
= Perform computations based on a source field (like evaluating the Value Added Tax, VAT).
Example: GetDSField("UnitPrice") * 0.2
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[fe] Expression Builder

=

L]

= Source Fields Expression Description
g SEE;:F::Ethem GetDSField ("ArtideMo™) ArtideMo
=) System Data Fields GetDSField("CustomerMo™) CustomerlMo
=) Functions GetDSField("Description”) Description
) Operators GetDSField ("Express”) Express
=) Formats GetDSField ("PickingListho™) PickingListho
=) Common Expressions GetD5Field ("ProductGroup™) ProductGroup
GetDSField("Quantity™) Quantity
GetDSField ("UnitPrice™) UnitPrice
Plzase enter an expression manually. You can also add a predefined expression or data field by double-licking it. -

A static text must be spedfied between apostrophes - "StaticText".
Text values (or data fields) may be concatenated by using '+ E.g. “concatenated-" + “text”.

GetDSField("UnitPrice") * 0.4

Reguired type of expression: ANYTHING QK ] [ Cancel

j Insert Data

"

Figure 74: Example of an expression for a computed field

FieldName”).

» To access a source field from within an expression use the function GetDSField(“Source-

» Accessing data fields is not possible.

For more advanced applications (like computing totals for the whole report) TFORMer supports
aggregation functions. The following aggregation methods are available. You can choose from the
drop-down list @ (see Figure 73).

= None (default)
= Running Average

= Running Sum

No aggregation function is used.

TFORMer computes the mean value of all expression results up to the current record. For the
first record the running average is the value itself. For the n-th record the running average is
the average of the first n records.

Example:

If you want to provide the running average for the source field “ArticlePrice”, use the following
settings:

Expression: GetDSField(“ArticlePrice”)

Aggregation: Running Average

TFORMer computes the sum of all expression results up to the current record. For the first
record the running sum is the value itself. For all subsequent records the values are added.

Example:

If you want to provide a serial number which is incremented by “1” for each record, use the
following settings:

Expression: 1

Aggregation: Running Sum

When using a filter in field ©, single values will only be considered if the expression returns true.
Thus you can define, which values are considered for the aggregation, and which not.

Example:

| GetDSField("ArticlePrice") > 100
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This filter instructs TFORMer to consider only records where the “ArticlePrice” is greater than 100.

13.5.2 Source Parameters

Source parameters provide the possibility to implement dynamic data source definitions. Thus you
do not have to change the data source definition each time for fetching different data. Source pa-
rameters can be used to parameterize ODBC data sources and file-based data sources. Besides,
they can be used in computed fields.

A typical example for the use of source parameters is the parameterization of the SQL SELECT
statement for an ODBC data source. Thus the user (or developer) has the possibility to instruct
TFORMer to fetch only specific records or to change the sorting order per parameter.

Using source parameters requires the following steps:

=  Create the source parameter (see section 13.5.2.1)
= Assign the source parameter (see section 13.5.2.2)
=  Set a value for the source parameter (see section 13.5.2.3)

In the following sections we demonstrate the use of source parameters by means of the picking list
example as included in the TFORMer setup. Please note: This sample already includes all the
adjustments as described below! To open the sample select File » New... from the menu. Then
open the folder “(6) Samples” and select “Picking List”.

To create a new source parameter first make sure that the required data source is set active (see
also 13.3.2.6). Then select the command Data Source | Parameter from the menu. Alternatively you
can also right-click on the data source item in the design tree and select New Source Parameter...
from the context menu.

The following dialog will appear:

%4 New Source Parameter [ihj In @ enter the name for the source para-
meter.

el ] Spedfy the name and the default value of the source parameter.

- Parameters are used to create dynamic data sources (e.g. for
SQL-WHERE instructions in ODEC data sources or dynamic file names
in text data sources).

The default value @ is used to initialize
the source parameter after the layout was

: loaded.

Mame:

PickingListParameter o

Default Value: In ® you may enter an optional descrip-
X (2] tion.

Description:

;)

[ Ok J [ Cancel

= 4

Figure 75: New Source Parameter

After creation of the source parameter it can be used

= as placeholder in an ODBC data source (in the DSN, username, password and SQL
SELECT statement),

= as placeholder in a file-based data source (in the file name and file path),
= in computed fields.

WWW.TEC-IT.COM Page 100 of 152




In this example we use the source parameter to parameterize the SELECT Query in an ODBC data
source. Assuming the ODBC data source is already created (see also sections 13.3.2 and 13.3.3),
open the “Edit Data Source” dialog (e.g., by setting the data source active and selecting Data
Source | Settings from the menu) and switch to the SQL-Query tab.

- 1
Edit ODBC [
- SQL-Query | Field Bindings | Preview

Spedfy the SQL SELECT-statement manually or generate it automatically by double-dicking a table name. For advanced applications use

source parameters and expressions to modify your SQL-guery (e.g. with dynamic WHERE parameters).

Available Tables: Generate SQL  SELECT Query: C' Insen.e'
thl_Example Select * from tbl Pickingli=t WHERE
tbl_PickingList PickinglistNo - ¢ 21

- ¢ {"Pickingli=ztFar o
ArtideNo PickingListMo Customerho Description Express ProductGroup Quantity UnitPrice =
4511656 1 4711 Hitachi Ultra. .. HARD DISC 25 308 I—l
4562656 1 4711 Hitachi Ultra. .. HARD DISC 28 503,78
4564616 1 4711 Fujitsu Alleg. .. HARD DISC 14 493,96
4564626 1 4711 Seagate Ch... HARD DISC 31 496,86 S
4| 1 | 3
[] show Advanced Options OK ] [ Cancel

" s

Figure 76: SQL-Query tab

To insert a source parameter in the SQL query place the cursor on the required position in ® and
then click on @ Insert » Source Parameter.... The following dialog will appear:

Select Source Parameter @
=
Expression Description
<Mew Source Parameter > <Mew Source Parameter >
GetD5Param{ PickinglListParameter”) PickingListParameter
0K ] [ Cancel

Figure 77: Select a Source Parameter
Select the required source parameter and confirm with OK.

In this example the source parameter “PickingListParameter” will be used in the WHERE clause of
the SQL query to retrieve the data for a specific picking list only. When TFORMer is fetching data
from the data source the expression [GetDSParam(“PickingListParameter”)] is substituted with the
actual value of the source parameter. Thus, the resulting SQL SELECT fetches only records from
the database which matches the specified picking list number.

E.g., if the “PickingListParameter” is set to 1, the SQL Query

| SELECT * FROM tbl PickingList WHERE PickingListNo = [GetDSParam("PickingListParameter")]

will internally be evaluated as:
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| SELECT * FROM tbl PickingList WHERE PickingListNo = 1

13.5.2.3 Set a Value for the Source Parameter

For the correct parameterization of the data source the according source parameter values have to
be set:

First make sure that the respective data source is set active (see also 13.3.2.6). Then select Data
Source » Parameters from the menu. Alternatively you can also right-click on the data source in
the design tree and select Edit Source Parameter... from the pop-up menu. The following dialog will
appear:

P ™y
Edit ODBC (B

| D5N | S0L-Query I Computed Fields I Field Bindings | Source Parameters |Preview|

If required create or adjust source parameters,
These parameters are used for dynamic data sources (e.q. parameters for SQL-WHERE instructions or file names in text data sources).

Mame Value Mew...
PickingListP'arameter il o Edit...

[#] Show Advanced Options OK ] [ Cancel J
N oy

Figure 78: Edit a Source Parameter Value

Enter the required value for the source-parameter in @. Then confirm with OK.

Using the settings as shown above, TFORMer will only fetch records where the PickingListNo is
equal to 7"

# Copies PickingListNo | ArticleNo CustomerMo Description

2 1 1 4562655 4711 Hitachi Ultrast...
3 1 1 456A61G 4711 Fujitsu Allegro...
4 1 1 4564625 4711 Seagate Cheet...
5 1 1 456A65Y 4711 Seagate Cheet...
] 1 1 &7009800 4711 Pentium 4 (Pr...
7 1 1 87009803 4711 Pentium Extre...

Figure 79: Data for PickingListNo = 1

Changing the source-parameter to 2’ results in different data:

# Copies PickingListNo | ArticleNo CustomerMo Description
4563655 Hitachi Ultrast...
2 1 2 456464 G 4711 Fuijitsu Allegro...
3 1 2 4564656 4711 Seagate Cheet...
4 1 2 4564655 4711 Fujitsu Allegro...
5 1 2 4564665 4711 Fujitsu Allegro...
] 1 2 &7009801 4711 Pentiurm 4 Extr...
7 1 2 87009806 4711 Pentium D (Pr...

Figure 80: Data for PickingListNo = 2
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» Source parameters can also be used by software developers via the APl or with the com-
mand line utility TFPrint. Please refer to the appropriate documentation for details.

13.6 Filter

The filter is used to limit the records in the active data source. You can:

= Create afilter — see section 13.6.1

= Apply a filter — see section 13.6.2

= Clear the Filter — see section 13.6.3
=  Print with a filter — see section 13.6.4

Layout Page Data Preview

._1 @ i Edit | (ODBC ~| gg El M
. ¢ Clear lJ Settings -
Preview Refresh Autol/\\? Apply Mew MNew Edit
- Filter 15 Parameters -
View Filter o Data Source Data Fields
Start Page- Picking List X hd
# Copies |ArticIeN0 | CustomerhMo | Description | Express Flag_InGroup | PickingListMo | ProductGroup | Quantity
1 1 4511656 4711 Hitachi Ultrast... <not bound> |1 HARD DISC 25
2 1 4562655 4711 Hitachi Ultrast... <not bound> |1 HARD DISC 28
3 1 4564616 4711 Fuijitsu Allegro... <not bound> |1 HARD DISC 14
4 1 456A62G 4711 Seagate Cheet... <not bound> |1 (2] Eil
5 1 456AB5Y 4711 Seagate Cheet... <not bound> |1 HARD DISC 2
6 1 87009800 4711 Pentium 4 (Pr... <not bound> |1 CPU 78
7 1 87009803 4711 Pentium Extre... <not bound> |1 CPU 2
8 1 87009804 4711 Pentium Extre... <not bound> |1 CPU 2
9 1 87009805 4711 Pentium 4 (Ce... <not bound> |1 CPU 8
10 1 87009812 4711 Core 2 Duo (C... <not bound> |1 CPU 200
11 1 87009815 4711 Core 2 Extrem... <not bound> |1 CPU 2
12 1 R47683) 4711 Kingston Valu... <not bound> |1 RAM DDR2-800 16
13 1 R47683M 4711 Kingston Valu... <not bound> |1 RAM DDR2-800 11
Figure 81: Filter
The ribbon menu (see 0) offers the following filter commands:
Auto Filter Creates a new filter which is based on the current selection in the data grid.

Place the cursor inside the row and on the value for which you want to filter. Alternatively
you can also select a specific record by clicking on the line number on the left side. Then
click Auto Filter.

Please note that multiple selection is possible as well (hold down the Shift or the Ctrl key).
You can also filter several times in order to refine the result.

Apply Enables or disables the filter.
% Edit Edits the filter expression.
,i Clear Removes the existing filter.

13.6.1 Create a Filter
You can create a filter in two different ways:

= Manually edit the filter expression — see 13.6.1.1
= Automatically create the filter expression based on the current selection — see 13.6.1.2

To create (or edit) a filter manually select Filter » Edit from the menu or right-click somewhere in
the data grid and select Filter » Edit...from the pop-up menu.
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The following dialog will appear:

r ™
] Edit Filter [ B )
=
= Data Fields Expression Description o
i) Constants
3 System Data Fields Chr {«MNumber:) Character
3 Functions Clng («Expr=) Convert ta Lon.g {Integer) B
3 Operatars CStr («Exprs) Convert to String -
) Fomats Day («Dates) Day
L) Common Expressions DayOfiWeek («Datex) Day of Week
DayOffear («Dates) Day of Year
Exp («Mumber=) Exp
Exp10 («Mumber:) Exp10
Find («Texts, «SearchTexts, «nStart+) Find -
Please enter an expression manually, You can also add a predefined expression or data field by double-didkdng it. -

A static text must be specified between apostrophes - "StaticText”.
Text values (or data fields) may be concatenated by using '+. E.g. "concatenated-" + "text”.

h g Insert Data
CLng (ArticlePrice) = 100
Required type of expression; BOOLEAN QK ] [ Cancel

“ P

Figure 82: Edit a Filter

Enter the required expression in ©. Then confirm with OK. The filter will be applied to the current
data source. An active filter can be identified by the activated command Filter | Apply in the menu.

The filter criterion is specified with a Boolean expression (see also chapter 11): Only records for
which the filter expression returns true remain visible in the data view. All other records are masked
out. Masked out records are neither used for the preview nor for printing.

Example:
When using the filter expression below, only records with an ArticlePrice greater than 100 will be
printed.

| CLng (ArticlePrice) > 100

In order to automatically generate the filter expression, first select the required field values and/or
records (use the Shift respectively Cirl key for multiple selection), then click Auto Filter.

Example:
If you want to filter for ProductGroup="HARD DISC”, first select the cell with the respective value
(see Figure 81, ®), then click Auto Filter.

Please note: If you want to refine the filter result you can also call the auto filter command succes-
sively for several times.

13.6.2 Apply a Filter
To apply or to cancel a previously defined filter select Filter | Apply from the menu.

13.6.3 Clear the Filter

To clear the current filter expression select Filter | Clear from the menu.
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13.6.4 Print with a Filter

To start the printing process press Ctrl+P or select File » Print from the menu. Alternatively you
can also click on the Print command in the quick access toolbar (or in the ribbon menu if you have
the preview open). The dialog below will appear.

Prirt e On the printing dialog select the target
i | printer, the data source, etc.
Outputor | g Sonter =||_ Optens.,,
Peivter: o] T — o[ Setings.. If you have already adjusted the filter in
P . the data view or in the print preview, no
_— Copes 1 : additional adjustments are required.

from S : 3 Colate However, you have the possibility to
5o i = enable/disable (®) or to

taanoad Sangs . n edit (@)
Dasa Soarce: Edit marnaaly (defell) = . . .

Do R T ok the current filter expression in @.
Ty bopping: | Betaie, =| Starthow 0 To edit the filter expression click on the
SEK Opores: Mleckcabint; 4 5 button - |. The expression builder (see

e section 11.2) will open.
Figure 83: Print with a Filter Confirm with Print to start printing.

For general information on printing, please refer to chapter 15.
Example:

The following output is based on the picking list example (File » New... » (6) Samples » Picking
List). To print only items in the product group “HARD DISC” we use the following filter expression:

| ProductGroup = "HARD DISC"

TFORMer will only print records where the content of the field ProductGroup is equal to the string
“HARD DISC”:

Customer 4711 Picking List

Picking List Number: 1
Article Group: HARD DISC

Article-No | Description Quantity Unit Price Barcode
4511650 l(-ﬂtj%qisl{lﬁqaf\tfeln_rs135&<u1)4? 147G SAS 25 308,00 (T T
GFERE | et e 28 50378 | NI
A56AB1G | hutel hlents 101X, 30008 SAS 14 49596 | | [INNEAIN
TREReED | DR 31 aoes NN
456AG5Y | SeRGAle Cheslan 15K 4 T4TGE SAS 32 262,06 | |INNINAN
Group Total 130 53402.50

Figure 84: Picking List, filtered for ProductGroup = "HARD DISC”
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14 Preview

14.1 Introduction

TFORMer offers a preview which instantly renders the output based on the current layout and the
active data source. This view offers functions for printing, for page navigation, and more.

m Layout Page Data Pre\riewo '-.@' h

%f @ < "*, ﬂ-{ ;—i ) one Page Next Page
2 s 1 1
= . — [2d Two Pages | [ Previous Page
Layout Print Refresh Setup Zoom Zoom .
- In out Show Label Boundaries
View Page Zoom Preview
Start Page Picking List X + | Repository/Design
« [B-[5 TFORMerl [
[E)-11§ Data Sources
Customer 4711 Picking List 1 Edit manually (default) @
|J opBC
Picking List Number: & Tray Mappings
= Layers
Article Group: HARD DIS C (continued) 3 Bands
Articletlo | Description Quantity Unit Price: Barcode
Seagak Cheetal 15K.5 3W0GE SAD
4E6A62G | mrmmemesy k] sor56 | N
4sB2E5G | fich LI R 121500 30065 SAs = soz7s | HNEEE
4563856 | Sht e 1ok T 14 262,57 | HINIEIN
FAIfE Y GIE Q0 105E, 257, 1 56 545 o
436454G cn;lsslzlmgcr?; § 8 2344 | [HIEE Properties
45BBE5Y | mrosaany v HOESAS 2 2905 | N N
4550555 | FallEL Ml 101X, 13560 543 14 1465 | N 2t
4GESESG | ook LU Bl 100 14768 Sas ] 29500 | N E Common -~
(HUS1 5301 0 LS 300) |
ASEADOG :I;L';lsgilggggn-mﬂ SAS 17 147,00 [T T Data Source Edit manually (default) |E |
4siiese | MU EETT T SRS x| sepo| NIEENN fdvanced M
Growp Total 309 9937992 Watermark
Documentation -
Article Group: RAM DDR2-800
Articlello [D escrintion [ Ouantity Unit Price Barcode
RA7RAAN | GTEN VSR A DN SIN 6 PE3660E | " 1540 | EEEEEE 2
Page: [4@ 4@ Zﬁﬂofze

Figure 85: Preview

To switch to the preview click on the Preview tab in the ribbon (see @) or use one of the other
methods as described in section 4.4. You can also use the keyboard shortcut Cir/+Space.

14.2 Menu Functions

The commands in the ribbon menu ©® allow you to create a print-out, to reload the data from the
data source and to adjust the page setup. The preview itself can be zoomed, you can switch
between single page and double-page preview, you can turn pages and you can show/hide the
label boundaries (labels only).

If you switch the data source (e.g., by double-clicking on the respective item in the tree view — see

®) the result is displayed immediately. TFORMer will automatically reload the data in order to
ensure that the most actual data is used.

14.3 Page Navigation

The page navigation © allows you to navigate between pages or to directly jump to a user-defined
page.
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15 Printing

15.1 Introduction

The term printing in the context of this document incorporates generating output in general.

Besides direct printing (via a printer-driver in Microsoft Windows), TFORMer also supports the
creation of PDF documents, HTML files, PostScript files, images, ZPL-Il output (for ZEBRA printers)
and ASCII output.

All output formats are generated directly. There is no need for third party software. This might
particularly be interesting for PostScript or ZEBRA output (see below).
15.2 Printing Manually

To open the print dialog press Ctrl+P or select File » Print from the menu. Alternatively you can
also click on the print icon in the quick access toolbar. The following dialog will appear:

Print ﬁ
Device
Output to: Lé Printer ov] [ Options ... ]
Printer: [Q Micrasaft ¥PS Document Writer &] Settings ...
Pages Copies
oa © Copies: 1 (4 B
() From: o to: o Collate

[ sSimulate Copies

Advanced Settings

Data Source: [Edit manually (default) e v]

[T Filter: @ E]
Save serial values after printing 0

Tray Mapping: [_Default_ M Start Row: @ 0=

SDK Options: @ Start Column: 0=
Open output file gutomatically | Print | [ Cancel ]

Figure 86: Print Dialog (with Advanced Settings enabled)

In this dialog specify all output parameters as discussed below. When finished click Print to send
the job to the printer (or to create the output file).

15.2.1 Output Format and Device

o Output to Selects the output device respectively format:
= Printer (via a printer driver)
= PDF
= PostScript
= HTML
= Text (pure ASCII)
= BMP, GIF, JPG, PCX, PNG, TGA, TIF or multipage TIF
= ZEBRA (ZPL-II)

(2] Printer Depending on your selection in @ you can select one of the Windows printers and/or
the target file.
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TFORMer generates PostScript or ZEBRA output directly. This means that you can use such
printers without any proprietary printer driver — you have two options:

= Print via a generic ASCII printer driver
=  Print via a PostScript or ZEBRA driver

In both cases the print data is generated by TFORMer. The printer driver is only used to send the
data to the required device (comparable to pass through mode). No driver functionality is used.

15.2.2 Pages

(3] Pages

15.2.3 Copies

(4] Copies
Collate

Simulate Copies

15.2.4 Data
(5] Data Source
(6] Filter
(7} Save serial values after
printing

15.2.5 Additional Settings

(8] Tray Mapping
o SDK Options

© Start Row,
Start Column

Here you specify the range of output pages.
Examples:

= All (prints all pages)

= From: “1” to: “1” (prints the first page only).

Specifies the number of copies.

If enabled, always the complete range of pages will be printed at once (one complete
printout for each copy).

If disabled, all copies of the first page are printed, then all copies of the second page
are printed, and so on.

If enabled, the number of copies is not passed as printer command but each page is
repeatedly sent to the printer.

Choose this option if the printer driver does not support copies.

Select the data source to be used for printing.
Please note: Before printing TFORMer always reloads the data from the adjusted data
source. This guarantees that the actual data is used.

Here you can optionally apply a filter expression. If a filter is set, only the records for
which the filter expression returns true are printed. All other records are ignored. In
order to apply the filter the checkbox “Filter” must be activated.

Examples for filter expressions:

= Record <= 3
Prints the first three records only.

®* ProductGroup = "HARD DISC"
Prints only records, where the data field “ProductGroup” has the value “HARD
DISC".

For more detailed information on the filter see section 13.6.
If you are generating persistent serial numbers (see section 10.3.3, ®), TFORMer will

store the values from the current print-out and continue with the first unused number
when printing the next time (= check box is enabled).

If you disable the check box TFORMer will suspend saving the serial values for the
current print-out (e.g., for a test print).

Here you can select one of the predefined tray mappings (see also section 12.6). If
you want to print on the default printer tray, this selection is obsolete.

Here you can enter additional TFORMer SDK options (e.g., printing offset, ...). For
more detailed information, please contact TEC-IT.

For label printing the “Start Row” and the “Start Column® can be specified. Use this
setting if you want to leave the first labels on the sheet blank.

Example:

= Start Row=2

= Start Column=0
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— Columns Print order “Down,
then Across:. The
first two labels in
the left column will
be left empty.

Rows

Rows

Columns

Print order
“Across, then
Down’”: The first
two rows will be
left empty.

15.3 Printing Programmatically

Software developers can print layouts created with TFORMer Designer as part of their applications

using TFORMer SDK.

TFORMer SDK is available for Microsoft® Windows® and for almost all Linux® and UNIX® platforms.

The following kinds of integration are possible:

= Command line based printing application (TFPrint)

=  Software component (DLL, COM component, .NET component and shared library)

For details, please refer to the Developer Manual or to the API References of the TFORMer SDK.

WWW.TEC-IT.COM

Page 109 of 152



16 Repositories

16.1 Introduction
TFORMer offers two different possibilities for organizing layouts:

16.1.1 Stand-Alone Forms

» Stand-alone forms are the simplest way to create and to print layouts. Each stand-alone
form designed with TFORMer can be used on its own.

A stand-alone form contains all the necessary information which is required for printing. As long as
no repository is used, TFORMer always creates stand-alone forms when selecting File » New...
from the menu.

A stand-alone form is using the file extension *.tff. Organizing multiple stand-alone forms in the file
system is completely up to the user. In this context, please note that images are not embedded in
the .fff file but stored as file references.

16.1.2 Repositories

If you prefer to organize your layouts and data fields in a structured way or if you plan to create
multiple layouts which share the same data basis (same data fields) the use of a so-called
repository is recommended. A repository is a central database for layouts, data sources, data field
definitions and tray mappings.

Layouts and data field definitions are stored within a repository on a per “Project” base. A project
defines data sources and data fields and it contains layouts. Each of the data sources and data
fields defined in a project is accessible from every layout within the same project. Besides the user
defined projects there is also one special global project. Data sources and data fields which are
defined within the global project (global data sources and global data fields) may be used in all
layouts in all projects.

> A repository is used for organizing multiple layouts within a structured data base. A reposi-
tory holds tray mappings and is divided into projects. A project maintains data sources, data
field definitions and layouts.

A repository is stored with the file extension .tfr. All projects are stored in subdirectories. Please,
take care to maintain this directory structure. Do not change it manually!

16.2 Structure

In a repository you will find the following entries (see also Figure 87 below):

® Tray Mappings
These tray mappings are available for all layouts in all projects.
@ Global Data Sources
These data sources are available for all layouts in all projects.
® Global Data Fields
These data fields are available for all layouts in all projects.
® Projects
Each project contains a collection of layouts, data fields and data sources. Data sources and
data fields are valid in the respective project only.
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16.3 User Interface

Layout Page Data Preview Repository @ =
f I j "‘;'j Data Source I_:_!:, Open A Edit ' Jl
B Tray Mapping Li Export é Parameters !
Project Form Data ) : Edit
Field Ly Import
Insert Diacument Data Source | Data Field

Figure 87: Repository

Repository/Design
E||‘_‘§j Demos tfr [C:\ProgramData \ TEC-I T\TFORMer'7 ! «
=88 Tray Mappings B
Pohagy _Defauk_
11§ Global Data Sources
@[] Global Data Fields (1]
@B Projects
(-5 EmptyProject
-5 Industry Templates
(- TFORMer_Rurtime_Examples =

&[] Data Fields
=] Foms

BusinessCard_Fixed
BusinessCard_Mutti
MailingCoupon
MailingFlowerPower
ProductCatalogue -
4] o — r
Repository De=ign

The tree view window @ shows the repository structure. In order to edit the repository right click on
one of the tree items and a context menu will appear. This menu provides a list of all available
commands for the selected repository object. Also consider that the most important editing
commands are available via ribbon menu @, as well.

16.3.1 Menu Commands

16.3.1.1 Insert

Project

Inserts a new project into the repository.

] Form

Inserts a new layout into the repository.

ol Data Field

Inserts a new data field into the repository.
For more information on data fields see chapter 10.

"l}'l Data Source

Inserts a new data source into the repository.
For more information on data sources see section 13.3.

¥ | Tray Mapping

Inserts a new tray mapping into the repository.
For more information on tray mappings see section 12.6.

16.3.1.2 Document

Lé Open

Opens the layout which is selected in the tree view (inside the current repository).

Li Export

Exports the layout which is selected in the tree view into a new stand-alone form.
See section 16.4.5.

L& Import

Imports an existing stand-alone form into the repository.
See section 16.4.4.
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lJ Edit Edits the data source (analogous to section 13.3.2.3).

| 5 Parameters Edits the data source parameters (analogous to section 13.5.2.3).

Edit Edits the selected data field (see also section 10.3).

s

16.4 Basic Operations

16.4.1 Open an existing Repository

To open a repository select File » Repository | Open Repository... from the menu. Alternatively you
may also use the standard command File » Open.... TFORMer allows you to open both, .tff-files
(stand-alone forms) and .tfr-files (repositories).

In the file dialog select the repository and confirm with OK. Once opened, the repository is displayed
in the design tree and the ribbon menu shows an additional “Repository” tab — see figure above.

The TFORMer installation includes a demo repository. This repository is named “Demos.tfr” and
can be opened via the Windows Start Menu by selecting All Programs » TEC-IT TFORMer 7.5 »
Examples » Demo Repository.

16.4.2 Create a New Repository

To create a new repository select File » Repository | New Repository... from the menu. In the
appearing file dialog enter a suitable flename and click Save.

b AT The new repository will be displayed in the design tree.
- ) Furthermore an appropriate “Repository” tab will be

QJ gﬂaﬁﬂium displayed in the ribbon menu (see Figure 87).

[3) Global Data Fields
1 Projects

» Important: Each repository has to be stored in a separate folder! Otherwise it will lead to
problems. So, when creating a new repository, you should always create a folder first, then
save the repository there.

16.4.3 Save a Repository

Make sure that the repository view is activated by clicking the “Repository” tab in the ribbon menu
(or in the design tree window). If more than one repository is open select the desired repository in
the design tree. Then press Ctrl+S (or select File » Save from the menu).

16.4.4 Import a Stand-alone Layout into a Repository
You can import existing stand-alone layouts into the repository by following these steps:

In the design tree select the desired project. Then click Document | Import in the ribbon menu.
Alternatively you can also right-click on the project and select Import Form... from the pop-up menu.
The dialog below will appear:
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Ceate New Fams Il In @ select the file that you want

Tamgiate . to import.
Which tempianie shookd be used t meate e new fom?
Piease speily e fle whch Snould be weed 25 terrplate for the nes fom Then CliCk Next or FInISh
:P.ﬂ:ﬁ'.I.
£ Taregiiama, i1 0 = If you click Next, you can assign a

name and a description for the
layout in the repository.

By default the name of the
imported file will be used as layout
name.

e > | Firwghn a0 Hesm

16.4.5 Export a Layout from the Repository
Exporting a layout from a repository creates a stand-alone layout.

In the design tree locate the desired layout inside the respective project. Then click Document |
Export in the ribbon menu. Alternatively you can also right-click on the layout and select Export
Form... from the pop-up menu. The layout will be opened in the layout view.

Finally save the layout using the menu File » Save.

16.4.6 Close a Repository

Mark the repository in the design tree (the root item). Then right-click on it and select Close
Repository from the pop-up menu. Alternatively you can also use the menu File » Repository |
Close Repository.

16.5 Working with a Repository

16.5.1 Projects

Before you can add layouts and data field definitions, first you have to create a project: Make sure
that the ribbon menu shows the Repository tab. Then select the menu command Insert | Project.
Alternatively you can also right-click on the item “Projects” in the design tree and select New Project
in the pop-up window. A new project is inserted.

To rename the project select it and press the F2 key. Alternatively you can also use the properties
window to edit the name and the description for the project.

16.5.2 Insert a Layout

In order to insert a new layout use the command /nsert | Form in the ribbon menu or right-click on
the item “Forms” in the design tree and select New Form... from the pop-up menu. The following
wizard will appear:
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In this dialog you can select
whether you want to create a
stand-alone form (®), or if you
want to add a form to a reposi-
tory (®).

Select option ®.

If more than one repository is
opened choose the desired
repository in ©.

Click Next.
The following dialog will
appear:

Select the project in ©.

Then click Next.

In this dialog you select the
desired template (analogous to
section 6.2.2).

Use the button Next for addi-
tional adjustments or click
Finish to accept.

The selected layout template
will be added to the selected
project in the repository.
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17 General Settings

17.1 Options Dialog

In the options dialog you can customize common TFORMer settings. To open the dialog select
Files » Options | Options... from the menu or use the respective item in the drop-down menu in the

quick access toolbar.

p 1
Options ﬁ
General User Interface Settings
Language Measurement system:
PDF ’System (Default) -
HTML
PostScript [ Use automatic zoom for new views
Picture Edit content of elements after insertion
Zebra (ZPL) Show tooltips in design
Barcodes
Formatted Text Show Mini Toolbar on selection

Highlight on mouse over:

[ordr and Dt ;) T
Positioning Mode (CTRL +R):

[Snap Lines v]

Grid settings

Width: 5,00 mm Height: 5,00 mm

Grid visible (Ctrl+G)

Design Tree Settings
[ Locate in Design Tree

[ Show all open forms

0K ] [ Cancel Apply

"

Figure 88: Options Dialog

Please note:

> All settings which apply for the output generation (see sections 17.4 to 17.10) are stored in
the configuration file ,TFORMer.xml*.

» These settings are used for TFORMer Designer, TFORMer SDK and for TFPrint.
» For more information on the configuration file see section E.2.

17.2 General

17.2.1 User Interface Settings

Measurement system

The measurement system can be set to:

= System (Default)
Uses the measurement system that is specified in the regional options of your operating
system.

= Metric (mm)

= U.S.-System (inch)

Use automatic zoom
for new views (y/n)

If enabled, all files that are opened will be set to “Automatic” zoom level (= fit the width of the
layout window).
By default this option is disabled.

Edit content of
elements after
insertion (y/n)

If enabled, upon insertion of a new text, barcode or picture element the dialog for editing the
content will be opened automatically (see section 9.3).
By default this option is enabled.

Show tooltips in

If enabled, TFORMer will display tooltips when hovering the mouse cursor over design

WWW.TEC-IT.COM

Page 115 of 152




design (y/n)

Show Mini Toolbar on
selection (y/n)

Highlight on mouse
over

Positioning Mode

17.2.2 Grid Settings

Width
Height
Grid visible (y/n)

elements or bands. These tooltips show information about assigned data, comments and
printing conditions.
By default this option is enabled.

If enabled, TFORMer will display a mini toolbar with common format settings for selected
design elements.
By default this option is enabled.

Specifies the type of highlighting and the highlighting color for elements which have the
mouse focus in the design view. The following options are available:

= Border

= Border and Data (Default)

Specifies the positioning behavior which applies when inserting/moving/resizing elements.
The following modes are available:

= Fine Positioning

= Snap to Grid

= Snap Lines (Default)

Hint: If one of the two snapping modes (grid, lines) is enabled you may position elements off
the grid as well: Just press the Alt key during positioning.

Keyboard shortcut (switch modes): Ctrl+R

Horizontal resolution of the grid.
Vertical resolution of the grid.

Shows or hides the grid in the layout view.
Keyboard shortcut: Ctrl+G

17.2.3 Design Tree Settings

Locate in Design Tree
(y/n)

Show all open forms
(y/n)

17.3 Language

Language

17.4 PDF

17.4.1 Properties

Page Layout
Orientation
Color Mode

17.4.2 Fonts

Embed as ___ (y/n)

Simulate bold fonts if
not available (y/n)
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If enabled, TFORMer will automatically locate each element in the design tree which was
selected it in the layout view. By default, this option is disabled.

If enabled, the design tree shows the contents of all open documents. Otherwise it is popu-
lated with the contents of the current layout only. By default, this option is disabled.

The language to be used in menus and dialogs.

The page size (Letter, A4, ...) for PDF output.
The orientation (portrait or landscape) for PDF output.

The color mode for PDF output: “Color”, “Grayscale” or “Black & White”.

If this option is enabled, all used fonts will be embedded within the PDF file. This option
ensures, that the PDF document is always displayed correctly, even if the required fonts are
not installed on the system where the document is viewed. Embedding fronts increases the
size of the generated PDF document. By default this option is enabled. You can choose the
method for font-embedding:

= TrueType: The complete TrueType font is embedded in the PDF file.

= TrueType-Subgroups: Only the required parts of a TrueType font are embedded in the
PDF file (smallest output size).

= Type3: Fonts are embedded as type 3 fonts in the PDF file. Type 3 fonts should only be
used when printing the resulting PDF on high resolution devices.

If this option is enabled, TFORMer will simulate the bold font in the resulting PDF file if the
bold typeface is missing. By default this option is enabled.
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17.4.3 Image Resolution

Reduce to ___ (y/n) If enabled, all images of which the resolution is larger than the specified value will be re-
sampled. Smaller images are stored in their original resolution.

If disabled, all images are embedded in their original size.

17.4.4 Image Compression

Method The compression method that is used for storing images in the PDF output:
= Auto
(All images which are provided as JPEG are embedded as JPEG. All other images
(.bmp, .tif, ...) are stored as Zip compressed bitmap data.)

= Zip
(All images are stored as Zip compressed bitmap data.)
= Jpeg
(All images are stored as JPEG images using the specified compression quality.)
Quality The compression factor for JPEG images.
17.5 HTML
Page Layout The page size (Letter, A4, ...) for HTML output.
Orientation The orientation (portrait or landscape) for HTML output.
Output Resolution The output resolution (in dpi) for rendering HTML pages.
The pre-set value is the screen resolution 96 dpi.
Optimal Barcode If enabled, the module width of barcodes will be optimized for the (rather small) output reso-
Resolution (y/n) lution of HTML pages. This option guarantees optimal barcode readability.

Please note: As a result the size of the barcode may be reduced!

17.6 PostScript

17.6.1 Properties

Page Layout The page size (Letter, A4, ...) for PostScript output.

Orientation The orientation (portrait or landscape) for Postscript output.

Color Mode The color mode for PostScript output: “Color”, “Grayscale” or “Black & White”.
Duplex Single-sided and double-sided printing:

= Printer Default (uses the settings from the printer driver)

= Simplex (single-sided printing)

= Vertical (double-sided printing using a vertical page turn)

= Horizontal (double-sided printing using a horizontal page turn)

17.6.2 Image Resolution

Reduce to ___ (y/n) If enabled, all images of which the resolution is larger than the specified value will be re-
sampled. Smaller images are stored in their original resolution.

If disabled, all images are embedded in their original size.

17.6.3 Image Compression

Method The compression method that is used for storing images in the PostScritpt output:

= Automatic
(The compression method is selected automatically. The user can control whether the
JPEG and/or the Flate algorithms are basically allowed.)

= JPEG
(1 bit images are auto compressed. All other images are JPEG compressed.)

= Flate
(All images are flate compressed.)

= RLE
(All images are run length encoded.)
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Enable JPEG
compression (y/n)

Quality

Enable flate
compression (y/n)

17.7 Picture

Page Layout
Orientation

Output Resolution
Color Mode

Font Anti-aliasing (y/n)
TIFF Compression

JPEG Compression

17.8 Zebra (ZPL)

Page Layout
Orientation

Resolution

Scaling (*JM)

Compression

Dither Mode

Do not dither Text (y/n)

17.9 Barcodes

Barcode Printing on
Windows-Printers

= None
(All images are embedded without any compression.)

Enables JPEG compression.

The compression factor for JPEG images.
Enables flate compression (requires PostScript Language Level 3 support).

The page size (Letter, A4, ...) for image output.
The orientation (portrait or landscape) for image output.

The output resolution (in dpi) for rendering images.
The pre-set value is the screen resolution 96 dpi.

The default color mode for image output: “Color”, “Grayscale” or one of various “Black &
White” modes (e.g., Scattered Dither, Ordered Dither, Threshold).

If enabled, all fonts are anti-aliased. By default this option is enabled.
The compression method which is used for creating TIFF output.
The compression factor which is used for creating JPEG output.

The page size (Letter, A4, ...) and the orientation (portrait or landscape) for ZPL-Il output.
The orientation (portrait or landscape) for ZPL-II output.

The resolution (in dpi) of the used printer.
The pre-set value is “8 dots/millimeter (203 dpi)”.

Selects the scaling factor for the output. Switch to Doubled if the resulting output is half of
the required size.

= Normal (default)

= Doubled

Please check out your ZPL-Il manual for the ~JMA and *JMB commands for details.

Selects the compression method that is used for compressing the bitmap which is sent to
the ZEBRA printer. The following options are available:

= None
(The bitmap will not be compressed. This kind of transfer may be very slow but it is sup-
ported by all ZEBRA models.)

= RLE
(The bitmap will be RLE compressed. This option is supported by most ZEBRA models.
This is the default option.)

= PNG
(The sent bitmap is a PNG image. This option is supported by newer ZEBRA models
respectively newer ZEBRA firmware versions.)

Selects the method used for simulating color output on a black & white printer. The following
options are available:

= Scatter (grayscale simulation method 1, this is the default)

= Ordered (grayscale simulation method 2)

= Threshold (no grayscale pattern, just black or white)

If enabled, colored text is never dithered. By default this option is enabled.

For the output on Windows-Printers TFORMer offers the following barcode rendering
methods:
= Default method

(This method is given through the barcode DLL. Currently the default method is the
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quality mode — please, see below. However, it may change in later versions.)

= Compatibility mode, supported by all printers
(This method may result in suboptimal output quality, but it is compatible to nearly all
printers. It uses the GDI rectangle functions for drawing the barcode symbols.)

= Quality mode, supported by most printers
(This method results in the best quality but may not be supported by all printers. It uses
advanced GDI drawing methods.)

= Dual, a combination of above modes
(This method produces correct output on most printers but might decrease drawing
speed.)

17.10 Formatted Text

Hyphen used for

Specifies the separator character, which is used in case of a conditional word break. Select

output one of the list items or enter your own character (or string).
Additional soft The standard character for conditional word breaks is the so called “soft hyphen” character
hyphens (ASCII: 173 or ADh; Unicode: 00ADh; HTML: &#173 or &shy;). Whenever this character is

encountered in a string a word break may be inserted at this position. Thus TFORMer can

better utilize the available space within one text line.

You can also define your own characters to be used as conditional hyphens (e.g., the

negation character ). Just enter the respective characters into the field “Additional soft

hyphens”.

Please note:

= Whenever a conditional word break is applied the specified separator character (see
above) is printed.

= The soft hyphen itself (standard or user defined) is never printed! If you specify a dash as
conditional hyphen, the output of all(!) dashes will be suppressed!
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18 Licensing

18.1 License Types

Please check out www.tec-it.com/order for available license types and pricing.

18.2 Entering your License Data

To enter the license data select File » Options... | License... from the menu. The dialog below will

appear. TFORMer provides two methods for entering the license data:

=  Online Activation using the Activation Key (see 18.2.1).
This is the default method. Internet access is required.
= Manual Licensing (see 18.2.2).
Please get in touch us with us if your system has no internet access or if you prefer to use
the manual activation for any other reason. We will be glad to send you the license data
which is suitable for manual licensing

18.2.1 Online Activation using the Activation Key

If you have received an activation key from TEC-IT, please use the online activation ©.

Licensing @
6 Please enter the activation key and your address information:

.

Activation key (00000000000 -000000M):
K2)

Company:
Cournitry: ZIP: City:
Email address to send your license information to:
[ Privacy... ] [ Proxy... ] [ Send ] [ Cancel

Figure 89: License Dialog — Online Activation

The following steps are required to license the product:

1. Infield ® enter the activation key.

2. Infield ® enter your email address. A license certification will be sent to this address
automatically.

3. Complete all remaining data (Company, Country, ZIP Code, City). For a successful
activation all fields are required.

4. Confirm the entered data by clicking Send.

A message will inform you about the successful activation. In case of problems or errors, please
contact TEC-IT.
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18.2.2 Manual Licensing

Manual licensing is the alternative method for licensing if your system has no Internet connection.
Select manual licensing ® and enter the license data as provided by TEC-IT.

» Please enter the license data exactly as you received it from TEC-IT!
Spacing and upper/lower case letters are to be considered. To avoid typing errors, it is
recommended to use “copy and paste” whenever possible: Copy the data from the license
email which you have received from TEC-IT and paste it in the license dialog.

» Single licenses
If you are interested in a single (workstation) license, please tell us the so-called "System ID”
of the target computer. You can find the System ID in the licensing dialog (see below).

Licensing I@

Please enter your license information.
3
System-ID:

Fep7138F @
Product:
[TFORMer -

Licensee:

Kind of License: Mumber of Licenses:
[Worksiation v] 1

Your License-Key:

[ oK ] [ Cancel

" 4

Figure 90: License Dialog — Manual Licensing

The following steps are required to license the product:

1. Atthe top of the dialog you see the System ID (©) of your computer.
For single licenses we will ask you to send us the System ID of the target computer.

2. Inthe field “Product” select “TFORMer”.
In the field “Licensee” enter the name of the license holder.
4. Inthe field “Kind of License” select the kind of license that you have purchased. Possible
license types are:
- Workstation
- Site
5. In the field “Number of Licenses” enter the number of licenses that you have purchased.
6. Inthe field “Your License-Key” enter the license key exactly as received from TEC-IT.
7. Confirm the dialog with OK.

w

A message will inform you about the successful licensing. In case of problems or errors, please
contact TEC-IT.

18.3 Notes

TFORMer stores the license data in the registry of the current user (HKEY_CURRENT_USER\
Software\TEC-IT Datenverarbeitung GmbH\TFORMer\7.5). For workstation wide licensing copy this
license data to the corresponding HKEY _LOCAL_MACHINE registry path.

Another possibility to license TFORMer is to use a license file named “TFORMer.ini". This file must
be stored in the same directory as “TFORMer.exe”. For details, please contact TEC-IT.
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19 Contact and Support Information

TEC-IT Datenverarbeitung GmbH

Address: Hans-Wagner-Str. 6
AT-4400 Steyr
Austria/Europe

Phone: +437/(0)7252/72720
Fax: +43/(0)7252/72720-77
Email: mailto:support@tec-it.com

Web: www.tec-it.com

AlXis a registered trademark of IBM Corporation.

Avery and all Avery brands, product names and codes are trademarks of Avery Dennison Corporation.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.

JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by
Netscape.

Microsoft®, Windows®, Microsoft Word, Microsoft Excel® are registered trademarks of Microsoft Corporation.

Navision® is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries.

Oracle® is a registered trademark of Oracle Corporation.

PCL® is a registered trademark of the Hewlett-Packard Company.

PostScript® is a registered trademark of Adobe Systems Inc.

SAP, SAP Logo, R/2, R/3, ABAP, SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several other countries).

All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this
document is not marked as trademark (or registered trademark), we ask you to send us a short message (mailto:office@tec-it.com)
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Appendix A:

Properties

A.1 Form Properti

A.1.1 Common

es

Data Source

Select the data source which is used for printing. By default the manual data source is
selected. Whenever you change the data source (e.g., in the data view), this setting is
changed.

A.1.2 Advanced

Document Name

This expression will be used as name of the generated output or spool file. If left blank, the
file name is used.

A.1.3 Watermark

The watermark is a background picture which is printed per output page.

Picture

The file name of the picture.
See section A.3.1.4.

Picture Mode

The display mode of the picture.
See section A.3.1.4.

Picture Alignment

The alignment of the picture on the printed page.
See section A.3.1.4.

A.1.4 Documentation

Comment

An arbitrary comment. For documentation purposes.
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A.2 Band Properties

A.2.1 Common

Group By?

Page Break®

Row/Column Break®

Pre-Evaluation

Post-Evaluation

A.2.2 Advanced

The records of a data source will be grouped based upon this expression: Every time, the
computed value of the expression changes, a new group will be started. Group by
expressions do not change the order of the records in the data source!

Group headers are printed when a group starts, group footers are printed after a group
ends.

Determines whether a page break will be inserted before and/or after this band. Possible
values:

= None

= Before this Band

= After this Band

= Before and After this Band

Determines whether a row/column break will be inserted before and/or after this band.
Possible values:

= None

= Before this Band

= After this Band

= Before and After this Band

This expression will be evaluated before the band is printed (see section 12.4).

This expression will be evaluated after the band is printed (see section 12.4).

Most settings in the group Advanced are available for Complex report and label layouts only.

Tray

Type
Output Area*

Print at Bottom®

A.2.3 Control

Printing Condition

A.2.4 Position

Height®
Width®

Can Grow’

For every single page of the output you can dynamically select a tray on the target printer.
E.g., this might be useful for printing the first page of an invoice on a letterhead.

The tray selection is performed by the first band on a new page (e.g., by the page header).
The tray that is entered in the property of this band will be selected:

= Tray 0 is the default tray (uses the setting of the current printer driver).
= Tray 1 to 10 can be pre-configured (Tray Mappings » Trays).

For more details, please refer to section 12.6.

The band type (Report Header, Page Header, ...).

The area, in which the band shall be printed:

= Page

= Label

By default, the report footer will be printed directly after the last detail band. By setting this
value to True, the report footer will be printed at the bottom of the page (before the page
footer).

The printing condition decides at print-time, whether the band is printed or not (see section
12.2).

The band height.
The band width.

Specifies, whether the height of the band is increased if required. This is useful if the band

2 For group headers and group footers.
3 Not for page headers and page footers.
4 For report headers, page headers, page footers and report footers.

5 For report footers.

8 Availability depends on the layout type and on the band type.
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contains elements with dynamic size (possible for text and picture elements). Allowed
values are:

= No
= Height

Can Shrink

Specifies, whether the height of the band is decreased if possible. This is useful if the band
contains elements with dynamic size (possible for text and picture elements). Allowed
values are:

= No
= Height

Print across Pages?®

Specifies if the band may be printed across pages:

= Yes (the band will be continued on the next page, if it does not fit in the remaining space
on the current page)

= Avoid (the band will be split only if it does not fit on an empty page)
= No (the band will be clipped if it does not fit on an empty page)

A.2.5 Documentation

Name

The name of the band (used for display only).

Comment

An arbitrary comment. For documentation purposes.

A.2.6 Columns

The group Columns is available for detail bands only.

Columns Specifies, how many columns are used for printing the detail bands.
If activated, each new record (respectively each record copy) is printed in a subsequent
column. When designing the layout you have to consider, that only the respective
percentage of the column width may actually be used for design elements (e.g., for 2
columns you may only cover 50% of the width). The Row/Column Break has to be removed.

Gap The gap between the columns.

Width The width of a column.

For the alternating output of two or more detail bands you have to consider, that each involved
detail band must have the same column settings!

7 Not for page headers.
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A.3 Element Properties

A.3.1 Common

A.3.1.1 Text Elements

Text

The text to be printed.

Font

Selects the font style and size.

Text Direction

Text direction (0°, 90° CW, 90° CCW or 180°).

lines will be clipped.

Text Color The color of the text.
Fill Color The color and the pattern of the text background.
Line Color The color and the pattern of the bounding rectangle.
Line Width The width of the bounding rectangle.
Line Style The line style for the bounding rectangle (solid, dashed, ...).
Alignment The alignment of the text within the bounding rectangle.
The following values are possible:
Top, Left Top, Center Top, Right
Center, Left Center Center, Right
Bottom, Left Bottom, Center Bottom, Right
Justify Turn justify on/off.
Word Wrap Automatically wrap words dependent on the given element width (y/n)? If disabled long text

A.3.1.2 Barcode Elements

Barcode Data

The data which is encoded as barcode symbol.

The barcode data may contain static data and/or dynamic data (e.g., data fields).

Barcode Type

The barcode type (symbology).

Check Digit Selects the check digit computation.
Barcode Color The color of the bars.

Font Selects the font style and size.

Text Color The color of the text.

Fill Color The color and the pattern of the background.

Human Readable Text

The position of the human readable text (Above, Below, No).

Human Readable Text
Distance

The distance between the barcode and the human readable text.

Alignment The alignment of the barcode within the bounding rectangle.
The following values are possible:
Top, Left Top, Center Top, Right
Center, Left Center Center, Right
Bottom, Left Bottom, Center Bottom, Right
Direction Barcode direction (0°, 90° CW, 90° CCW or 180°).

A.3.1.3 Line, Rectangle, Ellipse

Fill Color The color and the pattern of the text background.
(This property is not available for line elements.)

Line Color Line color and pattern.

Line Width The line width.

Line Style The line style (solid, dashed, ...).

Radius The radius of the rounded corner.

(This property is only available for rounded rectangles.)
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File Name

Alignment

Direction
Mode

Transparent Color

A.3.2 Advanced

Auto Font Size

Auto Font Size
Minimum

Auto Font Size
Maximum
Optimize Spaces

Suppress Blank Lines

Line Spacing

The image file name.
The following file formats can be used: .bmp, .gif, .jpg, .pcx, .png, .tga, .tif.
File names can be specified using one of the following formats:
= Windows file format
(e.g., “C:\temp\sample.png”)
= URL format (only available under windows!)
(e.g., “https://www.tec-it.com/pics/sample.png”)
You can use absolute file names (e.g., “C:\sample.jpg”) and relative file names (e.g.,
“sample.jpg” or “‘img\sample.jpg”). As base for relative path specifications the path of the
TFORMer file (.tff or .xmd) is used.
The alignment of the picture within the bounding rectangle.
The following values are possible:

Top, Left Top, Center Top, Right
Center, Left Center Center, Right
Bottom, Left Bottom, Center Bottom, Right

Picture direction (0°, 90° CW, 90° CCW or 180°).

The display mode:

= Clip (The picture will be printed in its original size and might be clipped by the bounding
rectangle.)

= Stretch (The picture will be stretched to fit the bounding rectangle, regardless of its
aspect-ratio.)

= Zoom (The picture will be enlarged to its maximum possible size within the bounding
rectangle, keeping its aspect-ratio.)
= Tile (The picture will be replicated row- and column-wise inside the bounding rectangle.)

All regions in the image that are filled with the selected color will be printed transparently.

If set to True, TFORMer automatically selects the biggest possible font size, for which the
text to fits into the bounding rectangle without being cropped.

Specifies the lower font size limit (in percent), if Auto Font Size is enabled.
Specifies the upper font size limit (in percent), if Auto Font Size is enabled.

If enabled, multiple consecutive spaces will be printed as one single space character.
Sample: “TFORMer Designer ” will be printed as “TFORMer Designer”.

If enabled, empty lines in a multiline text will not be printed.

Sample: “TFORMer  will be printed as  “TFORMer
Designer”
Designer”

The spacing between text lines.

For more information on the following properties, please refer to the Barcode Reference, which is
available for download on www.tec-it.com.

Escape Sequences
Hex Data

Codepage

Turn the translation of escape sequences on/off.

Enable this property if your barcode data is provided as hex-string. TFORMer will convert it
to ASCII characters automatically. Example: The hex-string “34373131” will be converted
into the barcode data “4711”.

This setting allows you to specify the codepage for encoding characters outside of the
standard ASCII range (0-127). This means this setting is relevant for specific 2D barcodes
only (others do not support the respective character range).

Please note:

If you choose any other page than the default codepage the characters might get mixed up
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Format

Bearer Width

Module Width
Notch Height

Bar:Space Ratio

Suppress Error
Message

Optimal Resolution

Bar Width Reduction

Encoding

A.3.3 Control

Printing Condition

Layer

A.3.4 Position

Left

Top
Right
Bottom
Width
Height
Rotation

Can Grow?®

or even unreadable. For public applications you should therefore always use the default
codepage. If you try to encode special characters (like A or N), please make sure that the
2D symbology is able to encode these characters with the default codepage.

The format property is used for formatting the utilizable data of the barcode. It is specified
via a string that operates with substitute symbols to indicate how the data shall be structu-
red.

Specifying a format string, you can:

= Select subsets for Code 128 and UCC/EAN-128.

= Define the desired Start/Stop characters for CODABAR.

= Reposition the Check-Digit (in special cases).

= Encode the date, preamble, service class, postal and country code into the barcode data
(MaxiCode).

Adjust the horizontal lines above and below the barcode:

0 inch (or mm) ... no line

x inch (or mm) ... use the specified line width

The module width is the width of the narrowest bar.

The notch height specifies how far the synchronization bars should jut out from the remain-
ing barcode. (E.g., the EAN code has synchronization bars on the left, in the middle and on
the right.)

This property is used to specify the relationship between the widths of the single bars and
spaces of a barcode. The input format depends on the selected barcode type. — For Code
20Fb5 Interleaved you could specify the ratio “1:2:1:2”, e.g.

In case of an error during the printing of a barcode (e.g., wrong input data), an error mes-
sage will be printed. This option allows you to suppress the error message. The space will
be left blank instead.

Automatically adjust the module width of the barcode (decrease it) to avoid aliasing prob-
lems on the output device. The module width is set to a multiple of the smallest available
printing unit.

When printing on inkjet printers, the ink that is absorbed by the paper tends to diffuse.
Setting the bar width reduction allows you to work against this spreading of ink.

The bar width reduction is specified in percent of the module width. E.g., when setting this
value to 20 all bars will be narrowed by 20 percent of the module width.

Specifies how the characters should be encoded inside the barcode. This setting is available
for most 2D barcodes. (The barcode must be capable of encoding binary data.)

Possible values:
= automatic (TFORMer tries to minimize the barcode data)
= binary

The printing condition decides at print-time, whether the element will be printed or not (see
section 12.2).

Assign the element to one of the predefined layers (see section 12.3).

The left most coordinate of the element.
The top most coordinate of the element.
The right most coordinate of the element.
The bottom most coordinate of the element.
The width of the element.

The height of the element.

The rotation of the element in degrees.

Note: For simple rotations of text, barcode and picture elements in 90° steps we recommend
the use of the property “Direction” (see also section A.3.1). It may simplify the positioning of
the element, because not the element itself is rotated, but only its content.

Specifies, whether the dimensions of the element are adjusted according to its content.

8 For text and picture elements
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If a text is clipped inside the frame (relevant for dynamic content only) you can use the pro-
perty Can Grow. The size of the text element will be increased automatically as required.
Allowed values are:

= No

= Height

= Width

= Height and Width

If the height of the band which contains this element should grow accordingly, enable the
“Can Grow” property of the band.

Can Shrink®

Specifies, whether the dimensions of the element are adjusted according to its content.
Allowed values are:

= No

= Height

= Width

= Height and Width

If the height of the band which contains this element should shrink accordingly, enable the
“Can Shrink” property of the band.

Flush Top

Adjust the top border to the specified band edge.

Useful for drawing column separator lines in tables. Allowed values are:
= No

= Last Printed Band

Flush Bottom

Adjust the bottom border to achieve a common baseline.

Useful for aligning an element to the bottom position of the band or other elements. Allowed
values are:

= No
= Elements
= Band

Flush Right

Adjust the right border to achieve a common vertical line to the right.

Useful for aligning the right border of an element to the right position of the band or other
elements. Allowed values are:

= No
= Elements
= Band

Shift Mode

This property is used to move elements relative to other growing or shrinking elements.
“Always” considers size-changes of other elements immediately. “When overlapped” only
avoids intersections.

Allowed values are:
= Always

= Don't shift

=  When overlapped

A.3.5 Margins

These properties are available for Text Elements only:

Margin Left

Margin Top

Margin Right

Margin Bottom

These margins are used to confine the printing area within a text element.

A.3.6 Documentation

Name

The name of the element.

Comment

An arbitrary comment. For documentation purposes.
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A.4 Layer Properties

A.41 Common
Name The name of the layer.
Display Color If Layout » Layers | Show Layers is enabled, all elements within this layer will be drawn in
the specified color.
Visible Here you can toggle all elements of one layer visible or invisible.
Please note: This is for editing purposes only! — The output will not be affected.
A.4.2 Control

Printing Condition

The printing condition decides at print-time, whether the elements, which are assigned to that
layer, will be printed or not (see section 12.2).

A.4.3 Documentation

Description

A simple description. Only for documentation purposes.

Comment

An arbitrary comment. For documentation purposes.

A.5 Data Field Properties

A.5.1 Common
A.5.1.1 Data Field
Name The name of the data field.
This name can be used to address the data field in expressions.
Data Type The type of the data field. Choose one of the following:

= Text

= Integer

= Floating-point

We recommend the general use of the data-type "Text".

Default Value

The default value for the data field. This value will be returned, if no other value is given.

A.5.1.2 Computed

Name

The name of the data field.
This name can be used to address the data field in expressions.

Data Type

The type of the data field. Choose one of the following:
= Text

= Integer

= Floating-point

Expression

The expression which is used to compute the value for the data field.

Compute Per

Choose if the data field is re-computed for every:
= Record
= Record copy

A.5.1.3 Serial
Name The name of the data field.
This name can be used to address the data field in expressions.
Data Type The type of the data field. Choose one of the following:
= Integer
= Floating-point
Start Value The start value for the serial number.

If the “Store last value” property is enabled (see below), the start value will be updated auto-
matically after each print-job.
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Step Size The step size in which the serial number is incremented.

Store Last Value (y/n) If enabled TFORMer remembers the last printed value. The next unused value will be as-
signed as start value for the next print job automatically.

Update on Choose the trigger, on which the serial number is incremented:
= Record

= Record copy
= Document
= Page
= Label
Update Condition An optional condition controlling the increment of the serial number.

If a condition was entered, the serial number will only be increased if the result of the ex-
pression is true.

A.5.2 Validation (Data Field)
The Validation group is only available for normal data fields.

Validation Rule This rule is verified when importing data.

Validation Message If the validation rule is violated, this message will be prompted.

A.5.3 Aggregation (Computed)
The Aggregation group is only available for computed data fields.

Aggregation Type Selects one of the available aggregation functions or disables aggregation.
Available values are:

= None
= Running Average
= Running Sum

Aggregation Region If aggregation is enabled, select the region for which the aggregation values are calculated:
= All
(do one aggregation within the whole range of the print-job)
= Page
(do a separate aggregation within the range of each new page)
= Label
(do a separate aggregation within the range of each new label)
= Group
(do a separate aggregation within the range of each new group)

Group If the aggregation region is set to “Group”, use this field to enter the grouping condition. Enter
the same condition as specified in the group header or group footer.

Aggregation Filter An optional filter for aggregation values.
If a filter was entered, single values will only be considered, if the expression returns true.
Thus you can define, which values are considered for the aggregation, and which not.

A.5.4 Advanced

Caption These properties may be queried with the TFORMer SDK API. They have no functionality for
printing.
Display Order This property is used by the data grid of TFORMer Designer and by the tool QuickPrint to

determine the order in which data fields are displayed. By default TFORMer sorts the data
fields alphabetically.

A.5.5 Documentation

Description A simple description. Only for documentation purposes.

Comment An arbitrary comment. For documentation purposes.
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A.6 Tray Mapping Properties

A.6.1 Common

Name The name of the tray mapping.
A.6.2 Trays
Tray 1 For each of the 10 logical trays in TFORMer you can assign a device-specific printer tray.

You can assign tray names or paper format names.
Tray 10
A.6.3 Documentation

Description A simple description. Only for documentation purposes.

Comment An arbitrary comment. For documentation purposes.

A.7 Repository

Description A simple description. Only for documentation purposes.

Comment An arbitrary comment. For documentation purposes.

A.8 Tray Mapping Properties (Repository)

Same as the Tray Mapping Properties described in A.6.

A.9 Global Data Fields (Repository)

Same as the Data Field Properties described in A.5.

A.10 Projects (Repository)

A.10.1 Common

Name The name of the project.

A.10.2 Documentation

Description A simple description. Only for documentation purposes.

Comment An arbitrary comment. For documentation purposes.

A.11 Forms (Repository)

A.11.1 Common
Name The name of the form.
File The file name of the form.
A.11.2 Documentation

Description A simple description. Only for documentation purposes.

Comment An arbitrary comment. For documentation purposes.
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Appendix B: Supported HTML Tags and Entities

B.1 HTML Tags

B.1.1 Standard
Tag Description
<a> Anchor.

Used for embedding links. Only the href attribute is supported.
E.g., <a href="http://www.google.com”>Link to Google</a>

<b>, <strong>

Bold text.
Everything between the start tag <b> and the end tag </b> is rendered bold.

<br> Line break.
Inserts a line break.
<font> Font.
The following attributes are supported:
= color
Only hexadecimal values, no color names.
E.g., <font color="#ff0000">.
= name
Selects a typeface.
E.g., <font name="Helvetica>
= size
Use one of the predefined HTML font sizes within the range from 1 to 7.
E.g., <font size="2">
= style
Supports the “font-size” attribute only.
E.g., <font style="font-size: 12pt">
<i> Italic text.
Everything between the start tag <i> and the end tag </i> is rendered italic.
<p> Paragraph.
<p> starts a new paragraph. </p> ends the paragraph.
<strike> Strike through text.
Everything between the start tag <strike> and the end tag </strike> will be striked through.
<sub> Subscript.
Everything between the start tag <sub> and the end tag </sub> will be subscript.
<sup> Superscript.
Everything between the start tag <sup> and the end tag </sup> will be superscript.
<u> Underlined text.

Everything between the start tag <u> and the end tag </u> will be underlined.

Table 1: Supported HTML Tags

B.1.2 TFORMer Specific

Tag Description
<Expr> Used by TFORMer internally. This tag embeds expressions.
<HtmIExpr> Used by TFORMer internally. This tag embeds expressions, which are returning HTML.

Table 2: Supported HTML Tags (TFORMer Specific)

B.2 Named Entities

Named Entity Character Description
&amp; & Ampersand.
&copy; © Copyright.
&deg; ° Degree.

&gt; > Greater than.
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&laquo; « Left angle quotation mark.
&lt; < Less than.

&micro; u Micro symbol.

&middot; Middle dot.

&nbsp; Non breaking space.
&plusmn; + Plus minus.

&raquo; » Right angle quotation mark.
&reg; Registered Trademark.
&sect; § Section sign.

&shy; Soft hyphen.

&trade; ™ Trademark.

&zws; Zero width space.
&zerowidthspace;

Table 3: Supported HTML Entity Names (incomplete list)
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Appendix C: Function Reference

C.1 Functions

Return Function

Description

long Abs («Number») Returns the absolute value of a number.
date AddDays () Adds or subtracts the specified number of days to/from a date value.
date AddMonths () Adds or subtracts the specified number of months to/from a date value.
date AddWeeks () Adds or subtracts the specified number of weeks to/from a date value.
date AddYears () Adds or subtracts the specified number of years to/from a date value.
long Asc («Text») Returns the ASCII value of a given character or of the first character of «text».
date CDate («Text») Converts the string «text» to a date. Provides an empty date if no conversion is
possible.
The date format in «Text» depends on the regional settings on your computer. This
setting is configured in the Control Panel » Region and Language under ,Formats®.
= German: Format = “24.12.2004”
= English: Format = “12/24/2004”
date CDateEx («Text», Converts a string into a date. The conversion format to be used is adjustable. For infor-
«Format») mation on how to specify the format, please refer to the description of the function

Format («Date», «Format») below.
Example: CDateEx ("31.12.2000", "dd.MM.yyyy").

double CDbl («Expr»)

Converts any value to a double value (floating-point notation).
The result is 0.00 when a conversion is not possible.

char CheckChar_ISO706
4Mod37_2 («Dataw)

Calculates the check character according to ISO 7064 Mod 37-2.

string CheckDigits
(«Method», «Text»)

Returns the check digit for the given string as text. Possible values for «Method» are: 2
(Modulo 10), 3 (Modulo 43), 4 (Modulo 47, 2 digits), 5 (DP Leitcode), 6 (DP Identcode),
7 (Code11, 1 digit), 8 (Code11, 2 digits), 9 (USPS PostNet), 10 (MSI, 1 digit), 11 (MSI,
2 digits), 12 (Plessey), 13 (EAN 8), 14 (EAN 13), 15 (UPC A), 16 (UPC E), 17 (EAN
128), 18 (Code 128), 19 (Royal Mail 4 State), 20 (Modulo-11, PZN), 21 (Modulo-11,
W=7), 22 (EAN 14), 23 (Modulo 10, Korean PA), 24 (Modulo 10, Planet), 25 (Modulo
10, ltalian Postal 2/5), 26 (Modulo 36, DPD Barcode), 27 (Modulo 16), 28 (Modulo 10,
Luhn Algorithm).

(«Date»)

long CheckDP («Text») Returns the Deutsche Post check-digit (Leitcode, Identcode) of the specified value as
long.
long CheckMod10 Returns the Modulo 10 check-digit (weighted) as ASCII code.
(«Text») E.g., CheckMod10(”1203”) will return 52, which is the ASCII code for the character “4”.
Please, use the function Chr(CheckMod10(..)) to get the result as a character.
char CheckMod36 Returns the Modulo 36 check-digit of the specified value as character.
(«Text»)
char CheckMod43 Returns the Modulo 43 check-digit of the specified value as character.
(«Text»)
char Chr («Numbery) Returns the corresponding character for the specified ASCII value «Number».
long CLng («Expr») Converts any value into a whole number. If a conversion is not possible, the result is 0.
string CStr («Expr») Converts a value into a text.
long Day («Date») Determines the day of the month [1..31].
long DayOfWeek Returns the day of the week of a specified date [1..7]. 1=Sunday, 2=Monday, ...

double DayOfYear
(«Date»)

Returns the day of the year of a specified date [1..366].

double Exp («Number»)

Returns the value eN'™e” where e is the base of the natural logarithms.

double Exp10 («Number»)

Returns the 10«<Number>,

long Find («Text»,
«SearchText»,
«nStart»)

Searches the string «Text» for «SearchText» starting from Position «nStart». Returns
the position of the string or -1. The first character of a string is located at position 0.
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long FindReverse Searches the string «Text» for «SearchText» in reverse order excluding «nExclude»
(«Text», characters at the end. Returns the position of the string or -1. The first character of a
«SearchText», string is found at position 0.
«nExclude»)
string Format («Number», | Formats «Number» according to the specified pattern string «Pattern».
«Patterny») Format placeholders:
# digit or no value,
0 '0" or digit
. decimal point
, comma
+ - sign
string Format («Date», Formats «Date» according to the specified pattern string «Pattern».
«Pattern») Format placeholders:
dd day of month (01 —31)
MM month double-digit (01 — 12)
MMM month three-digit (Jan — Dec)
\%% year double-digit (01)
yyyy year four-digit (2001)
Example: Format (CDate("12/24/2009"), "MMM, dd yyyy") returns Dec, 24 2009.
See also section C.4 Formats.
double Fract («Number») Returns the fractional unit of «<Number».
long Hour («Date») The hour of a specified date [00..23].
string lIf («Condition», Returns the value of «TrueExpr» if «Condition» is evaluated as (TRUE or not equal to
«TrueExpr», 0).
«FalseExpr») Returns the value of «FalseExpr» if «Condition» is evaluated as (FALSE or equals 0).
bool IsDate («Text», Checks if the given string can be converted into a valid date using the specified
«Format») conversion format. For information on how to specify the format, please refer to the
description of the function Format («Date», «Format») above.
long ISEmpty («Text») Test whether the string «Text» is empty or not.
long IsEven («Number») | Returns TRUE if «Number» is even.
long IsLastPage () Returns TRUE if the page being printed is the last page of the document.
bool IsLeapYear Returns TRUE if the specified date occurs within a leap year.
(«Date»)
long IsOdd («Number») Returns TRUE if «Number» is uneven.
string KeepChars («Text», | Removes all characters in «Text» which are NOT included in «KeepChars».
«KeepChars»)
string LastValue Returns the last value of a given data field (the value of the data field from the previous
(«VarName») record).
string Left («Texty, Returns the first characters «nLength» of a string.
«nLength»)
long Len («Text») Returns the length of the given string.
double Log («Number») Returns the natural logarithm of «Number».
double Log10 («Number») Returns the logarithm of «Number».
string Lookup («Key», Retrieves the value associated with the specified key. If the key is not found the default
«NamedValues», value is returned.
«DefaultValue») Example: Lookup ("KEY1", "key1=value1 key2=value2", "DefaultValue") returns
“value1”.
string Mid («Texty, Returns the substring of string «Text» starting at position «nStart» with length
«nStart», «nLength». The first character of a string is located at position 0.
«nLenghty)
long Minute («Date») The minutes of a specified date/time [00..59].
long Month («Date») The month of the specified date [1..12].
date Now () The actual date and time.
double Pow («Number», Returns the result of «<Number» raised to the power of «Power».
«Powery)
double RandomDbl Generates a random number (type double) in the range [MinValue..MaxValue].
(«MinValuev,
«MaxValue)
long RandomLng Generates a random number (type long) in the range [MinValue..MaxValue].
(«MinValuey,
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«MaxValue»)

string RandomStr Generates a random string of given length using the given characters.
(«Length, Example: RandomStr (6, "0123456789ABCDEF") might return "12AF42".
«AllowedChars»)

string RemoveChars Removes all characters in «Text» which are included in «RemoveChars».
(«Text»,
«RemoveChars»)

string Replace («Text», Replaces each occurrence of «SearchText» in string «Text» with «ReplaceText».
«SearchTexty,
«ReplaceText»)

string Right («Text», Returns the last characters «nLength» of a string.
«nLengthy)

double Round («Number, Returns «Number» rounded using precision digits. If 0 is «Precision» the result will be
«Precisiony) rounded to a whole number.

long Second («Date») The second of a specified date/time [00..59].

double Sqrt («Numbery) Returns the square root of «Number».

long SumOfDigits The sum of all digits of «Number».
(«Numbery)

long SumOfDigits1 Returns the one digit sum of all digits of «Number».
(«Number»)

string ToLower («Text») Converts all character in the string «Text» to lower case.

string ToUpper («Text») Converts all character in the string «Text» to upper case.

string Trim («Text») Removes leading and trailing spaces.

string TrimLeft («Text») Removes leading spaces.

string TrimRight («Text») Removes trailing spaces.

double Value («Text») Converts «Text» to a double value.

long WeekOfYear The calendar week of a specified date/time [1..52].
(«Date»)

long Year («Date») The year of the specified date/time.

Table 4: Functions

C.2 System Data Fields

Function Description
BandName The name of the current band.
BandType The type of the current band.
Column The current column number (label printing) [0..x].
ComputerName The name of the computer (hostname).
Copy The actual number of copies [1..NumCopies].
Device The name of output device (Printer).
Device Type The type of the output device (usually Winspool).
Form The name of the current form.
LogPage The number of the current logical page® [1...NumLogPages].
Several logical pages can be printed per physical page.
NumCopies The count of all copies [1..x].
NumLogPages The count of all logical pages® [1...x].
Several logical pages can be printed per physical page.
NumPages The count of all physical pages (sheets) [1..x].
NumPrintltems Total number of items to be printed. Sum of the copy count of all records.
NumRecordCopies The number of copies of the actual record.

% A logical page is usually the area of a label on the output page. Every Row/Column Break starts a new logical page.
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NumRecords

The count of all input-records.

Page

The actual page number [1..NumPages].
Every printed physical page (sheet) increases the page number by 1.

Printedltems

Number of currently printed items, including the current item.

Project The name of the current project.

ProjectDir The directory of the current project.

Record The actual record number [1..NumRecords].

RecordCopy The actual number of record copy.

Repository The name of the current repository.

RepositoryDir The directory of the current repository.

Row The current row number (by Label print) [0..x].

tfDocumentName This name will be used for the spool-job under Microsoft Windows. Can be set via an

expression.

tfServerJobFile

The job file of TFORMer Server.

tfServerJoblD

The job ID of TFORMer Server.

tfServerJobTimesPrinted

For TFORMer Server only: How often has this server job already been printed.

XResolution

Horizontal device resolution in dots per inch (25.4 mm).

YResolution

Vertical device resolution in dots per inch (25.4 mm).

Table 5: System Data Fields

C.3 Common Expressions

Expression

Description

“_“+ CStr (Page) + “ -*

Inserts the page number into the layout.

“‘EUR ” + Format («Numbery, “###HHHHH#.00”)

Formats a value into a EUR price.

“Page ” + CStr (Page)

Inserts a formatted page number into the layout.

“Page ” + CStr (Page) + “ of ” + CStr(NumPages)

Inserts the page number and the count of all pages into the layout.

“USD ” + Format («<Number», “t#HH#HH##.00”)

Formats a value into a USD price.

CStr (NumPages)

Inserts the count of all pages into the layout.

Format (Now (), “hh’’mm’:’ss tt”)

Inserts the actual time (12 hours).

Format (Now), “HH’’mm’:’ss”)

Inserts the actual time (24 hours).

Now ()

Inserts the current date into the layout.

Table 6: Common Expressions

C.4 Formats

C.4.1 Numbers

Expression

Description

Format («Numbery, “# ### ##0.00+”)

Formats a number with a trailing sign (+ or -) (e.g., 1.299,20+).

Format («Numbery, “# ### ##0.00-")

(e.g., 1.299,20-).

Format («Numbery, “*,***,**0.00-")

(only if negative) (e.g., ***1.299,20-).

Format («Number», “+# ###,##0.00”)

Formats a number with a leading sign (+ or -) (e.g., +1.299,20).

Format («Number», “-#,### ##0.00”)

(e.g., -1.299,20).

Format («Number», “-0.000.000.00")

(e.g., -0.001.299,20).

Table 7: Number Formats
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Formats a number with an optional trailing sign (only if negative)

Formats a number with leading starts and an optional trailing sign

Formats a number with an optional leading sign (only if negative)

Formats a number with an optional leading sign (only if negative)
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C.4.2 Date

Expression

Description

Format (Now (), “dd’-‘MM’-'yy”)

Formats the actual date (e.g., 29-01-07).

Formats the actual date (e.g., 29-01-2007).

(
Format (Now (), “dd’-MM’-‘yyyy")
Format (Now (), “dd’."MM’-‘yyyy")

Formats the actual date (e.g., 29. Jan ‘07’).

Formats the actual date (e.g., 29.01.2007).

Format (Now (), “ddd’,’d”."MMM"'yyyy”)

Formats the actual date (e.g., Mon., 29. Jan. 2007).

(
(No
Format (Now (), “dd’.’MM’.’yyyy”)
(
(

Format (Now (), “dddd’,'d’. MMM".'yyyy”)

Formats the actual date (e.g., Monday, 29. Jan. 2007).

Format (Now (), “dddd’,'d’. MMMM yyyy”)

Formats the actual date (e.g., Monday, 29. January 2007).

Table 8: Date Formats

C.43 Time

Expression

Description

Format (Now (), “h’.’m’.’s tt”)

Formats the current system time and appends am or pm (according
to the language settings of your system) (e.g., 9:6:5 am/pm).

Format (Now (), “H’.’'m’.’s”)

Formats the current system time (e.g., 21:6:5).

Format (Now (), “h’.’mm’.’ss tt”)

Formats the current system time and appends am or pm (according
to the language settings of your system) (e.g., 9:06:05 am/pm).

Format (Now (), “H’.’mm’.’ss”)

Formats the current system time (e.g., 7:06:05).

Format (Now (), “hh’.’mm’’ss tt”)

Formats the current system time and appends am or pm (according
to the language settings of your system) (e.g., 09:06:05 am/pm).

Format (Now (), “HH’."mm’.’ss”)

Formats the current system time (e.g., 21:06:05).

Table 9: Time Formats

C.5 Operators

Please note that there may be more than one operator for identical operations. In this case you can

select your preferred notation.

Operator Description

! Logical NOT.

1= Comparative operator not equal.

% Modulo.

& Bitwise AND.

&& Logical AND.

* Multiplication.

+ Addition (add values, concatenate strings).
- Subtraction.

/ Division.

< Comparative operator smaller than.

<= Comparative operator smaller than or equal.
<> Comparative operator not equal.

= Comparative operator equal.

== Comparative operator equal.

> Comparative operator greater than.

>= Comparative operator greater than or equal.
A Bitwise XOR.

and Logical AND.

not Logical NOT.

or Logical OR.
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xor Bitwise XOR.
| Bitwise OR.
Il Logical OR.
~ Bitwise NOT.
Table 10: Operators
C.6 Constants
Constant Description
"\n" Linefeed.
False Logical value FALSE. This value is usually the result of a condition. If the condition is not
fulfilled the resulting value is FALSE.
True Logical value TRUE. This value is usually the result of a condition. If the condition is fulfilled
the resulting value is TRUE.

Table 11: Constants
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Appendix D: Layout Schemes

D.1 General

Basically TFORMer distinguishes two layout types: Labels and Reports. Each of these two types
allows different variations in the page layout:

= When printing Labels usually one detail band is printed on each label. A label is also referred
to as logical page area. This area can be printed once or multiple times on each physical
page.

=  When printing Reports multiple details bands are printed underneath each other. The page
(minus the headers and footers) is filled with detail bands. The area on which the detail
bands are printed is internally also treated as logical page (= as label).

Figure 91 to Figure 99 use the following color keys for page areas and bands:

0 The red frame marks the page area, which may, on demand, be divided into multiple labels.
1 The dashed frame marks one label (one logical area).

[ Depending on the settings for this band, it is either printed inside or outside of the label area.
(Applies to page headers, page footers, report headers and report footers.)

] This band is always printed inside of the label area.
(Applies to detail bands, report headers and report footers.)

TFORMer fills each physical page with page headers, detail bands, page footers, etc. If no space is
left a new physical page is started.
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D.2 Report

For the layout type “Report” the following variations are available:

=  Simple — see section D.2.1
= Columns — see section D.2.2
= Complex — see section D.4

D.21 Simple

For a simple report start with the template <Custom
‘ Report Header ‘ Report> and select the variation “Simple Report” (see also
‘ 6.2.2.1).

‘ Page Header

In the page setup dialog you specify the paper size and the
page margins.

‘ Detail Band

|
‘ Detail Band ‘
‘ Detail Band ‘ ExampleS:
File » New... » (6) Samples » Report_1
| Detai Band | File » New... » (6) Samples » Report_2
‘ Detail Band ‘

Report Footer ‘

‘ Page Footer ‘

Figure 91: Simple Report

D.2.2 Columns

For a report with columns start with the template <Custom
Report Header ‘ Report> and select the variation “Columnar Report”.

‘ Page Header ‘

In the page setup dialog you specify the paper size, the
page margins and the columns.

‘ Detail Band ‘ ‘ Detail Band ‘

‘ Detail Band ‘ ‘ Detail Band ‘ Hint:

Detail Band When using a fixed number of columns and if you set

Width="0" the available horizontal space is divided equally.
Detail Band

Detail Band Example:
File » New... » (6) Samples » Report 5

‘ Report Footer ‘

Page Footer ‘

Figure 92: Report with Columns
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D.3 Labels

For the layout type “Label” the following variations are available:

= Label Printer— see section D.3.1
= Label Sheets — see section D.3.2
= Complex — see section D.4

D.3.1 Label Printer

Label
(Detail Band)

Label
(Detail Band)

Label
(Detail Band)

Etikett
(Detailbereich)

Paper Format: Height

Paper Format: Width

Figure 93: Label Printer

D.3.2 Label Sheets

Detail Band Detail Band
Detail Band Detail Band
Detail Band Detail Band
Detail Band Detail Band

Figure 94: Label Sheets

For printing on label printers (e.g., ZEBRA® thermo transfer
printers) start with the template <Custom Label> and select
the variation “Label Printer” (see also 6.2.2.3).

In the page setup dialog you specify the label size.

Example:
File » New... » (2) Transportation » DHL »
DHL_EuroConnect

For printing on label sheets (e.g. Avery® standard formats)
start with the template <Custom Label> and select the
variation “Label Sheets” (see also 6.2.2.2).

Hint:

If you intend to use different paper sizes for your printout
you can set the number of rows and columns to “auto”. In
this case TFORMer will calculate the number of labels that
fit on the output page.

Example:
File » New... » (6) Samples » Label_1
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Page Header

el Detail Band
Detail Band Detail Band
Detail Band Detail Band
Detail Band Detail Band

Page Footer

Figure 95: Label Sheets with Headers and

Footers
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If required you can also insert additional page headers and
footers respectively report headers and footers for label
sheets:

Example:
File » New... » (6) Samples » Label_2
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D.4 Complex

For <Custom Label> and for <Custom Report> you can choose the layout variation “Complex”
which refers to the same design mode in both cases. When using “Complex” you have full access to
all band properties, even to those which are hidden in the basic layout types otherwise.

For implementing the following layout schemes it does not matter if you are starting with the
template <Custom Label> or <Custom Report>. In both cases you have full control over the design.
The only difference is the different base design you are starting with.

D.4.1 Labels with Headers and Footers

‘ Report Header ‘
‘ Page Header ‘
[ Page Header |! ![ Page Header |
Detail Band Detail Band
[ Page Footer |! |[ Page Footer |
7\7 Page Header | 7\7 Page Header |
Detail Band Detail Band
[ Page Footer |! |[ Page Footer |
‘ Report Footer ‘
Page Footer ‘

Figure 96: Label Sheets with Headers and
Footers

If you want to print headers and footers on labels start with
the template <Custom Label> and select the variation
“Complex Labels”. Insert the desired page headers and/or
page footers.

When setting the Output-Area to “Page” (= default)
TFORMer will print the header/footer across the whole
physical page width.

When setting the Output-Area to “Label” (see ®) TFORMer
will print the header/footer within the label.

Header/ Footer: | Advanced
Output-Area Label @

Please note:

You can also use more than one header (or footer) in your
design. For example, you can use one page header which
is printed per page and one page header which is printed
per label.
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D.4.2 Reports in Labels

‘ Report Header

‘ Page Header

‘ Detail Band ‘ \ Detail Band \

‘ Detail Band ‘ ‘ Detail Band ‘

‘ Detail Band ‘ ‘ Detail Band ‘

‘ Detail Band ‘ ‘ Detail Band ‘

‘ Detail Band ‘ ‘ Detail Band ‘

‘ Detail Band ‘ ‘ Detail Band ‘
‘ Report Footer

‘ Page Footer

‘ Report Header

‘ Page Header

[ Page Header |

Page Header |

[ Detail Band |

Detail Band |

[ Detail Band |

Detail Band |

[ Page Footer |

Page Footer |

[ Page Header |

Page Header |

[ Detail Band |

Detail Band |

[ Detail Band ]

Detail Band |

[ Page Footer |

Page Footer |

‘ Report Footer

‘ Page Footer

Figure 97: Reports in Labels

For printing multiple detail bands inside one label start with
the template <Custom Label> and select the variation
“Complex Labels”. Remove the Row/Column Break for the
detail band (see ©).

TFORMer will print as many detail bands as possible for
the given row height.

Please make sure to use reasonable values for the label
height and the detail band height ®. If your label is 60 mm
high and if your detail band is 20 mm high three detail
bands will fit on one label.

Detail Band: Common
Page Break None
Row/Column Break None @
Position
Height 20.000 mm @
Please note:

Headers and footers may be added as required (see also
section D.4.1).

Examples:
File » New... » (6) Samples » Report_3
File » New... » (6) Samples » Report_4
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D.4.3 Report with Detail Band Columns

‘ Report Header

‘ Page Header ‘
‘ Detail Band ‘ ‘ Detail Band ‘
‘ Detail Band ‘ ‘ Detail Band ‘

Detail Band

Report Footer ‘

‘ Page Footer ‘

Figure 98: Report with Detail Band Columns

In order to print a report with multiple detail bands in one
line start with the template <Custom Report> and select the
variation “Complex Report”. (Please make sure not to
change the predefined settings for the page subdivision, so
the page will not be divided into multiple labels. The correct
settings are: 1 row, 1 column, 0 width and 0 height).

Remove the Row/Column Break for the detail band (see
0). In the section Columns @ enter the required column
configuration. If you want to print multiple different detail
bands in one line, you have to apply the same column
settings for all of these bands. Otherwise line breaks will be
inserted.

Variant A: Fixed number of columns with identical width

Detail Band: Common
Page Break None
Row/Column Break | None @
Columns &
Columns 2
Gap 0.000 mm
Width (auto)

In this example the page width is divided in two equal
columns (see also Figure 98, left). You can let TFORMer
calculate the column width automatically or you can enter it
manually.

Please note: In the layout the detail band is drawn over the
whole page width. However, you may only use the part of
the band which corresponds to the column width (in this
case half of the band width).

Variant B: Multiple detail bands with individual widths

Detail Band: Common
Page Break None
Row/Column Break | None @
Columns &
Columns (auto)
Gap 0.000 mm
Width (auto)

In this case TFORMer automatically determines the space
which is required for each detail band. Thus the page can
be filled with detail bands that have different widths.

Example:
File » New... » (6) Samples » Report_5
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D.4.4 Labels with Detail Band Columns

‘ Report Header

‘ Page Header

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

Detail
Band

‘ Report Footer

‘ Page Footer

Figure 99: Label Sheets with Detail Band

Columns
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In order to print multiple columns per label start with the
template <Custom Label> and select the variation
“Complex Labels”.

Remove the Row/Column Break for the detail band (see
0). In the section Columns @ enter the required column
configuration (see also D.4.3).

In this example two columns with the same width are
printed on the label.

Detail Band: Common

Page Break None
Row/Column Break | None @
Position
Height 50.000 mm
Width 80.000 mm
Columns &
Columns 2
Gap 0.000 mm
Width (auto)

Please note:

The width of the detail band is the same as the label width.
When setting the number of rows to 2 the design on the
detail band must not cover more than 50% of the detail
band width (in this case 40.000 mm)!
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Appendix E: Advanced Configuration

E.1 Template File Path

The file path for the template files can be set in the windows registry. You can find the appropriate
settings either under HKEY _CURRENT_USER or under HKEY _LOCAL_MACHINE:

[HKEY CURRENT USER\Software\TEC-IT Datenverarbeitung GmbH\TFORMer\7.5\Directories]
TemplateDir="Some directory where the templates are stored"

When storing the setting under HKEY_LOCAL_MACHINE it is valid for all users on the computer:

[HKEY LOCAL MACHINE\Software\TEC-IT Datenverarbeitung GmbH\TFORMer\7.5\Directories]
TemplateDir="Some directory where the templates are stored"

E.2 Configuration File TFORMer.xml

All output specific settings from the options dialog (see chapter 17) are stored in the configuration
file TFORMer.xml.

This file is located in the application data directory of the current Windows user:

| $LocalAppData%\TEC-IT\TFORMer\7.5\TFORMer . xml

Please note:
» Each Windows user account uses its own configuration file.

> The settings from the configuration file are used for TFORMer Designer, TFORMer SDK
and for TFPrint.

» The standard settings (defaults on the first program start respectively in case of a missing
TFORMer.xml file in the user application data directory) are taken from the global application
data directory (see below).

The standard configuration file is located in the global application data directory:

| $ProgramData%$\TEC-IT\TFORMer\7.5\TFORMer .xml

For a complete description of the configuration file, please refer to the Developer Manual.
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Appendix F: Creating CSV Files with Excel®

In order to create a CSV file with Microsoft® Excel®, please follow these steps:

A B e First create a table with the desired data. Make
| 1 |ArticleName  ArticleNo Articleprice? sure that every column has a column name (see
2 | Chair 558963 110 0).
i Eﬂiﬁ:itor ;;:iig gg The cplumn names should match the names of the
data fields used in the layout.
5 Panel 544593 40
6 Coffee Machine 5493896 30
7 |Printer 458862 100
8 |Fax 445866 115
9 |Phone 458932 50
. ' Select File » Save as » Other Formats from the
File name: m menu.
Save as type: [csv T TN Navigate to the desired output folder and enter a
file name (e.g., “Data”). Under ® choose “CSV
(Comma delimited) (*.csv)”. Then click Save.
ArticleNane: drticleNo ArticlePrice When opened in a text editor the CSV file should
Chau."' 558%3 ;110 look like this. All columns must be separated b
Desk 778920150 p y
Monitor;775116:236 semicolons.

Panel 544593 ;40

Coffee Machine 54989630
Frinter: 458862100

Fawx ;445866115

FPhone: 45893250
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Switch between open Files

Click on the respective file tab or use the layout
picker ¥ . Alternatively use the following
keyboard shortcuts:

Next File.........ccccoennnen. Ctrl+Tab
Previous File .................. Ctrl+Shift+Tab

Layout and Printing

SEIECE

Layout View Ctrl+L

Data View. . Ctrl+D
Preview ....... ... Ctrl+Space
Page setup..................... Ctrl+Shift+P
Print ..o Ctrl+P

The Page Setup can also be opened via
double-click on the form selection area ® or via
double-click on the gray area ©.
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Keyboard Shortcuts

Right-Click — Context Menu

If you are unsure which operations can be performed on a selected
object, open the context menu by clicking the right mouse button — see

0.

Renaming

Grid Visible (on/off)......... Ctri+G
Positioning Mode...... ... Ctrl+R

Zoom In ... Ctrl++

Zoom Out v Ctrl+-

Zoom In/Out ..........ccco... Ctrl+Mousewheel
Auto Zoom.........ccceunnnnn, Ctrl+0

Zoom 100%.... ... Ctrl+1

Zoom 200%.... w.. Ctrl+2

Zoom 300%.... .... Ctrl+3

Zoom 400%.......... .... Ctrl+4

Zoom 50%............ ... Ctrl+5

Scroll vertically ............... Mousewheel
Scroll horizontally ........... Shift+Mousewheel

WWW.TEC-IT.COM

To change the name of a data field, tray mapping, layer, band or design
element, select the respective item in the tree view window and click on
the item once again (or press the F2 key). The name can now be

edited.

Layers

Double-click on the layer icon in the design tree to toggle the visibility.

Default Element Properties

You can save the current format styles (font style, color, line width, ...).
These styles will be applied automatically when inserting a new ele-
ment. Use the context menu (right mouse button) to:

= Set Default-Format (based on current selection)

= Apply Default-Format (to current selection)

Editing
F) UNdO ..o Ctri+Z
8 Redo....iin. Ctri+Y
# 0 Cul, Ctrl+X
2 CopY e Ctrl+C
[ Paste..oiieniene, Ctri+V
¥  Delete Del

Select all Elements.......... Ctri+A

Element Content

Edit the content of

selected text, barcode

and picture elements........ F2

Text Properties
B [=T0] (o TR Ctri+B
ra ItaliC ..vvvveeveveieieeee, Ctrl+l
O Underline......ccoeevvennnnnen. Ctrl+U

Move Elements

While dragging elements with the mouse you
can use the following modifier keys:

Move

horizontally/vertically ........ Shift
Copy Mode........cccocuveennee. Ctrl
Fine Positioning................ Alt

Insert/Resize Elements

While inserting or resizing elements with the
mouse you can use the following modifier keys:

Square/Circle....................
Centered ..................
Fine Positioning

Align Elements (for multiple selection)

Align Left........cccoooiienn Ctrl+ <
Align Right..........ccooee Ctrl+->
Align Top..cvveceieece Ctrl+
Align Bottom.................... Ctri+¥
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Arrange Elements (Z-Order)

L4 Moveto Top ...cccoeeererrinns Ctrl+Home
LY Move UpRight ................ Ctrl+Page Up
Lh  Move Down..........cc........ Ctrl+Page Down
=% Move to Bottom ............... Ctrl+End
Band Order (if a band is selected)
Move Up.....cccoceverniieennn. Alt+
Move Down .........c....c........ Alt+¥
Data Source
i Reload data.........c.ccceuue. F5
Miscellaneous
& TFORMerHelp................. F1
Cancel operation .............. ESC
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(e.g., cancel a mouse
drag and drop)
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